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Introduction — Welcome

         
Introduction

Welcome to ElectricImage™ 2.8!

Well, here it is, ElectricImage 2.8! Crammed with hundreds of incredible new features, 
such as a fantastic new user interface, including a totally new material and texture map 
interface, procedural shaders, and state of the art character animation tools, we are sure 
that you will find this new version irresistable.  

This is the second revision of the documentation.  This revision contains corrections to the 
previous edition, and includes new material.  Please discard the previous version.

Further documentation updates in Adobe® Acrobat® form will be availabe at our website 
in coming days, so keep checking in at:

www.electricimage.com

The ElectricImage Team
ElectricImage 2.8 Supplement        1



 

Introduction — Welcome

    
2       ElectricImage 2.8 Supplement    



 

Camera Info Window — Overview

        
Camera Info Window

Figure 1 — Camera Info Window

Overview

The camera info window contains all of the settings required to manipulate a camera in 
Electric Image, as well as view it’s current attributes.  Each camera in a project maintains a 
separate set of parameters, found in its camera info window.  This window is brought up 
by double clicking on the desired camera in the project window, or by selecting the cam-
era and typing ð -I.

A camera in Electric Image dictates how an image will look when it is rendered.  It mimics 
a real camera, with controls for focal length and field of view, as well as precise position-
ing values.  A camera in Electric Image is comprised of 2 elements; the camera itself, and 
it’s reference point.  The camera represents the physcial location of the camera itself, while 
the reference point represents what the camera is looking at.
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New to Electric Image 2.8 are settings for Explicit positioning, and depth of field.  Addi-
tionally, there is enhanced functionality in the rotoscoping and projection mapping (previ-
ously called camera mapping) areas.

General Camera Settings

 In Electric Image 2.8 the camera window has been divided into 5 tabbed dialogue boxes.  
On the left side are check boxes used for enabling the various methods of displaying the 
camera in a view window.  The X-Form window displays the position of the camera and 
it’s reference point, as well as it’s current angle.  The FOV window is used for setting the 
focal length and field of view of the camera, as well as it’s shutter, and depth of field set-
tings.  The Roto/Comp window is used for adding rotoscoping and compositing layers.  
The stereo window allows for the rendering of sterescopic images.  Finally, the projection 
map window is where camera maps are applied, allowing for the projection of custom 
images onto geometry from a camera’s perspective.  The following chapter goes into 
depth on each of these areas.

Camera Display Options

On the left side of the camera window info are the display options which determine how 
the camera will be seen in the world view windows.

Show Angle
This check box displays a projection of the lens viewing angle in the world view windows.

Show Fog
This check box displays a projection of the fog radius used by the camera.

Show Stereo
This check box allows the display of the stereo separation and convergence values in the 
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world view windows.

Show Roto
This checkbox will cause any loaded background images to be drawn in the camera view 
window.

Show Map
This checkbox will cause any foreground image to be displayed in the camera view win-
dow.

Camera X-Form Tab

This tab reflects the current position of the camera and reference point, as well as display-
ing its Yaw, Pitch, and Roll.

Figure 2 — Camera X-Form Tab

A new feature to Electric Image 2.8 is the ability to display keyframe values in either 
Implicit, or Explicit values.  Implicit is the way that Electric Image has always displayed 
vectorized quantities.  When the camera is set to implicit it will work as it has in previous 
versions, where dragging the camera in a window controls two of it’s positional measure-
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ments.  The velocity is computed as a composite of these two vectors.  For instance, by 
dragging a camera in the top view window, the X & Z coordinates will change, in the 
Front View the Y&X, and the Side View the Y&Z coordinates.  Implicit controls always 
function on two axes simultaneously.

When a camera, or object in EI 2.8 is set to explicit positioning, a new option for control-
ling positional values becomes available.  Using the new cfunction urve editor, it is now 
possible to control the values and velocity for all 3 components of motion (X,Y,Z) indepen-
dently.  For more information on using the curve editor please refer to the Curve Editor 
section of the manual.

FOV Tab

This tab allows for the selection of the focal length of the camera, and it’s field of view.

Figure 3 — Camera FOV Tab

New to Electric Image 2.8 is the ability to perform depth of field rendering.  Depth of field 
mimics a real camera, whereby images are blurred according to the focal settings of the 
camera.  Electric Image uses a jitter-sampled technique to achieve various focusing effects.  
Depth of field rendering is a multiframe technique that requires the multi-frame button to 
be set in the Motion Blur tab of the Render window.  For best results the number of Blur 
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Frames should be set to 5 or higher.

Additionally, to enable depth of field rendering, the Enable Focus checkbox must be 
selected.  There are 2 ways to control the focus distance (what part of the imge will be 
clearest).  This can either be set to use the reference vector as the focal distance (by refer-
ence), or use an absolute value, entered in the Focus Distance edit box (by channel).  
Depth of field effects are also affected by F-Stop, Shutter Angle, and the Multi-frame Pixel 
Offset Value (Circle of Confusion).

Roto/Comp Tab

New to Electric Image 2.8 are enhanced compositing and rotoscoping controls.  Multiple 
foreground and background images can be added in the Roto/Comp tab.  It is also possi-
ble to use animated maps with individual start and stop frames.  Map cropping is also 
supported.

Figure 4 — Camera Roto/Comp Tab
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Group Info Window

Introduction

The group info window contains basic non-material attributes for the group, as well as an 
access point to the group’s material record (See the Materials and Texture Maps chapter 

for more information.) Like so much else in ElectricImage 2.8, the Group Info Window has 
undergone a complete overhaul.  The window has many familiar elements from previous 
versions, but it also has quite a few enhancements.  Like many new interface enhance-
ments, the group info window is divided into conveniently organized folder tabs, each 
containing the controls and functions indicated by the name of the tab.  To access the con-
tents of a tab, just click on it.

The group info window is divided into the tab section, Material ball icon, and configura-
tion check boxes.  The four folder tabs are:
• X-Form
• Shading
• Shadow
• Info

Figure 5 — Group Info Window
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Base Options

Figure 6 — Filter Ball

On the left side of the window you will see either two or four options, depending on what 
type of object it is. They are not linked under a folder tab,and remain visible at all times.

Show Extent Box
This checkbox toggles on and off the display in the project windows of group bounding 
boxes.

The Filter Ball
The traditional filter ball display shows you the current material properties of the object.  
It does not display texture properties, however.  (See the ElectricImage Series 2 Reference 

Manual and Addedums for more information.)

The following two options will only appear if the group’s geometry is generated by an 
active plugin.

The Plug in Button
When a group is comprised of data generated by a plugin, clicking this button will open 
the plugin’s configuration window.  

Live Plug in
This checkbox toggles on and off the active recalculation of a plugin’s parameters when 
the time thumb is moved (a great time saver.)  
For example, if you have a Mr. Nitro group in your project, every time you move the time 
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thumb Mr. Nitro  will recalculate the position of the  group’s fragments.   A particle sys-
tem will do exactly the same thing.  Unchecking Live Plugin will disable this calculation, 
removing the need for you to type ð -. (Command-Period) to prevent recalculation.

The X-Form Tab

Figure 7 — X-Form Tab

The X-Form (Transformation) Tab contains spaces which contain X, Y, and Z values for the 
four geometric transform values of a group: 

• Position
• Rotation
• Center
• Scale

Each of these values functions exactly the same as they did in previous versions of Elec-
tricImage.  (See the ElectricImage Series 2 Reference Manual and Addendums for more 

information.)

In the position and scale sections, you will see a popup menu where you can select 
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Implicit or Explicit keyframe interpolation.  The following section will explain the differ-
ences in these two types of interpolation.  Following this section we will continue with the 
explanation of the Group Info Window.

Implicit and Explicit Interpolation

As you may have already noticed, all vectorized quantities in ElectricImage (position, ref-
erence, center, etc.) now have an extra pulldown menu in their info windows.  This pull-
down controls whether the quantity is Implicitly or Explicitly translated.  Implicit 
tranalstion is what you have been using in past versions of ElectricImage™.  Explicit 
translation allows separate control in our new curve editor for each of the three compo-
nents (X,Y,Z).

Implicit Translation Example

Figure 8 — Top View in ElectricImage
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Figure X-X shows us the top view of a basic motion path, as you were used to seeing in 
prior versions of ElectricImage™.  Figure X-X shows us the graph of the camera motion 
velocity.

The Camera's motion path, as seen in Figure X-X is really a composite of the Z and X chan-
nels of the Camera motion path transform.  When you drag the Camera in the top view 
the Z and X values change but Y does not.  Velocity is computed on the composite vector 
(The vectors of X and Y.)  There is no curve available to adjust one of the three components 
by itself.

Explicit Translation Example

By making the Camera's transformation Explicit, velocity calculations are removed and 
you are free to independently manipulate the three component vectors of the motion 
(X,Y,Z).

To make an object’s Translation explicit:

• Open the Group Info window for a given object.  Make sure that the X-Form window 
is in the foreground.

• Change the translation of the particular Transformation characteristic from Implicit to 
Explicit.

Figure X-X shows the Position translation being changed to Explicit.

Figure 9 — Figure X-X
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The translation value for the object’s position is now explicit.  Repeat these steps for any 
other value to change its transformation.

The Shading Tab

The shading tab contains attributes which let you specify the shading behaviour of the 
group.  

Figure 10 — Shading Tab

The Shading Window is divided into seven sections:

• Fog Section
• Reflection Section 
• Line Section
• Blur Section
• Color Section
• Geometry Section
• Popup Menu Section
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Fog Section

Fog Enable
This checkbox enables the group to be affected by any of the global fog settings.  When 
this box is unchecked the object will not be affected.

Reflection Section

The items in this section are pertinent only when automatic reflections such as mirror or 
environment maps are used somewhere in the scene.  They are otherwise ignored.

Cast No Reflection
Enable this check box if you don’t want the group to cast a reflection onto another group.  

Reflection Object Only
Checking this box will force the group to not render in the scene, but other objects will be 
able to see it in their reflections.

Line Section

The attributes in this section affect wireframe shading options only.  They do not affect the 
cell/outline shader settings found in the geometry tab of the Material Info Window.  (See 

the Materials and Texture Maps chapter for further information.)

Shade Lines
When a group’s shading popup is set to wireframe, this check box enables the material 
attributes assigned to the group to actually shade the wireframes of the group. Very cool.

Line Size (pixel)
Use this value to set the line thickness in pixels for wireframe shading.  A value of 0.0 will 
use the global line thickness settings in the Render Information Window instead.
(Motion) Blur Section
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Blur Mode Popup
There are three options for motion blur for every group:
• None
• Frame Multisample
• Motion Vector

None
No blur is used for the group (default)

Frame Multisample
Multiple frames are used to create the illusion of motion blur for the group.  The amount 
of frames used are set in the Motion Blur tab of the Render Information Window.

Motion Vector Blur
A very high quality fast motion blur that most closely approximates real photographic 
motion blur.  This setting is the best to use in about 90% of the cases you will come across.  
At times, the effect does break (such as a fan inside a cage).  At those times, you can set the 
Motion Vector setting at the group level, and choose both the Frame Multisample (set the 
smaple valule to 2 and increase as necessary) and Motion Vector settings (use the default) 
in the Render Information Window.  The combination of these two blurs can usually sta-
isfy all but the most ardent critics!

Color Section

Smooth Across Faces
Enables the shading of the group to smoothly blend across the faces that make up the 
group’s shape.  If you want to see the individual faces defined, disable this check box.

Color Blend
Blends the color of the vertexes of the group together.  Typically, the vertexes of a group 
are a single color, rendering this option useless. However, you can create some nifty spe-
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cial effects if you have the ability to color individual polygons (most modelers do) and use 
this feature.  For example, you can create a tail cone of a jet with black colored polygons 
around the edge of the cone closest to the outlet, and the color the polygons around the 
section closest to the body gray.  Enable this checkbox and shade.  See how the colors 
bolend together?  For added realism in this example, don’t color all of the polygons black 
around the outlet, leave some gray.  It looks even better now.  This is basically a throwback 
to the old CGI days, before texture mapping was common.
 
Vertex Transparency
Certain new plugins are able to set transparency values for geometry on a polygon by 
polygon basis. This will be very useful for plugins that simulate fire and other such effects. 
This type of transparency will be used by the render if this is checked.

Glow Object Only
With this box checked the object that is set to glow will not render as a shaded object but 
its glow will still render.  Very good to use with particle systems plug ins, as it improves 
that “CG” look to be more acceptable.

Geometry Section

This section contains controls which directly affect the group’s geometry during the ren-
dering process.

Cull Backfaces
Removes back facing polygons (those not seen by the camera) so that they are not shaded 
at render time.  This speeds up rendering (didn’t think we could get any faster?) and is 
great for eliminating the double specular effect present with transparent objects.

Reverse Normals
You can reverse the normals of a group with this option enabled.  Unlike most rendering 
engines, ElectricImage understands that polygons have two sides regardless of the nor-
mals for the polygons and will shade the model accordingly.  You can turn the group 
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inside out with this feature, or better yet, combine it with the Cull Back faces option.  Try 
this: add a model (don’t use the standard shapes plug in with this feature) of a sphere and 
enable both of these features.  When you render, you will see the inside of the back of the 
sphere.  Combine this with edges set to transparent (see the Materials and Texture Maps 

chapter for more information), and you have yourself the beginnings of a planet atmo-
sphere!

Shadow Tab

The shadow tab controls the shadow casting properties of the group.  There are five check 
boxes in the tab:

• Cast Shadow
• Receive Shadow
• High Precision Shadow
• Generate Shadow Mask
• Shadow Object Only

Figure 11 — Shadow Tab
Cast Shadow
Enables the group to cast a shadow onto other groups.  Defaults On.
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Receive Shadow
Enables the group to receive shadows from other groups.  Defaults On.

High Precision Shadow
Improves the quality of the shadows that fall upon this group.  Defaults Off, because it is 
usually not needed.  If you do not like the way a shadow appears on this group, try using 
this feature.

Generate Shadow Mask
Creates a “shadow cutter” using this group.  The group effectively becomes a mask wher-
ever a shadow from another group would fall upon it.  The sections of the group outside 
of the shadow would be rendered with a value of zero (black) in the alpha channel of the 
image.  You can use this to assist in realistic compositing of rendered objects into real 
world scenes, and so forth.  Use the diffuse color channel to determine the color of the 
“shadow” that this group becomes.  Defaults to Off.

Shadow Object Only
Forces the group to be rendered only during the shadow pass, not during the final render.  
With this feature you can create low resolution shadow casting groups to make things ren-
der even faster!  Defaults to Off.

Info Tab

This tab stores information about the group’s creation date, the amount of points, lines 
and polygons in the group, and the extent of the group’s volume.
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Light Info Window — Introduction
Light Info Window

Introduction

In addition to the other functions found in the Light Info Window (documented in previ-
ous addendums and the Series 2 Reference Manual,) ElectricImage 2.8 offers these new 
lighting features: 

• Illumination lists
• Projection maps
• Lightflare plug in

Illumination lists use the new Selection Set feature to control a light’s effect on a particular 
group of objects. These lists are used to either illuminate or ignore only the objects in the 
list. In other words, if you assign an illumination list to a light, the light will then “see” 
only those objects in the lists assigned to it for the specified behavior.

Projection maps allow a light to work as a slide or movie projector, up to an including cre-
ating light rays colored by the projection map. You can also use this feature to mimic real 
world lighting, such as “gobos.” (Gobos are patterns placed in front of a light to break up 
the light in a particular way.)

The Lightflare plug in is a new type of lensflare. It has different properties than the Lens-
flare, and mimics the lensflare of some other 3D programs. It is provided for your conve-
nience.

The following pages discuss these new features and the new Light Info Window in depth.    
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Accessing the Light Info Window

Like all Info windows in ElectricImage, the Light Info Window can be accessed using any 
of the following methods:
• Double click on the light in the World View or Camera Windows
• Double click on the light name in the Project Window
• Choose “Get Info” from the File menu, with the light previously selected

Basic Layout

Below we have an illustration of the Light Info Window. To the left of the Light Info Win-
dow you will see a Light Type pulldown menu and a series of check boxes. To the right are 
a series of named tabs, each containing the controls and functions indicated by the name 
of the tab. To select a tab, just click on it to bring it forward.

Figure 12 — Light Info Window
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The popup menu allows you to select the type of light you want this light to be, and the 
eight check boxes activate visual representations of specific attributes within the world 
view and camera view windows. The checkboxes allow the user to have quick visual feed-
back regarding the parameters of the lights sources without having to render out scenes. 
Generally, users should use the checkboxes while setting up a scene but be careful to only 
turn on those references as they refine the attributes. Turning on too many of the attributes 
at the same time can be a little confusing.

Two new checkboxes have been added in ElectricImage 2.8:

• Show Flare Dropoff
• Show Volume Dropoff

Show Flare Dropoff

This checkbox draws a circular Flare dropoff extent in the world view and camera view 
windows when selected, and represents the furthest distance from the light that the lens 
flare effect will be visible. You can access installed lens flares through the Flare tab in the 
Light Info Window.

Show Volume Dropoff

This checkbox draws a circular volume dropoff extent in the world view and camera view 
windows when selected. The volume drop off setting is an edit box located in the proper-
ties tab of the Light Info Window.
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X-Form Tab

The X-Form (Transformation) tab displays the value of the light’s position, reference, and 
angles at the current scene time. The roll control is also available here. The functions of 
these attributes are identical to previous versions of ElectricImage and are covered in the 
ElectricImage Series 2 Reference Manual and Addendums.

Figure 13 — X-Form Tab

Properties Tab

The Properties tab contains the basic illumination features of the light. These features are 
covered in the ElectricImage Series 2 Reference Manual and Addendums. ElectricImage 
2.8 presents some new features:

• Volume Dropoff edit box
• Illumination List
• Inner Cone is offset checkbox
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Figure 14 — Properties Tab

Volume Dropoff Edit box
The Volume Dropoff setting is used to improve the look of both glow and fog lights. It 
provides a more natural transition calculation for the glow and fog volumes. The values in 
the edit box…

Illumination Lists
Illumination lists provide a way to control which objects receive light from a particular 
light source. Which objects receive or are excluded from the illumination of a particular 
light source are determined by selection sets. (For information on sets and how to create 

them please refer to Chapter X, Selection Sets.)

Adding Illumination Lists

To add an illumination list to the light, use the following method:

• Click the Add button. 
• Select the set from the list window that appears.
• Click the Add button in the list window
You will now see the name of this selection set listed in the Illumination List window.
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Enabling/Disabling Illumination Lists

Sets in the Illumination lists are enabled or disabled by clicking on the solid circles to the 
left of their names (defaults to enabled.) Once clicked, the circle becomes hollow, indicat-
ing that the set member will be ignored. This feature works in the same manner as the 
checkboxes to the left of each group name in the project window.

Figure 15 — Normal Render                                               Excluded Render     

Illumination Lists and Light Behavior

Once you assign an illumination list to a light, the light “sees” only those items contained 
within the selection sets listed for the specified behavior. If the Illumination List is set to be 
excluding, then those selection sets in the illumination list are not light by the lightsource. 
All other objects in the scene will be lit normally. If the Illumination List is set to be includ-
ing, then only those items contained within the selection sets will receive illumination 
from the lightsource. All other objects in the scene will be ignored by the light.

Lights can only offer include or exclude behavior, regardless of the amount of selection 
sets within the illumination list. Behaviors cannot be mixed and matched. If such is 
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desired, you would need to create a new light with the corresponding selection sets and 
settings.

Flare Tab

The flare tab contains all of the parameters to control lens flares for the lightsource. 
Installed lens flares are available from the popup Flare menu (flares are plug ins and need 
to be installed into the EI Sockets folder to be available to a project.) 

Figure 16 — Flare Tab

Previously, Enable Obscuration was the only Lens Flare option. ElectricImage 2.8 provides 
several more, offering more control.

• Enable Offscreen
• Enable Distance
• Enable Background
• Enable Fog
• Enable Intensity
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Enable Offscreen
This checkbox enables the flare to gradually diminish as the origin of the flare moves off-
screen. With this option on the flare behaves as the real photographic artifact behaves. The 
lightsize setting in the Properties tab is used to control the effect.

Enable Distance
This checkbox enables the flare to diminish over distance. The lightsize setting in the 
Properties tab is used to control the effect.

Enable Background
Allows the lens flare to “glow behind” all objects in the shot. As such, this feature ignores 
the Enable Obscuration setting. You can add some dramatic backlighting effects to your 
scene with this feature.

Enable Fog
Causes the flare intensity to diminish as the flare moves into the fog (the fog feature is 
available in the World Info Window.)

Enable Intensity
Uses the Light intensity setting to calculate the flare intensity. The Light intensity setting is 
available in the Properties tab. The Dropoff setting for the light will effect the lensflare if 
this setting is active.
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Glow Tab

This tab contains all the information to control the glow properties of your light source. 
(These features are all covered in the ElectricImage Series 2 Reference Manual and Adden-

dums.) ElectricImage 2.8 adds a new feature, Volume Falloff.

Figure 17 — Glow Tab

Volume Falloff
The Volume Falloff checkbox improves the overall appearance of visible lights. You will 
find that the visible lights now have a more natural look when this checkbox is on.
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Fog Tab

This tab contains all the information to set the fog properties of your light source. (All of 

the features are discussed in the ElectricImage Series 2 Reference Manual and Adden-

dums.) ElectricImage 2.8 offers a new item, Volume Falloff, and works exactly the same as 
Volume Falloff in the Glow window (previous.)

Figure 18 —  Fog Tab

Projection (Map) Tab

Projection maps are controlled from the Projection Tab in the Light Info Window. Projec-
tion maps are single or multiple frame image files. You can think of them as texture maps 
for lights. In fact, many of the texture map controls covered in the chapter on the materials 
editor are available here.   

To Add a Projector Map

• Click on the Add button
• Select a valid image file
• Double click the file or click on the Open button

The map is now ready for use.
30       ElectricImage 2.8 Supplement    



Light Info Window — Projection (Map) Tab
Projection Map: X-Form Tab
The Projection Map X-Form tab is used to control the position of the map in the light’s 
local space. The position edit boxes control the X and Y position of the map. The scale edit 
boxes control the X and Y scale of the map. The Align popup menu (shown extended in 
the figure below) eases map alignment and fitting. They are discussed below.

Figure 19 — Projection (Map) Tab: X-Form Tab

• Fit Outer Cone (Default)
• Fit Within Inner Cone
• Fit Without Inner Cone
• Fit Within Outer Cone
• Fit Within Outer Cone
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Projection Map: Properties Tab

The Projection Map: Properties tab is used to control the properties of the projection map. 
Illustrated below, the tab is divided up into several components: Tiling popup menus; 
Samples edit box; Blur edit box; and a series of checkboxes. 

Figure 20 — Projection (Map) Tab: Properties Tab

Tiling Popup Menus

The tiling section controls the repeat functions of the map if it is scaled at less than 1.0 
(scale functions are found in the Projection Map: X-Form tab.) There are four options for 
each popup menu: 

• None
• Hold
• Repeat
• Mirror

None
Disables the map on the specified map axis. Choosing None for both axes will hide the 
map.
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Hold
Displays the map without repeating on the specified map axis. Choosing Hold for both 
axes will cause the map to be displayed only once.

Repeat
Repeats the map along the specified axis. Choosing Repeat for both axes will cause the 
map to repeat continuously within the cone of the light, depending upon the scale of the 
map.

Mirror
Mirrors the map along the specified axis. Choosing Mirror for both axes will cause the 
map to flip flop about both axes.

Samples Edit box
The Samples edit box determines the quality of the map as projected. The higher the 
amount of samples, the higher the quality of the map. The default is 5, and it is unlikely 
that you would need a higher setting than this.

Blur Edit Box
The Blur edit box controls the sharpness of the map as projected. The default is 1.0. To 
make the map blurrier, increase the number in the edit box.

Quality Control Check Boxes

There are four check boxes which let you control the quality of the map:
• Interpolate
• Anti-Alias
• Invert RGB
• Invert Alpha
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Interpolate
Enables map filtering. Necessary to avoid moire patterns in the map as it rotates off axis.

Anti-Alias
An additional level of filtering for image quality. Not always necessary, and can soften the 
look of the map.

Invert RGB
Negates the RGB channels of the map for special effects.

Invert Alpha
Negates the Alpha channel of the map. This feature comes in handy when you aren’t sure 
how to design the alpha channel of the map.

Projection (Map): Info Tab

The info tab contains information about the projection map, as well as any cropping that 
you may have performed on the map.

Figure 21 — Projector(Map): Info Tab
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Projection (Map): Crop Tab

The crop tab displays a reduced version of the map and allows you to crop within it, so 
you can use just a section of the map. To crop, click anywhere on the “crawling ants” bor-
der around the edge of the map in the rectangle. Clicking on the edges of the map will 
drag the entire side of the map. Clicking on the corners of the map drags the corner 
inward. To reset the map, drag the borders to the extents of the image. 
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World Info Window

Introduction

Every new project now has an item called World at the top of the Project Window List.  
Double clicking on the World icon will bring up the World Info Window.

Figure 22 — The World icon in the Project window

Fog/Ambient/BG Tab

The Fog/Ambient/BG window contains three sections:

• Fog controls
• Ambient Color control
• Background Color control

 

Figure 23 — World info window
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The Fog Controls

Figure 24 — Fog control window

Fog, or Fog Projection, simulates atmospheric depth cuing.  Atmosphere has depth 
because of particles contained within it, which gives Fog th appearance of being  more 
dense the further away it is from the Camera.  While it can simulate distant haze or fog in 
a landscape, it does not induce atmospheric effects such as visible light shafts or shadows.

There are a number of items in the Fog Controls section:

The Enable checkbox
This checkbox toggles Fog on and off.  Use this to temporarily disable Fog settings.

The Color Box
Clicking this box will being up the ElectricImage color picker.  There you can select a color 
for your fog.

The Mode menu  
This menu determines the type of transition that willoccur between the region in which 
the fog effect starts,and the regionin which the fog reaches its maximum density.  There 
are two choices under this menu:
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Figure 25 —  The Mode Menu

The default option, Linear, gives an even increase in the density of the fog region.  The rate 
in which density increase will be constant throghout the length of the fog region, as 
defined by the Radius boxes (below.)

The second option, Exponential,  will calculate the density of the fog in an exponential 
manner.  The rate at which fog density increases is not constant.

Fog To menu
This menu determines the typeof fogging technique to be used.  There are three choices 
under this menu:

Figure 26 — The Fog Menu

The default option, Color, will calculate fog to the color specified in the Fog Color box.  As 
the fog gets further and further away from the Camera, it will become closer and closer to 
the specified color. This is exactly the same as doing a gradient fill in a paint program, 
where the gradient tool is set to fade from transparent to a color.  No matter what color 
you may have selected for a Background Color, the fog will calculate to the designated fog 
color.

Figure X-X below shows us a linear fade from transparent to blue. The further awayfrom 
the camera the fog is, the more dense it becomes.
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Figure 27 —  A linear fade to color

 The second option, Alpha, will calculate the fog to an alpha value of 0, which is totally 
transparent. When this is digitally composited over a background image, the objects 
enveloped by the fog will eventually fade out to the composited background.

Figure X-X below shows this principle at work. On the left the fog has an alpha value of 
100, which is totally opaque.  As the fog gets further away from the camera, the alpha 
value decreases to 0.  This does not fog itself transparent - the fog value actually fades the 
the objects in the scene itself.

Think of the check pattern as the objects in your scene.  On the left the fog is 100% opaque.  
The farther to the right the fog goes, the more it’s alpha value begins to get closer to 0.  As 
it does so, the check pattern begins to become transparent, allowing the background 
image to show through (which in this case is set to white, to match the white color of the 
page.)

Figure 28 — A linear fade to a transparent alpha value

The final option, Background, calculates the fog to the background color, as set in the 
Background Color box (see below.)

This is essentially the same as the first option, Color.  The difference, however, is that 
while Color calculates the fog to the color designated in the fog color box, Background cal-
culates the fog to the designated Background Color.
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Figure 29 — shows us a fade to a purple background color.

The Radius boxes
These edit boxes contain values that define the inner and outer fog radii of the camera.  
The first box represents the point where the fog will begin, and the second box designates 
where the fog willend.  These two values are known respectively as the Inner Radius and 
Outer Radius.

The inner and outer fog radii are drawn in the world view windows as two circles which 
enclose the camera controls.  These circles are only visible if the camera is selected, and if 
Show Fog is checked in the Camera Info window.

Figure X-X  shows us these two circles, with a red fade pattern added to illustrate the prin-
ciple.  From center point (the camera) out to the first circle, which is a dashed circle, the 
fog effect is not seen.  This first circle is the Inner Radius circle.  From the Inner radius cir-
cle to the second, large solid circle, the  fog value fades from the Inner Radius value to 
whatever Fog To option (Color, Alpha, or Background) has been selected.  This second cir-
cle is known as the Outer Radius.  From the Outer Radius onward to infinity the fog is at 
full value.

Figure 30 — The Inner and Outer Radii
ElectricImage 2.8 Supplement        41



World Info Window — Fog/Ambient/BG Tab
The Amount Boxes
These boxes function in essentially the same way as the fog radius boxes.  However, 
instead of determining the start and stop points of the fog radius, they determine the 
opacity value of the fog at the start and stop points.  These values in these boxes range 
from 0 to 1, with 0 being 100% transparent and 1 being 100% translucent.

While it is possible for you to enter a higher value than 1, you will not ever get a value 
higher than 100%, so make sure you don’t enter a value of anything other than numbers 
between 0 and 1 in these boxes.

The first box shows the fog opacity value between the camera and the inner radius.  The 
second number designates the opacity value at the outer radius and beyond.

Figure X-X  below shows this effect.  Let’s assume we have a dark green color selected for 
our fog.  Instead of going from 0 to 1 (transparent to opaque) we will go from 0.2 to 0.9.

From the camera to the first arc (the Inner Radius) the light green value is solid.  From 
thge Inner Radius to the second arc (the Outer Radius) the dropoff occurs.  From the Outer 
Radius onward the fog is at full value.

Figure 31 — A fade from 0.2 to 0.9.  

The Ambient Color Controls

Figure 32 — The Ambient Light Control
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The Ambient Color Controls set the color of global ambient light in a scene.  There are two 
items in this section:

The Enable checkbox
This checkbox toggles ambient light on and off.  Use this to temporarily disable ambient 
light settings.

The Color Box
 Clicking this box will being up the ElectricImage color picker.  There you can select a 
color for your ambient light.

The Background Color Controls

Figure 33 — Background Color Controls

The Background Color Controls set the color of the background in a scene.  When 
unchecked, the default black background will be rendered in your scene. There are two 
items in this section:

The Enable checkbox 
This checkbox toggles background color on and off.  Use this to temporarily disable cus-
tom background color settings.  Unchecking this box will revert the background color to 
its default black.

The Color Box   
Clicking this box will being up the ElectricImage color picker.  There you can select a color 
for your background.
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Backdrop Tab

The World Info Window contains new features under the backdrop tab that procedurally 
generate ramped color sky and ground planes.  This feature can be used while initially 
setting up your project to give your test renderings a better sense of scale.

Figure 34 — Figure X-X  The Backdrop Tab

There are two main sections in this window:

• Sky
• Ground

The Sky Controls

The Sky Controls give you the ability to designate custom background colors sky.  There 
are four items in this window:

The Enable Checkbox  
This checkbox toggles the sky  color values on and off.  Use this to temporarily disable sky 
color settings.

The Horizon Color Box   
Clicking this box will being up the ElectricImage color picker.  There you can select a color 
for thge sky at the horizon line.
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The Zenith Color Box  
Click this box to enter a color value for the sky at the Zenith line.

The Horizon is the point at which the sky meets the ground.  The Zenith is the upper 

region of the sky that is positioned directly above the camera.

The Transition Box  
This value sets the midpoint of the transition between the Horizon Color and the Zenith 
Color.  Higher values move the midpoint closer to the horizon, thus showing more of the 
zenith color.  Lower values, such as the default 1, will show more of the horizon color.

  

Figure 35 —  The default sky colors

Figure 36 — The sky colors with a transtion of 3
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The Ground Controls

The Ground Controls function in exactly the same manner as the Sky controls do.  There 
are four items in this window:

The Enable checkbox  
This checkbox toggles the ground  color values on and off.  Use this to temporarily disable 
ground color settings.

The Horizon Color Box  
 Clicking this box will being up the ElectricImage color picker.  There you can select a 
color for the ground at the horizon line.

The Nadir Color Box  
Click this box to enter a color value for the ground at the Zenith line.

The Horizon is the point at which the ground meets the sky.  The Nadir is the lower region 

of the cky that is positioned directly below the camera.  The Nadir is diametrically 

opposed to the Zenith.

The Transition Box 
This functions in exactly the same manner as the sky transition box. Higher values move 
the midpoint closer to the horizon, thus showing more of the nadir color.  Lower values, 
such as the default 1, will show more of the horizon color.
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Figure 37 — The default ground colors 

Figure 38 — The ground colors with a transtion of 6

When both items are enabled at the same time, the following image appears when ren-

dered:
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Figure 39 — A rendering with the default settings

The Global Reflection Tab

The third tab contains a list of Global Reflection maps that are accessible in each group's 
material interface.

Figure 40 — The Global Reflections Tab

To add a reflection map to this window, click the Add button.  A standard Open dialog 
will appear.  Simply navigate through your computer, find the map you wish to add, and 
select okay.

When setting an object’s reflectivity value in the Material Info window, you will notice a 
checkbox called Use Global Reflections. Any object that has this item checked will reflect 
the reflection maps added to this window.

Please see the Materials and Texture Maps section for more information.
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Render Information Window

Overview

The rendering process is the stage during which all of the elements in a scene (models, 
lights, cameras, textures, etc.) are combined, and used to generate a final, rendered image. 
Technically speaking, this is the point where the rendering portion of Electric Image (the 
Camera application) transforms the models into optimal segments for rendering speed, 
caches the texture maps to RAM (or the hard drive), generates shadow maps and color 
buffers, and then applies the desired shading algorithm and render settings to the geome-
try in the scene. It is also during this stage that post-processing effects like anti-aliasing, 
motion blur, and glow are applied. All of these complex processes take place transparently 
to you after clicking on Go to launch the render. It is in the Render Information Window 
that the settings which control all these various rendering parameters are applied.

In order to give the user maximum control over all aspects of the rendering process, the 
Render window in Electric Image 2.8 has been divided into folder tabs. This chapter will 
explore each of these sections and explain what their functions are, as well as how these 
settings affect other group and object settings.

To open the Render window, choose Render... from the File menu, or type ð -R (Com-
mand-R).
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General Render Settings

Figure 41 — The Render Control Window

This is the window where general rendering parameters are set, such as the global shad-
ing level, color depth, and the image format. This is also where global rendering flags are 
set, allowing the user to enable and disable specific parameters on a per-render basis. Each 
of these areas is explained in depth in this section.

The Render Tab

The render tab in the Render Information Window contains global shading level attributes 
for shading method, image quality, format, activation flags and gamma control.

Figure 42 — The Camera shading popup menu

The Camera Menu
This menu sets the maximum shading level for a render.   The default is Phong shading, 
and this will provide the highest quality rendering for most projects. If this global shading 
level is set to a lower quality than an individual group or object’s shading level, the global 
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setting will be override the objects’ setting. For instance, if an object is set for Phong shad-
ing and the global is set for Flat shading, the object will be rendered using flat shading. 
This allows the user to render an entire scene quickly using a lower quality shading level 
for motion tests and other previews. However, if the global is set to a higher quality shad-
ing level, individual objects in the scene can still be set to render at any of the other lower 
shading levels on a per object basis. This allows for a mixture of shading methods (i.e., 
wireframe objects with Phong rendered objects) in the same scene.

There are four basic shading algorithms currently available in Electric Image. Listed by 
increasing quality and render time they are:

• Wireframe
• Flat
• Gouraud
• Phong

Wireframe
Wireframe rendering is the fastest of the four rendering methods, and renders out a sim-
ple wireframe mesh image. This option will override any of the other shading methods set 
at the group/object level.   

To control line thickness enter a value in the Point/Line thickness box. Higher numbers 
result in thicker mesh lines. Below are some examples of Wireframe shading using various 
Point/Line Thickness settings:
 

Figure 43 — P/L Thickness: 1.0      P/L Thickness 3.0                                P/L Thickness5.0       
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Flat Shading
Flat shading is the fastest, but lowest quality, solid rendering algorithm. Solid rendering 
allows for full hidden surface elimination, which is helpful for quick test renders in order 
to make sure objects aren’t intersecting with each other improperly. Flat shading, also 
known as constant shading, applies a light source to only one point on each face of a 
model. This can give a rendered image a faceted, blocky appearance. Using this global set-
ting, individual objects can use both flat, and wireframe shading, at the group/object 
level. It will however, override the shading level for any group/object that is set for 
Gouraud, or Phong shading.

Gouraud Shading
Gouraud shading results in a higher quality solid rendering than Flat Shading, but is 
slightly slower. Rather than applying a light source to only one point on each face of a 
model, Gouraud shading calculates the light source based on the vertices of the polygons 
that make up a face. These values are then interpolated to give a slightly smoother appear-
ance than flat shading. The net result is that for a slight increase in render time, objects 
appear smoother and more naturally shaded than they do with Flat Shading. With this 
global setting, individual objects can use wireframe, flat, and Gouraud shading at the 
group/object level. This global setting will however, override the shading level for any 
group/object that is set for Phong shading

Phong Shading
Phong shading, the default, is the most time consuming solid renderer, using an algorithm 
that creates the most natural, smooth shaded images. Phong shading calculates the light 
sources from multiple points across the surface of a model, instead of just at the vertices of 
the component polygons. The result is more realistic specular highlights on surfaces as 
well as the most natural shadowing and light sourcing of any of the shading methods. 
This global shading level allows for all shading types to be active at the group/object level 
for the maximum amount of control.
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The Image Menu

Figure 44 — The Image popup menu

The Image popup menu determines the final bit depth of the rendered image. Bit depth 
represents the number of colors used in the palette of an image. Black and white images 
are 1-bit (black or white), 256 Color and grayscale images are 8-bit, thousands of colors are 
16-bit, millions are 24-bit, and millions + alpha are 32-bit. These color depths are all pro-
cessed as a post-rendering effect, as all Electric Image rendering algorithms are initially 
computed in the 32-bit color (Millions+Alpha) Image format. After rendering the image in 
32-bit color, Electric Image then converts the image to one of the settings defined above.   
Thus, it is important to note that there will be NO savings in render time or speed by ren-
dering in less than 32-bit color. It may actually take longer to render in one of the other 
modes, as there is an extra step which takes place after the render is complete. 

The options for this pop-up are:

BW Lines
Renders an image with lines only, in black and white only.

BW Filled
Renders an image with filled polygons, in black and white mode, similar to flat shading. 

BW Dithered
Simulates a smooth shaded image using a dithered pattern, in black and white.

BW Summation
Renders a black and white image using summation dithering, a higher quality dithering.
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256 Shades
This option converts the image to 256 shades of gray (8-bit). No histogramming is 
required for 256 Shades as it is converted directly to gray scale from the original 32-bit pal-
ette.

256 Colors
This option coverts the image to an optimized 8-bit color palette. 256 Color animation’s 
are histogrammed from the original 32 bit IMAGE file, resulting in a consistent frame-to-
frame color palette. This means that a 256 color animation will maintain the same color 
palette throughout the entire animation

Thousands
This option converts the image to a 16-bit color palette (32,768 colors) after rendering. As 
noted above, this does not speed up render time as the image is initially created in 32-bit.

Millions
This option renders the image in 32-bit color and discards the alpha channel, resulting in a 
final 24-bit image.

Millions+Alpha
This option renders the image in 32-bit color, creating a 24-bit RGB image with an embed-
ded 8-bit alpha channel.

The Format Menu

The Format pop-up menu determines the file format for the final, rendered image. 
 

Figure 45 — The Format Menu
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Image
The original file format, used since the origin of Electric Image. The Image format is a 
robust, 32-bit color format. It is also natively supported by many other, high-end graphics 
packages such as Adobe Photoshop™ and After Effects™. Files stored in the Image format 
can be displayed within Electric Image by using the display option in the File menu, or by 
using the separate Projector application. Additionally, a utility program bundled with 
Electric Image, ImageToQuickTime, will convert an Image file to a QuickTime movie.

QuickTime
Created by Apple Computer®, QuickTime™ is a digital movie format that has become a 
standard across multiple platforms. Choosing the QuickTime format brings up a dialogue 
that offers the choice of any installed hardware or software compression CODEC’s.

It should be noted that settings made in the CODEC window will override both the 
frames per second, and the Image Depth, settings in the Render window. For instance, 
even if you set the Image Depth to Millions+Alpha in the Render window, if you choose 
millions only in a QuickTime CODEC the image will be stored in millions of colors, 
WITHOUT the alpha channel. Also note that any slave machines used for rendering must 
have the same QuickTime CODEC installed as selected on the host machine.

PICT

The PICT file format is another cross platform image format which began on the Mac. 
Unlike QuickTime, the PICT format is used for single frame images, rather than anima-
tions. If PICT is chosen for a multi-frame render a series of sequentially numbered PICT 
files will be saved. PICT files have the same CODEC options as a QuickTime movie.

Flags Section

These check boxes are used to turn on and off various effects for rendering. Any box that 
is checked enables that function. This has no effect on the settings of a given group or 
object, but simply turns off that function temporarily during the render. Any objects that 
use these effects (i.e., reflections or shadows) will still maintain their settings, and will ren-
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der properly when the appropriate flag is re-enabled. This allows the user to enable and 
disable specific effects and functions on a global, per render basis. For instance, while 
doing a test render it might not be necessary to calculate shadows, so the Shadows box 
can be unchecked until a final render is needed.
 

Figure 46 — The Flags section

At many professional effects houses a trick that is often employed is to render out the 
same image using multiple passes. One render will be made just for the reflections, while 
another will be done for the diffuse light, another for glows, and so on. Then, in a post-
processing program these layers can be combined with the utmost accuracy and flexibil-
ity, even changing over time.

The Flags control the following functions:

Clip
This check box controls whether or not clip maps are rendered. It defaults to on.

Bump/Displace
This check box controls whether or not bump and displacement maps will be rendered. It 
defaults to on. 

Diffuse
This checkbox controls whether or not the Diffuse channel will be used during rendering. 
It defaults to on. 
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Specular
This check box controls whether or not specular maps will be used in the rendering pro-
cess. It defaults to on.

Transparency
This check box controls whether or not transparencies will be rendered. It defaults to on. 
When this box is turned off, no transparencies will be rendered.

Transmission
This check box controls whether or not transmission maps will be rendered. It defaults to 
on. By turning this check box off, no transmission effects will be rendered. 

Textures
This check box controls whether or not texture maps will be rendered. It defaults to on. 

Reflections
This check box controls whether or not reflection maps will be rendered. It defaults to on. 

Shaders
This check box controls whether or not procedural shaders will be rendered. It defaults to 
on.

Luminance
This checkbox controls whether or not Luminance effects will be rendered. It defaults to 
on. 

Glows
This check box controls whether or not glow effects are applied to the render. It defaults to 
off.

Outlines

New to Electric Image 2.8, this check box controls whether or not the Cel/Outline shader 
functions are enabled. It defaults to Off. By enabling this check box, and by also activating 
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the Cel/Outline shader options in a groups’ material window, a variety of effects can be 
achieved. The Cel/Outline shader allows for separate color and thickness to be assigned 
to polygons, edges, and silhouettes of models. (For more information on this please refer 

to the Materials and Surfaces chapter.)

Lens Flares
This check box controls whether or not lens flare effects will be rendered. It defaults to Off.

Shadows
This check box controls whether or not shadows will be calculated and rendered for an 
image. It defaults to On. 

Add Noise
This check box controls the addition of a dithering pattern to rendered images to reduce 
banding. It defaults to on.

  

Point/Line Thickness

Figure 47 — The Point/Line Thickness Box

When a scene is rendered in wireframe, the Point/Line Thickness edit box allows the user 
to specify the thickness of points and lines in pixels. The default is 1 pixel. Higher num-
bers will give the wireframe mesh thicker lines.

Output Gamma

Gamma is a technical term used to describe the intensity of different levels of gray as they 
appear on an output device; usually either a computer monitor or video screen. Standard 
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gamma setting range from 1.0, up to 2.2 depending on the output device. Mac monitors 
are often much brighter, and thus have a higher gamma level than PC monitors.

The Resolution Tab

The Resolution Settings tab is where all of the parameters for the resolution of the final 
rendered image are set. In this window there are options for setting the aspect ratio, reso-
lution, cropping, and VR rendering functions. 

Figure 48 —  The Resolution Tab

The Aspect Ratio Menu
The Aspect Ratio popup menu defines the relationship between the x and y pixels of the 
image. This relationship is known in technical terms as the aspect ratio. This ratio is com-
monly stated as “x resolution in pixels: y resolution in pixels”, simplified to the lowest 
common denominator. Therefore, a standard Macintosh screen with a resolution of 640 
pixels horizontally (x) and 480 pixels vertically (y) has an aspect ratio of 4:3. Usually, when 
discussing film resolutions, the aspect ratio is specified as a ratio with y always equal to 1. 
For instance, IMAX film requires a very square 1.22:1 ratio, while 70mm uses an ultra 
wide 2.20:1 ratio. There are a number of preset aspect ratios defined in Electric Image, or 
the user may choose to enter their own Custom aspect ratio. What aspect ratio you choose 
depends solely on the final format required for output. By choosing one of the pre-defined 
aspect ratios, the rendered image will be constrained to the proper pixel ratio for that for-
mat.
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Figure 49 — The Aspect Ratio Menu

An important consideration when using one of the preset aspect ratio’s is how it affects 
the field of view of the camera. Not only does film stock vary in aspect ratio, it also corre-
spondingly varies in the amount of information it can record, or the Field of View. One 
way to consider how the field of view relates to the aspect ratio is to visualize a physical 
piece of film stock. When you look at it, it has a tangible measurement of x inches horizon-
tally, and y inches vertically. One factor is the relationship of these two measurements to 
each other. Those measurements will give you the aspect ratio, and determine how wide 
or square an image will appear when projected. The other factor is the physical size of the 
film stock itself. Although both Super 8mm film, and 35mm Full format film have the 
same aspect ratio (1.33:1), you can see a lot more on 35mm film, shooting the same subject 
at the same distance, and using the same lenses. In other words, if you put the exact same 
lenses on both cameras, say 25mm, and shoot from the exact same distance, the 35mm film 
will have a significantly wider field of view and you will see more information recorded 
on the film. Why? Because 35mm film is physically larger and has about 4 times the sur-
face area of Super 8mm film on which to record an image. So it is very important to 
remember that you are determining not only the width, or aspect ratio, of an image, but 
also it’s relative field of view. Of course, in 3D you can use any lens, regardless of the 
aspect ratio, in order to create a specific field of view, but the film stock is an important 
factor in this equation. For more information on Focal Length, and Field of View please 
refer to the The Camera Info Window chapter.

Note that the aspect ratio is locked to the X resolution. Any number entered in the X box 
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will automatically calculate the proper Y resolution based on the currently selected aspect 
ratio. However, numbers can be entered manually in the y resolution and do not automat-
ically convert the x value to the correct aspect ratio. Therefore, if you want the aspect ratio 
to be automatically calculated, always enter your resolution in the X edit box, and let Elec-
tricImage calculate the proper Y resolution.

For reference information, the field of view in horizontal degrees, assuming a 25mm Focal 
Length lens, is given with each preset choice. The aspect ratio choices are as follows:

Custom
This option brings up a dialogue box for entering a custom aspect ratio. The pop-up menu 
on the right allows the user to specify the measurement system in millimeters, centime-
ters, or inches. Then, simply enter the specific film gauge measurements in both x and y 
dimensions, or enter an aspect ratio in the Frame Aspect edit box. 

This dialogue box is very useful for entering custom measurements when you are trying 
to match a film stock that is not one of the presets, or you need to match a particular 
aspect ratio from another 3D package, or to suit a specific programming need. 

Computer
This option (the default) specifies the 4:3 aspect ratio of a standard 640x480 computer 
screen. The horizontal field of view using a 25mm lens is 3.0 degrees.

If you are doing multimedia work for a standard computer screen this is the setting that 
you would use most often.

Super 8mm
This option specifies the 1.33:1 aspect ratio of Super 8mm film. The horizontal field of 
view using a 25mm lens is 12.1 degrees.

16mm
This option specifies the 1:38:1 aspect ratio of standard 16mm film. The horizontal field of 
ElectricImage 2.8 Supplement        61



Render Information Window — The Resolution Tab
view using a 25mm lens is 23.2 degrees.

Super 16mm
This option specifies the 1.7:1 aspect ratio of Super 16mm film. The horizontal field of 
view using a 25mm lens is 28.1 degrees.

35mm
This option specifies the 1.37:1 aspect ratio of standard 35mm film. The horizontal field of 
view using a 25mm lens is 47.4 degrees.

35mm Full
This option specifies the 1.33:1 aspect ratio of 35mm Full format film, also known as Acad-
emy Aperture. The horizontal field of view using a 25mm lens is 52.9 degrees.

VistaVision
This option specifies the 1.5:1 aspect ratio of VistaVision format, with 8 horizontal perfora-
tions per frame. The horizontal field of view using a 25mm lens is 74.1 degrees.

65mm
This option specifies the 2.28:1 aspect ratio of 65mm vertical 5 perf film. The horizontal 
field of view using a 25mm lens is 92.8 degrees.

IMAX
This option specifies the 1.22:1 aspect ratio of 65mm horizontal 15 perf IMAX film. The 
horizontal field of view using a 25mm lens is 109.3 degrees.

70mm
This option specifies the 2.20:1 aspect ratio of 70mm film. The horizontal field of view 
using a 25mm lens is 88.3 degrees.

TechniScope
This option specifies the 2.35:1 aspect ratio of TechniScope film. The horizontal field of 
view using a 25mm lens is 88.3 degrees.
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Image Resolution

The Resolution popup menu determines the final number of pixels to render for an image. 
This resolution will be constrained by the chosen Aspect Ratio. 
 

Figure 50 — The Resolution menu

The resolution of an image has little effect on the amount of memory required to render, 
but does increase the number of passes needed, due to the additional pixels, and increases 
render time.

You should note that the resolution has no effect on the field of view. You won’t be able to 
see twice as much of a scene by doubling the resolution. In order for the camera to “see” 
more of a scene, it is necessary to either change the aspect ratio and/or the focal length of 
the camera. The resolution setting merely renders more or less pixels in a given image. 
The amount of information seen by the camera is the same, regardless of the resolution.

The choices for image resolution, based on a Computer aspect ratio of 4:3, are:

• 260x200
• 320x240
• 640x480
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• 1024x768
• 1280x960
• 2048x2048
• 4096x4096
• Main Screen (the default): This setting uses the resolution of the primary monitor.
• NTSC:   (720x486) The standard television resolution used in North America and 

Japan. Pixel ratio = .9 (see below for explanation of Pixel ratio)
• PAL: (768x576) The standard television resolution used in many European countries, 

including England, and Germany.
• HDTV:   (1920x1280) The mythical, high definition television format that may appear 

in the United States one day, but most likely not at this resolution and no longer called 
HDTV.

• Abekas NTSC: (720x486) Resolution used by Abekas direct disk recorders at NTSC 
resolution. Pixel ratio=.9.

• Abekas PAL:   (720x576) Resolution used by Abekas direct disk recorders at PAL reso-
lution. Pixel ratio= 1.0667.

X and Y Edit Boxes

These edit boxes allow the user to directly enter values for resolution rather than choosing 
from the resolution pop-up menu. The X value will automatically constrain the Y value to 
the chosen aspect ratio, but not vice-versa. The maximum theoretical resolution is 16,000 
pixels by 16,000 pixels.
 

Figure 51 — The X and Y Edit Boxes
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Pixel Ratio

This edit box allows the user to control the aspect ratio of each rendered pixel. Most com-
puter screens display square pixels, at a pixel ratio of 1.0. However, broadcast television 
signals, including NTSC, PAL, and HDTV do not use square pixels. Therefore, by altering 
the pixel aspect ratio, non-square pixels can be rendered. The value in this box will auto-
matically change when specifying a resolution in the resolution popup.
 

Figure 52 — The Pixel Ratio box

Rendering with rectangular pixels will tend to make images look stretched out when 
viewed on a computer screen, but after being properly processed and sent to video tape 
they should appear normal.

Image Cropping
New to Electric Image 2.8, is the image cropping function. This allows for only a portion 
of an image to be rendered. There are two ways to use the new cropping feature. First, the 
enable cropping check box must be checked in the Render window. Next, values from 0 to 
1 can be entered directly in the text boxes in the cropping area, where 0 represents left/
top, and 1 represents right/bottom. When the image is sent to render only the area within 
the cropping guidelines will be rendered.

Figure 53 — The Image Cropping options

More usefully, the crop region can be seen and interactively set. By option-clicking on the 
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title/safe pulldown symbol at the bottom of the Camera View and selecting Crop, a visual 
guide will appear in the camera window. This region can now be interactively resized 
using the Drag Cropping tool found under the tools pulldown menu. When the render is 
sent only the area within the visual cropping guides will be rendered.

Rather than just a temporary selection, like the method of rendering Selected Size, the 
Crop region can be saved, turned off and on, and easily moved and resized. 

This kind of selective rendering option can be extremely useful when you have a scene set 
up, and you need to preview specific areas of the scene, but don’t want to wait while the 
computer renders everything in the scene. Rather than turning a bunch of objects off and 
on, or setting up multiple cameras, you can selectively set a cropping region around the 
object you wish to and render. There is also a new shortcut under the preview render icon, 
Cropped Size, that allows you to instantly render the cropped selection, or to render a 
selection within the cropped area, Selected Cropped Size.

QuickTime VR Image Format

The options for outputting a QTVR image are as follows:

QuickTime
When using this option in the image format pop-up menu, Electric Image generates a 
final, diced, compressed QTVR movie. You can play it back, distribute it, or use it as a 
basis for creating a multi-node movie. When using the QuickTime option you will be 
prompted to select a CODEC for compressing the QTVR movie.

It should be noted that Electric Image can only generate single node movies. You will need 
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to obtain additional tools, either from Apple or a third party, in order to create multi-node, 
or other special QTVR movies.

PICT
When using this option in the image format pop-up menu, Electric Image will generate a 
final, stitched, warped panoramic image in the Pict format. Warped PICT files are then 
used with other authoring tools to create QTVR nodes and movies. One major advantage 
to this method is that the finished image can be touched up and rotoscoped, prior to being 
compressed and included in a node. You should be aware, however, that this format does 
not create a QTVR movie, and you will need other software to make a finished QTVR 
node.

Image
When using this option in the image format pop-up menu, Electric Image will generate a 
final, stitched, warped panoramic image in the Image format. There are no real differ-
ences, aside from the format, between this and a warped pict file.

QuickTime VR Object Movies

New to Electric Image 2.8 is the ability to create object movies through the VR pop-up 
menu. A Quicktime VR Object movie is a VR movie that tracks a single object around a 
360 degree axis. Rather than the viewer panning and tilting across a panorama, an object 
movie allows the viewer to spin and rotate a single object around it’s own axis.

Simply place the object you want to rotate at 0,0,0 on the global axis. Then, select Object 
from the VR popup menu. This will bring up an additional dialogue box allowing you to 
set the number and angle of Horizontal (Latitude) and Vertical (Longitude) samples 
needed. By default an object movie will utilize a 360 degree axial rotation, starting at 90 
degrees Latitude, 0 degrees Longitude and rotating to 90 degrees Latitude, and 360 
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degrees Longitude. To create a smoother object movie, more samples can be created per 
rotation, by entering a value in the Sample edit box.

Unlike QTVR Panoramas, QTVR Object movies do not have set requirements for FOV or 
Resolution. These are left up to the user.

The Anti-Alias Tab

The anti-alias tab contains all of the settings which control final image quality.
 

Figure 54 — The Anti-Alias tab
The Anti-Alias Menu

Figure 55 — The Anti-Aliasing popup menu

The Anti-Aliasing popup menu determines the type of anti-aliasing used when rendering. 
The choices are:

None
This option specifies that no anti-aliasing will be used on the image. Edges and outlines 
may have a jagged, rough appearance.
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Adaptive

This option (the default) specifies that adaptive anti-aliasing be performed on the render. 
This produces a softer image than None, and a sharper image than the Oversample. Thin, 
sharp lines may cause artifacting when rendering for video output, and using Oversam-
pling may be more effective in these cases.

Oversampling
This option specifies that Oversampling be performed on the render. This produces the 
softest images with the smoothest edges, and significantly reduces video artifacting 
caused by jagged edges.

The Anti-Aliasing Levels Menu

Figure 56 — The Anti-Aliasing Levels menu

4x4
(The default) This setting is generally sufficient for most images. Lines and edges main-
tain a sharp, detailed appearance. High contrast vertical and horizontal edges can cause 
artifacts, and moire patterns, for which the 8x8 setting may work better.

8x8
This setting is useful when a slightly smoother, softer look is required. Lines and edges 
will appear less crisp than when using the default, and may reduce moire patterns and 
artifacts. Be aware, however, that this setting may slow down rendering time significantly 
over the default 4x4.

16x16 (and higher)
These settings should only be used in specific instances where a very high level of anti-
aliasing is needed. For the vast majority of renders, these sampling levels will produce an 
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image that is indistinguishable from one rendered at a 4x4 or 8x8 level. However, render-
ing time goes up dramatically when using these levels.

The Sampling Levels Menu
 

Figure 57 — The Sampling Levels Menu

1x1
(The default) This setting is sufficient for lower detail objects, or models that appear at a 
moderate distance from the camera. However, when viewing images rendered at this set-
ting up close, jagged edges may be apparent. This is also not a good setting for high reso-
lution images.

2x2
This is a good, general setting for most objects and groups. Render time compared to 1x1 
sampling may be only slightly higher, and the extra detail is generally worth the time, 
especially with high detail texture maps.   This setting may also help animations that 
exhibit flashing, or stair step patterns on playback.

4x4
This setting, although slower than 2x2, is useful for objects which require a high amount 
of sampling detail. This includes objects with intricate texture maps that are in close prox-
imity to the camera, or that involve complex effects passes (smoke, fog, glow). Very high 
resolution images may also benefit from this sampling level.

16x16 (and higher)
Like anti-aliasing levels, these setting should only be used in specific instances where a 
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very high sampling level is required. Render time at these levels increases by a huge 
amount, and for the majority of renders will show no noticeable improvement.

When rendering at any typical resolutions (720x486 and less), leave your anti-aliasing 
level at 4x4. Unless you see a problem in the render this setting will be more than ade-
quate and allow you to render as quickly as possible. For sampling levels, I would recom-
mend using a global maximum sampling level of 4x4, and individually setting the 
sampling levels on a per object basis. Therefore, if you have an object with a complex tex-
ture map very close to the camera you can set it’s sampling level to 4x4, while objects that 
only appear in the distance can be set for 1x1. This approach gives you the maximum con-
trol over the 2 major issues in a production setting; quality and render time.

Adaptive Sampling Threshold
 

Figure 58 — The Sampling Threshold boxes

The Min and Max edit boxes contain values that control the type of anti-aliasing to be per-
formed between adjacent pixels of different color values. If the difference in the pixels is 
less than the minimum value, the image is sharper. If the difference in the levels is greater 
than the maximum value, the image is softer. If the difference falls between the minimum 
and maximum values, adaptive anti-aliasing is performed. The higher the difference, the 
softer the image; the lower the difference, the sharper the image.
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 The Motion Blur Tab

 

Figure 59 — The Motion Blur Tab

This section of the Render window is used to control Electric Image’s motion blur fea-
tures. Motion blur is the simulation of the kind of effect that occurs when recording a 
moving object on film. As an object moves across a frame of film it naturally blurs, 
depending on the speed of the film, and the object’s velocity. These controls allow you to 
mimic that behavior in Electric Image. Note that in order for blur effects to be rendered, it 
is also necessary to set the blur mode for each object/group that you wish to blur under 
that object’s group info window.   Since this setting defaults to no blur, unless you change 
the blur mode per object blur will not be rendered.

Shutter Angle
 

Figure 60 — The Shutter Angle Box

This edit box contains a value in degrees that represents the circular angle at which a cam-
era shutter is open. A value of 360 degrees simulates a shutter that is always open, 
whereby all moving objects leave a continuous streak across the frame. A value of 180 
degrees (the default) simulates a shutter that is open for half a frame, mimicking a motion 
picture camera. The higher the angle, the longer the shutter will stay open, creating longer 
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streaks and more blur. Note that only moving objects create blur, or streaks, as the streak 
length is computed by the distance an object moves within the field of view from frame to 
frame. Hence, objects that are far away from the camera will streak very little regardless of 
their velocity, while very close objects will streak dramatically with very slight movement.

Blur Intensity
 

Figure 61 — The Blur Intensity checkbox

This edit box is used in conjunction with the Point/Line blurring technique (see below). 
This value controls the brightness of the streaks left behind by points and lines. A value of 
0.0 (the default) imparts a constant value regardless of the length of the streaks. Larger 
values produce brighter streaks, while smaller values produce dimmer streaks. New to 
Electric Image 2.8, a separate blur intensity can be set for each individual object/group in 
that group’s info window. This edit box automatically appears after selecting the Point/
Line blur mode.

Blur Noise

Figure 62 — The Blur Noise checkbox

This edit box is used in conjunction with the Motion Vector blurring technique (see 
below). This value controls the number of blur samples per pixel. The higher the number, 
the less visible noise in the streak. By using a value of 0, Electric Image will automatically 
compute the optimal number of samples for a streak based on its length. A value of 4 (the 
default) renders quickly and produces high quality results. Values over 10 are unproduc-
tive, and will drastically slow the rendering process.

Blur Frames
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This edit box is used in conjunction with the Multi-Frame blurring technique. This value 
represents the number of individual frames that are rendered prior to averaging the 
frames together to generate a single frame. For instance, if this value is set to 3, for each 
frame of an animation, Electric Image generates 3 images, two prior to the current frame, 
and one at the current frame. It then averages these images together to make a single 
frame, with blurring based on the distance moved between all 3 frames. Without this set-
ting, Electric Image calculates two frames for averaging; one before the current frame, and 
one at the current frame.

Point/Line Blurring
 

Figure 63 — The Point/Line Blurring checkbox

This check box, when enabled, activates the point/line motion blur technique at the global 
level. Individual objects still need to be set for this type of blurring at the group/object 
level. In this mode, only points and lines leave streaks behind. This is most useful for the 
motion blur of star streaks and particle systems. Normal polygonal models will not streak 
using this method.

Motion Vector

Figure 64 — The Motion Vector checkbox

This check box, when enabled, turns on the Motion Vector motion blur technique at the 
global level. Unlike the point/line method which only blurs points and lines, this method 
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induces blur on all objects which have been set for motion vector blurring. This includes 
points, lines, and polygons. It should be noted that blurred lines are always linear, and are 
never curved when seen in a single frame. This is a fast and versatile technique which 
works for most objects.

Multi-Frame
 

Figure 65 — The Motion Vector checkbox

This check box, when enabled, allows for multi-frame sampling for motion blur. It must 
be used in conjunction with one of the other blur techniques (point/line or motion vector). 
The number of frames to be sampled prior to the current frame is set in the Blur Frame 
check box. This can produce a strobe like effect if too few sample frames are used. It is best 
applied to a section of an animation where there is complex or rapid motion (like spinning 
fan blades, or the tires of a quickly moving car).

The Glow Layer Tab

New to Electric Image 2.8, are glow layers. Any group can be given a gaussian glow that 
emanates outward from that object. Additionally, groups of layers can be defined, each 
with its own glow radius and intensity. 
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Figure 66 — The Glow Layer Window

There are three sections in the glow tab:
• Glow Layer List
• Glow Layer Members List
• Configuration Section

Glow Layer List
A glow layer contains glow attributes which apply only to members of that layer. To add a 
glow layer:
• Click the Add Button Next to the Glow Layer list
• Name the layer
• Click OK
A new glow layer is added to the list.

Glow Layer Members List

Glow layer members are selection sets. In order for groups to use their glow effects 
(applied as a material), the groups need to be in a selection set contained within a glow 
layer. To add a selection set to a glow layer:

• Select a glow layer
• Click the Add button next to the glow layer member list
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• Pick a selection set form the list
• Click the Add button

The selection set is now added to the glow layer.

Glow Configuration Section

The appearance of the glow layer is a combination of the material attributes of the glow, as 
well as the settings in the Glow Radius and Glow Intensity edit boxes, shown below.
 

Figure 67 — The Glow Layer Window with Glow Layers and Layer Members

Glow Radius
The pixel area of the glow. This is the area of the image that will have a glow effect applied 
to it. Smaller values are good for objects that you wish to appear brighter in a scene, while 
larger values are better for simulating effects such as glare.

Glow Intensity
This value controls the brightness of the glow. Glows are added on top of the rendered 
scene, therefore a value of 1.0 would produce a glow that is twice as bright as the original 
image without glow.

Although glow layers and sets may seem a bit complex at first, once you get the hang of it 
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you will begin to understand the potential. Rather than having to manually tweak settings 
for each separate glow effect you can simply define a series of standard effects and apply 
those to the appropriate sets at render time. For instance, you could come up with a set of 
glow layers to simulate fire, candles, tv monitors, spaceship exhausts, light bulbs, etc. 
Once you have a series of defined glow layers they can easily be assigned to any set of 
objects you’ve created. Additionally, since Glow radius and intensity can vary by layer, a 
series of complex effects and layered glows can be created.

The Timing Tab

 The timing tab contains start and stop information, and playback information.

Figure 68 — The Timing Window
Start and Stop Times

This edit box defines the start and end times for a project, in seconds. These settings are 
also represented visually in the project window by the green (start) and red (end) arrows, 
and can be changed by dragging them interactively. Any changes made in the project win-
dow will be reflected here, and vice versa. These boxes define the total range of frames for 
a given project. Animation keyframes can still exist outside of the range of frames for a 
project, but will not be rendered.
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Figure 69 — The Start and Stop Boxes

Note: It is possible to set the start time to a negative number. This can be very helpful if 
you’ve already created a complex animation starting at 0.0 seconds, and you later realize 
you need to add a sequence prior to the start of the animation. Rather than attempting to 
drag all of your keyframes to the right, simply use a negative number as your start time. 
Be aware, however that while this works in most cases, negative frame numbers may not 
work with simulation plug ins such as particle systems.

Total Frames

 

Figure 70 — The Total Frames box

This edit box displays the total number of frames in an animation. This number is gener-
ated automatically based on multiplying the delta of the start and stop times by the num-
ber of frames per second and adding 1. For instance, if a project is set for 10 seconds, and 
the frame rate is 30 frames per second, the total number of frames rendered will be 301. 
This extra frame is due to the fact that Electric Image counts frame zero as the first frame 
in an animation. This number is displayed primarily for reference, although by setting the 
Total number of frames directly in the edit box, the Stop Time will be updated accordingly 
in both the Stop edit box and the project window.
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Nth Frame
 

Figure 71 — The Nth Frame box and checkbox

This edit box is used to specify that an animation is only rendered out with every nth 
frame. In other words, if this box is set to 2, then every 2nd frame will be rendered. If the 
start frame is 0, the following frames will be rendered: 0, 2, 4, 6, 8...etc. In order for this to 
work, the Enable Nth frame checkbox must be checked. This setting works independently 
of the Render frames pop-up. The Nth frame is always used if selected, whether an anima-
tion is rendering all frames, or a selected range of frames. For instance, if a render is set for 
a range of frames from 100 to 150, and Nth frame is set to 3, then the following frames will 
be rendered: 100, 103, 106, 109...etc.

The Nth frame box is extremely useful for doing test renders. Instead of having to render 
out every single frame of an animation, it is often sufficient for a rough motion test to only 
render out every 2nd or 3rd frame.

FPS

Figure 72 — The Frames Per Second (FPS) Menu

This edit box is used to specify the number of frames per second (fps) to be rendered for 
an animation. This figure determines the total number of images that are drawn per sec-
ond. Note that it is important to set this number prior to doing any animation in a project, 
as all animation keyframes that are created will be based on this number of frames per 
second. By changing this value later, velocities and keyframe attributes may be thrown 
80       ElectricImage 2.8 Supplement    



Render Information Window — The Timing Tab
off. The pop-up menu contains the following choices:

Custom
The Custom setting allows the user to enter any number of frames per second, as well as 
choose whether or not the image will be interlaced. Interlaced rendering splits each frame 
into two fields, with the odd field dominant unless the Even Field check box is enabled. 
Interlaced fields are necessary for some broadcast video output cards. You should consult 
with your video output devices manuals to determine if interlaced fields are necessary.

NTSC: 30, 30i
This setting specifies the NTSC video standard of 30fps. This is what all broadcast televi-
sion in the US is shown using, and consists of a 60Hz signal, being shown in 2 fields. Com-
bining both fields into 1 frame results in a frame rate of 30fps. NTSC: 30i is output as 
interlaced frames, with the odd field dominant.

PAL: 25, 25i
This setting specifies the PAL video standard of 25fps. This is most common for European 
broadcast television, and differs from the US in that it operates at 50Hz, shown in 2 fields. 
Combining both fields into 1 frame results in a frame rate of 25fps. Pal:25i is output as 
interlaced frames, with the odd field dominant.

Film: 24
This setting specifies the motion picture standard of 24fps.

The Render Menu

This pop-up menu is used to select the range of frames that are to be rendered. The 
choices are:
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Current Frame
This option (the default for single frame projects) causes only the current frame in the ani-
mation to be rendered. The current frame is defined as whatever frame is currently dis-
played in the camera window. This is selected by moving the timebar in the project 
window.

All Frames
This option (the default for multi-frame projects) causes all frames in an animation to be 
rendered. The total number of frames is defined by the Start and Stop times, mentioned 
above.

Range of Frames
This option opens a dialogue box which allows for setting specific frame numbers to be 
rendered. Using this tab, any portion of an animation within the Start and Stop times can 
be rendered. This is very helpful when working in a large project, with multiple animation 
sequences. Using this setting, only a specific range of frames needs to be rendered.

Even Field
This checkbox specifies that when rendering interlaced animation files, the Even field will 
be rendered out as the dominant field. If you don’t know what this means, then you don’t 
need to use it.

How To Render a Project

The little button on the right side of the render window looks simple doesn’t it? Well, it 
actually features two modes of operation which turns it from a simple start button into a 
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powerful selective rendering feature.

Go

To simply begin rendering a project, click the Go button. If you haven’t saved you will be 
prompted to do so. Following that, Electric Image will quit, launch the camera applica-
tion, and begin rendering. 

Control-Go
One of the great, “hidden” features of Electric Image is the Control-Go option. By holding 
down control when clicking Go, Electric Image prompts you to locate the Camera applica-
tion. This allows you to select a camera from any mounted drive, including networked 
machines, for rendering. Thus, by doing a Control-Go, instead of a standard go, you can 
send a render to launch on a slave camera on any network machine. Also, when using this 
method, Electric Image launches the selected camera application as a separate process. So, 
if you have enough memory you will never need to quit Electric Image when sending a 
render. Similar to the Preview Render option, control-go allows you the utmost in flexibil-
ity when sending a render.

Network Rendering
You can render to as many Macintosh computers as you wish (assuming they meet mini-

mum performance requirements.) Renderama, the ElectricImage network control applica-
tion, must be available in the same folder as ElectricImage, and properly configured.  (See 

the Renderama chapter for further information.)
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Selection Sets

The Select Menu has had a new selection type added, By Set.  A set is simply a defined col-
lection of groups from within a project.  The By Set menu option allows you to edit selec-
tion sets, or select items in the project that already belong to an existing set. The 
hierarchical menu below By Set initially contains a single entry, Edit Sets.  As sets are cre-
ated their names will appear in this space.

Select by Set

Figure 73 — Select Menu
 
Sets have four purposes in ElectricImage 2.8. 

• To select groups of items within the project
• To include or exclude groups from a light’s illumination
• To control the glow radius and glow intensity for a set of models
• To control which objects receive projections from Camera Maps.
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To Create a Set

• Choose Edit Sets from under the Select menu.
• The Sets window, show belown in Figure 2.2, opens.
• In the Selection Sets column, click Add.  When prompted, create a name for your set.

The Selection Sets Window

Selection Sets  
The left column, Selection Sets, contains the names of all existing sets.  Once you create 
your set its name will appear in this column.  New sets can be created and old sets can be 
deleted using the Add and Remove buttons.  The Sort pulldown gives you the option of 
viewing the list of sets alphabetically or in their creation order.

Members
 The right column, Members, shows the members of the set that is highlighted in the left 
column. To add members to an existing set, go to the Project window and highlight the 
names of the groups to be added.  Then return to the Selection Sets window.  

Figure 74 — Selection Sets Window
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In the left column, highlight the set name to which you wish to add the objects and click 
on the add button on the right side of the dialog box.  Members of sets or whole sets can 
be removed by highlighting the item and clicking on the remove button.
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Materials and Texture Maps

Introduction

In this chapter we will discuss the new Materials and Texture Map features in Electric 
Image 2.8. Materials are what the rendering engine uses to give shading and detail to a 
group. Textures are a component of Materials (new to ElectricImage  — previously tex-
tures were treated separately).  Procedural Shaders are also a component of Materials, and 
are covered in Chapter X-X Procedural Shaders.

Great effort has been spent conforming to industry standard material terms and behavior 
wherever possible.  This was done to allow you to take advantage of the myriads of books 
and publications which cover the topics of 3D which are now available, and to make Elec-
tricImage even easier to use than ever before.

Overview of New Features

The following highlights will give you an idea of the radical changes to the Materials and 
Texture Map capabilities of ElectricImage 2.8. 

• Master Materials (materials that groups can subscribe to)
• Materials Can Be Saved To Disk
• Industry Standard Material Controls
• New, Easy to Use Interface Design
• Displacement Maps
• Clipping Maps
• Procedural Shaders
• Unlimited Texture Maps
• Precise Texture Mapping Controls
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Materials Defined

Materials are a collection of shading attributes that you create and apply to a group (or 
groups.) Materials can also contain texture maps and procedural shaders. You can apply 
materials from saved material files on disk, from materials created in the Material Info 
Window, or from Master Materials. 

Master Materials

Master Materials are new to ElectricImage 2.8. They are visible in the Project Window, and 
can have many groups parented to them. Master Materials will replace all of the attributes 
of the groups parented to them (you will still have to tweak the texture map alignment to 
fit each particular group for the best results, unless the groups are similar in shape.) You 
can have as many Master Materials as you wish in a project. To add a Master Material to a 
project, choose File>Add>Type>Material. You will now see the Material at the top of the 
item list in the Project Window.

Accessing the Material Info Window

In order to create or edit a material, you need to get to the Material Info Window. There 
are four ways to access the Material Info Window:
• Select the Group, and click the Material Info Window icon in the Project Window
• Command double click on a Group in any window
• With the Group Info Window open, click on the Material Ball icon
• Double click a Master Material in the Project Window

The Material Info Window

The Material Info Window sports a totally new look and feel. All of the material “chan-
nels” now have their own tabs, with each tab containing the controls and functions indi-
cated by the name of the tab. To access the contents of the tab, just click on it.
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Figure 75 — The Material Info Window

Above the tabs you see the material ball icon to the left. The material name edit field is just 
to the right of that. Below are the Load and Save Material buttons, and below them is the 
Create New Master button. To the right of the buttons is the Material Statistics section, 
which illustrates the makeup of the material.

The material ball icon shows a live preview of the settings of the various material chan-
nels. To copy a material, select the Material Ball Icon and choose Copy.  To paste a new 
material into this material record, select the Material ball icon, and choose paste. (The 

material ball icon is covered in the ElectricImage Series 2 Reference Manual and Adden-

dums.)

Materials can be named, and saved for other groups to use. To assign a name to a material, 
click in the material name edit field, and type the desired text. The name will “stick” when 
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the material has been saved.

Loading and Saving Materials

One of the most powerful new features is the ability to create a material and save it to disk 
to be called up any time it is needed. The material is saved to a directory within your Elec-
tricImage directory called “EI Material.” The saved material contains the settings of the 
various material channels (diffuse, specular, etc.), as well as, external references to texture 
maps and procedural shaders.

To load a material
• Click the Load button
• Choose a material from the directory
• Double click the material or click the open button

The material is now applied to the group. Groups can only have one material assigned to 
them, whether you assign a material to a specific group, or whether you assign a group to 
a master material.

To save a material
• Make sure that the material is named
• Click the Save button

The material is then added to the EI Material directory. ElectricImage does not provide 
any indication that the material has been saved. To check this you can save it again, if you 
like. When you do, you will then be asked if you wish to replace the material (indicating 
that it was previously saved.)

Creating New Master Materials

You can create new Master Materials from the Material Info Window of a particular 
group, or you can add them to a project as described previously. Groups can be linked to 
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them with a special material link command described in the Master Materials section.
Groups can be passively linked to a Master Material, or they can be “live linked.” Pas-
sively linked groups will require a manual update to receive any changes that are made to 
the Master Material they are assigned to. Live linked groups will be updated immediately 
upon any change to the Master Material they are assigned to.
 
To create a Master Material
• Set up your material
• Click on the Create New Master button
• A dialog will appear, prompting you to name the material.

A Master Material version of the material you were editing now appears in the Project 
Window item list. You will note that two new buttons have now been added to your mate-
rial, just below the Create New Master button: Reload from Master and Update Master.

Reload From Master
This button appears in groups that are passively linked, not live linked, to a Master Mate-
rial, and reloads the material properties from the Master Material. This is useful if you are 
exploring a change to a material but decide you prefer the original.

Update Master
This button appears in groups that are linked, not live linked, to a Master Material, and 
replaces the Master Material with the current material. Groups that are live linked to the 
master will be immediately updated.

New Material Interface

With ElectricImage 2.8, the Material Info Window now presents all material channels in a 
tab context. This makes all of the shading attributes of ElectricImage very accessible and 
easy to use. It should not take very long to get acclimated to the new interface.
To edit a particular channel within a material, just click on its tab. A material channel is a 
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shading component, referred to as “surface attribute” in the ElectricImage Series 2 Refer-
ence Manual. We are calling them channels now to more appropriately reflect their nature 
and how you can use them. There are eight material channel tabs:

• Geometry
• Diffuse
• Specular
• Ambient
• Reflectivity
• Transparency
• Luminance/Glow
• Transmission

Each channel tab contains the many attributes which are controlled by the channel, 
including texture maps and procedural shaders.

The Geometry Tab

The geometry tab contains all of the material channels and attributes which affect the 
apparent geometry of a group and how it is shaded. You can add outlines to the group, 
add bump and displacement maps for more detail, or punch actual holes into the group 
with clipping maps (and shadows do see these holes.)

The geometry tab is organized into three basic sections:

• Cel/Outline Shader section
• Bump/Displacement Map list
• Clipping Map list
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Figure 76 — Geometry Tab

Cel/Outline Shader Section
In this section you assign color and thickness to polygon outlines, edge outlines and sil-
houette outlines. Used in conjunction with the Cartoon procedural shader, the look of tra-
ditional 2D cel animation can be achieved. There are three types of line effects:

• Polygon Outlines
• Edge Outlines
• Silhouette Outlines

Polygon Outlines
Activating this setting causes all of the polygons in the group to receive an outline. This is 
similar to wireframe shading, except that the polygon will also be shaded.

Edge Outlines
Activating this setting will cause certain edges to be defined with lines. As the group or 
camera is in motion, the definition of the edges will change, similar to the effect you see in 
traditional 2D animation. The silhouette feature should be active with this feature.
Silhouette Outlines
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This setting causes the silhouette of an object to be drawn in lines. On occasion, the silhou-
ette is not clearly resolved, so it is best to use this feature with the Edge Outline feature 
enabled.

To activate the particular line effect you wish you must click in the check box. You can 
color the lines by clicking on the color swatch and choosing a new color from the color 
picker. To adjust line thickness, type in a new value in the edit box to the right of the line 
type (values are in pixels.)

The way the model is constructed is very important with this feature. If the polygons of 
the model are not properly welded, the edge outline feature will find and render all edges, 
creating unwanted lines within your rendered image. If you notice this happening, re-
import the model with the Combine Coordinates feature turned on (see the ElectricImage 

Series 2 Reference Manual and Addendums for more information on welding vertexes.)

Bump/Displacement Maps List
The Bump/Displacement Maps list is where you add maps of these type. You can add as 
many maps or procedures as you like to this list. Along with the standard bump map, dis-
placement maps are now supported. Displacement maps actually move the vertexes in 
the group using the map to determine how much displacement is applied. 

With bump maps the illusion of depth or relief can be created such as the bark on a section 
of log. The limitation to bump mapping is that the silhouette or edge of the log is perfectly 
smooth and the closer to the edge the more obvious the cheat. With a displacement map 
the geometry is actually moved, so the edge of the log shows relief as well as the center. It 
is important that there be enough vertex points in the group to achieve a satisfactory 
effect. It might be necessary to apply the Dicer plug-in to the group to achieve best results. 
(Dicer is covered in the ElectricImage Version 2.5 Addendum.)

Bump maps and displacement maps can be either a grayscale bitmap image or movie file 
or a procedural shader. Any bitmaps of greater than 256 colors will be converted to gray 
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scale by the rendering engine to achieve the effect. If an alpha channel is present, it can be 
used to control the bump instead. (See the section on Texture Maps for more details on the 

alpha channel.)

To add a bump or displacement map
• Click on the add button next to the bump map list
• Choose the Map
• Double click on the map or click on the open button

The map will be added to the list. You can configure the map by double clicking on the 
name of the map in the map list. (See the section on Texture Maps for more details.)

Controls for the strength of the bump and displacement are found under the Special Tab 
in the Texture Info Window, and these controls can be animated. Setting Bump Factor to 0 
will disable the bump calculation. Setting Displacement to 0 will disable the displacement 
calculations.   (See the section on Texture Maps for more details.)

Clipping Maps List
The clipping maps list is where you add clipping maps to your group. You can add any 
amount of clipping maps or procedures to this list. Similar to transparency maps, clipping 
maps are a quick and efficient way of cutting holes into a group. Unlike a transparency 
map, the clipped region is anti-aliased independent of resolution. Zooming in close, the 
clipped object will still exhibit very clean edges. Clipping maps actually remove geometry, 
so they will create appropriate shadows. 

Clipping maps can be either a grayscale bitmap image or movie file or a procedural 
shader. Any bitmaps of greater than 256 colors will be converted to gray scale by the ren-
dering engine to achieve the effect. If an alpha channel is present, it can be used to control 
the clipping instead. (See the section on Texture Maps for more details on the alpha chan-

nel.)
ElectricImage 2.8 Supplement        97



Materials and Texture Maps — The Diffuse Tab
To add a clipping map

• Click the Add button next to the Clipping Map list
• Select the map or procedural from the dialog
• Double click the map, or click the open button

The Clip factor edit box is found in the Texture Info Window under the special tab, and 
controls the strength of the clipping map, where 0 is fully transparent and 1 is fully 
opaque.

The Diffuse Tab

The diffuse tab contains all of the material channels and attributes which affect the diffuse 
channel of a group. The diffuse channel is where color is applied, and you will note that 
there is no longer a surface color attribute. (This was done to more closely conform to 

industry standard guidelines. By conforming to as many industry standards as possible, 

much of the information available in magazines and books which cover the 3D spectrum 

will be applicable in ElectricImage, making it easier to learn and use.)
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Figure 77 — The Diffuse Tab

The diffuse tab is organized into two basic sections:
• Diffuse parameters
• Diffuse Maps list

The diffuse parameters section contains a color swatch, slider bars for controlling the 
amount of energy transmitted by the group, the falloff of that energy, and the mask opac-
ity for the group. There is also a checkbox that allows you to use the original polygon col-
ors of the group (some modeling programs let you assign unique colors to individual 

polygons, which you may want to keep.)

Color Swatch
To choose a diffuse color, click on the swatch and pick a new color from the color picker. 

Use Polygon Color
This check box forces the renderer to use the color assigned to the individual polygons of 
the group when it was created. Assigning a color to the group with the swatch will ignore 
all of the polygon colors in the group. You can revert back to the original color of the 
group with this checkbox.
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Amount
Use this slider to darken the group’s color. The slider bar will use the color in the swatch 
(or the polygon colors if Use Polygon Color is active) as top end of the range (brighter). 
You can also type in a value in the Amount edit box. The Amount slider is a nifty way of 
keeping your diffuse color intact while adjusting the brightness levels of the group. 

Falloff
Falloff was formerly called Shading Dropoff, and sets transition value from fully shaded 
to not shaded. Larger objects to have sharper falloff values (such as planets, where .25 is a 
good falloff value.) Smaller objects on a less astronomical scale to stay at 1.0.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Falloff 

is one of the attributes that allow this.

Mask
This slider affects the alpha channel for the group (often called a Mask or Matte) in the 
final render. This feature can be used in conjunction with a compositing effects. If you 
want the group to appear normally in the scene, then leave the value at 0.0 (opaque on the 
slider.) If you want the group to act as a cutter, removing its shape from the scene, then set 
the value of the mack attribute to 1.0 (transparent on the slider.) Note that a true hole will 
be left behind, if the group is obscuring another object if this setting is anything more than 
0.0.

Diffuse Maps list
The diffuse maps list is where you add color maps, procedural shaders, or diffuse value 
maps. You can put as many maps as you like in this list. Maps can be single frames or 
movie files, and can be any bit depth desired.

To add a diffuse map to the list
• Click the Add button next to the Diffuse Map list
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• Select a map or procedural shader from the file list
• Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the sec-

tion on Texture Mapping for more information.)

The Specular Tab

The specular tab contains all of the material channels and attributes which affect how the 
various specular attributes of a group will shade. The specular tab is organized into two 
basic sections:

• Specular Attributes
• Specular Map List
 

Figure 78 — The Specular Tab

The Specular Attributes section contains a color swatch, slider bars for controlling the 
amount of specularity, gloss, size and falloff, and a diffuse bias check box.
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Color Swatch
The color swatch is used to set the color of the specular highlight. To choose a color, click 
on the swatch and pick a new color from the color picker. This setting is ignored if the Dif-
fuse Bias setting is active.

Diffuse Bias
This check box forces the specular color to be equal to the diffuse color. The color of the 
highlight is added to the diffuse color, making the highlight brighter than the surrounding 
area. This is analogous to the way that highlights work in the real world, and defaults to 
on (which ignores the color in the color swatch.)

Amount
The Amount slider controls the brightness of the specular highlights that appear on the 
group. A value of 0 turns off the highlight.   Type is a value greater than 1.0 in the Amount 
edit box for an even brighter highlight.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Specu-

lar Amount is one of the attributes that allow this.

Gloss
The gloss slider adds a gloss or sheen to your group. It imitates what the group would 
look like if it were a bit reflective, removing color from the surface around the highlight. It 
can create an odd look, so you might want to use this sparingly.

Size

Controls the size of the highlight on the group. The smaller the number, the larger the 
highlight. Values of greater than 1.0 can be typed into the Size edit box.
Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Specu-

lar size is one of the attributes that allow this.
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Falloff
Controls the sharpness of the highlight. Larger numbers give a sharper, more abrupt tran-
sition, and smaller values produce a smoother and less defined highlight.

Specular Maps List
A specular map controls the area in which the specular highlight is visible on a group, as 
well as the value (brightness) of the highlight or the color of the highlight. Specular value 
maps can be either a grayscale image or movie file or procedural shader. Any bitmaps 
greater than 256 shades will be converted to gray scale by the renderer for specular value 
maps. If an alpha channel is present, it can be used to control the specular instead of the 
RGB channel. (See the section on Texture Maps for more details.)

To add a specular map to the list
• Click the Add button next to the Specular Map list
• Select a map or procedural shader from the file list
• Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the sec-

tion on Texture Mapping for more information.)

The Ambient Tab

The ambient tab contains all of the material channels and attributes which affect the ambi-
ent shading characteristics of the group.  Ambient is a simulation of ambient fill light, and 
you can make the ambient take a different color cast than the diffuse channel.
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Figure 79 — The Ambient Tab

There are two basic sections to the ambient tab:
• Ambient Attributes
• Ambient Map List

The ambient attributes section contains a color swatch and a slider bar.

Color Swatch
Controls the color cast of the ambient fill light on the group. To change the color, click on 
the color swatch and pick a new color from the color picker.

Amount
Controls how the group responds to ambient light. Larger numbers will make the group 
appear to have more fill color, and be a little less defined. Higher fill values would be 
appropriate for objects in sunlight. Lower fill values would be more appropriate for night 
time or deep space shots.

Ambient Map List
Ambient maps can affect the color of the ambient effect, the value of the effect, and the 
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areas of the group that receive the ambient effect. You can have as many ambient maps as 
you like in the material. An ambient map can be an image or movie file or a procedural 
shader.

To add an ambient map to the list
• Click on the Add button next to the Ambient Map List
• Select the map
• Double click the map, or click the Open button

The map is now added to the list.To configure the map, double click on the map name in 
the list. To reorder the map in the list, just drag it to its new location. (See the section on 

Texture Mapping for more information.)

The Reflectivity Tab

 The reflectivity tab contains all of the material channels and attributes which affect how 
and what the group will reflect. The reflectivity tab is one of the more complex tabs in the 
Material Info Window. There are four main sections to the reflectivity tab:

• Reflectivity Configuration (How the Group Reflects)
• Reflection Configuration (What the Group Reflects)
• Reflectivity Map List
• Reflection Map List

Both the Reflectivity Configuration section and the Reflection Configuration section are 
comprised of additional subsections.
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Figure 80 — The Reflectivity Tab

The Reflectivity section resides within the left side of the tab, and the Reflection section 
resides on the right side of the tab.

Reflectivity Configuration Section

The reflectivity configuration section contains the basic reflectivity controls and special-
ized edge attenuation controls.    

Amount
The Amount slider is used to control overall reflection amount. The value in the Amount 
edit box can be set to greater than 1.0 

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Reflec-

tion Amount is one of the attributes that allow this.
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Color Swatch
The color swatch tints the group’s reflection. It is disabled if the Reflection Bias checkbox 
is enabled.

Reflection Bias
This check box forces the reflected color to be equal to the diffuse color. The reflection is 
then added to the group by whatever percentage is set in the Amount attribute. This is 
more realistic than setting the color of the reflection manually, and defaults to on. 

Edge Control (Attenuation)
Edge control allows you to attenuate the reflection across the surface of the group. Essen-
tially, this means that the reflection is stronger towards the edges, and less visible in the 
center of the group. Reflective objects tend to follow this behavior most real world objects.

The Amount value controls the amount of edge reflection. Values of greater than 1.0 can 
be typed into the edit box.

Some sliders will accept values of greater than 1.0, or less than zero. You can adjust the 

value by typing in the value that you wish in the edit box to the right of the slider. Edge 

Amount is one of the attributes that allow this.

The Falloff value controls how the reflection will fall off towards the center of the group. 
The higher the number, the less reflection you will see at the center of the group. This 
value is not considered if the Edge Amount value is 0.0.

To the right of the edit boxes is a graph area, which shows the relationship of the Edge 
Amount and Falloff values. With the Edge Amount set to 1.0, and the Edge Falloff set to 
0.0, the graph will appear as a white square (the default.) This indicates that the reflection 
will appear evenly across the surface of the group. As you adjust the relationships 
between the two values, you will see the graph change to reflect the new values.
Reflectivity Maps List
A reflectivity map controls how the group will any reflection maps assigned to it in the 
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Reflection Map section. It can also control what areas of the group receive a reflection, and 
how much of it. Any bitmap image, movie or procedural shader can be used as a reflectiv-
ity map.

To add a reflectivity map to the list
• Click the Add button next to the Reflectivity Map list
• Select the map or procedural shader from the file list
• Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to the new location. (See the sec-

tion on Texture Mapping for more information.)

Reflection Map Configuration Section

Reflection maps are what the group is actually reflecting. Reflection maps can be bitmaps, 
either still or movie files. Procedural shaders cannot be used for reflection maps. Reflec-
tion maps can also be automatically generated by ElectricImage. These are called mirror 
maps, which are flat, and environmental maps, which are cubic. The controls for the auto-
matic maps are in the Environment Reflection subsection.

In the main Reflection Map Configuration section, there are three check boxes:

• Use Global Maps
• Use Bitmap Reflection
• Use Environmental Reflection

Any or all of these settings can be selected at any time.

Use Global Maps
This check box enables the reflection maps applied under the World Info Window located 
in the Project Window as a reflections for the group. This setting allows as many groups as 
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you wish to use the same reflection. This map can also function as a “default” reflection 
map, removing the need to physically assign a reflection map to the group.

Use Bitmap Reflection
This check box enables the group to reflect maps from the reflection map list.

Use Environment Reflection
This check box enables any of the selected Environment Reflections specified in the Envi-
ronment Reflection subsection.

Environment Reflection Subsection

There are three choices in the subsection:
• None
• Mirror
• Environment

None
No map is selected. This is the default condition.

Mirror
Mirror maps are flat, and automatically render an exact mirror reflection, relative to the 
established mirror plane. You control the mirror plane through the Configure… button in 
the subsection. It is necessary to establish a plane to guarantee expected results. (See the 

section on Texture Mapping for more information.)

Environment
Environment maps are cubic reflection maps that are automatically created by the render-
ing engine. The rendering engine creates six images representing the faces of the cube. 
These images then form the basis of the reflections on the group. You can control the reso-
lution of the environment map with the Configure… button. The resolution settings are in 
an edit box available under the Projection tab. (See the Texture Mapping section for more 
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information.)

Please note that environmental reflections and mirror reflections can add up rendering 

time if you use alot of them. These methods provide a much faster reflection than ray 

traced reflections, as long as they are not abused. Over use of these types of reflections 

can engender render times equal to or greater than ray traced reflections available in 

other programs.

To save render time, you can set an automatic environment map to calculate its reflection 
only once. This setting is available through the Configure… button, in the Filter tab. (See 

the Texture Mapping section for more details.)

Reflection Map List
The reflection map list is where you add the bitmap images or movies that you wish the 
group to reflect. 

To add a reflection map to the Reflection Map List
• Click on the Add button next to the Reflection Map list
• Select a map from the file list
• Double click the map, or press the Open button.

The reflection map is added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag it to its new location. (See the Tex-

ture Mapping section for more information.)

The Transparency Tab

The transparency tab contains all of the material channels and attributes which affect the 
transparency of the group. Several improvements and modifications have been incorpo-
rated in the transparency calculations used by the rendering engine, and industry stan-
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dard presentations of the transparency attributes have been incorporated into the 
interface where ever possible.

Please note that the specular highlight and reflection calculations for the group are no 
longer affected by the transparency settings. They will remain set to whatever values you 
have chosen.

Figure 81 — The Transparency Tab

The transparency tab contains four sections:

• Transparency Attributes section
• Edge Characteristic section
• Transparency Map list
• Transparency Edge Map list

Transparency Attributes Section
The transparency attributes section contains controls for setting the actual transparency of 
the group. The slider bar controls the amount of transparency. The three buttons to the 
right of the slider control the type of transparency applied to the group:
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• Filter
• Color Filter
• EI Filter

Filter
Filtered transparency groups are mathematically “averaged” into the scene, meaning that 
they do not change the appearance of any groups that fall behind them, with the excep-
tion of dimming the brightness values of those groups by the value set for the transpar-
ency. This effect does not reflect how transparent objects behave in the real world, and 
tends to be used primarily for special effects. 

Color Filter
Color filter transparencies are either subtracted from the scene or added to the scene, 
depending upon which choices you make in the filter mode subsection. (The filter mode 

subsection is visible only if this option is selected.) 

Figure 82 — Figure X-X Filter Mode Subsection

The filter mode subsection is divided into two areas:

• Filter Mode
• Filter Color

Filter Mode
Filter Mode determines the method in which the transparency will be applied to the 
scene. 

Subtractive transparencies most accurately mimic the effect of transparent objects in the 
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real world. Groups which pass behind a subtractively transparent group will be tinted to 
color of the transparent group, as the color of the transparent group is subtracted from 
whatever is behind it. 

Additive transparencies are typically used for special effects purposes, such as glowing 
balls of energy and so forth. Groups which pass behind additive transparent groups will 
appear brighter, as the color of the transparent group is added to whatever is behind it.

Filter Color
Filter color is used to determine the color that will be used for the filter effect. 

The Use Surface Color option will use the Diffuse channel and all attributes assigned to it 
for the filtering process set by the Filter Mode switch. This is the most realistic setting, and 
the default.

The Use Custom Color option will use the color in the swatch next to the item as the filter-
ing color. It will ignore all of the attributes in the Diffuse channel. To change the color of 
the swatch, click on it and pick a new color from the color picker.

EI Filter
This setting is included for project file compatibility with previous versions of ElectricIm-
age. (See the ElectricImage Series 2 Reference Manual and Addendums for a complete dis-

cussion on this type of transparency.) The new transparency methods offer far more 
control and ease of use than this method, and should be ignored.

Figure 83 — EI Filter Options

When this option is selected, the EI Filter options subsection appears. It consists of two 
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items:

• Use Surface Color
• Use Custom Color

Use Surface Color
This option will use the diffuse channel and all attributes associated with it as the filtering 
process for the transparency. This item is new to ElectricImage 2.8. 

Use Custom Color
This option will use the color in the swatch as the filter color. This is analogous to the 
methods used by previous versions of ElectricImage. To change the color in the swatch, 
click on it and pick a new color from the color picker.

Transparency Map List
Transparency maps can be applied to modify the amount of transparency or to modify the 
color of the transparency. You can have both types of maps in the list. Maps can be bitmap 
images and movie files, or procedural shaders. 

To add a transparency map to the list
• Click on the Add button next to the transparency map list
• Choose a map from the file list
• Double click on the map, or press the Open button
The map is added to the list. To configure the map, double click on the map name in the 
list. To reorder the map in the list, just drag the map to its new location. (See the section on 

Texture Mapping for more information.)

Edge Characteristic Section
The items in this section control the effect of the edge of an group, regardless if the group 
is set to be transparent or opaque.   For transparent groups, you can adjust the opacity of 
the edge, and the falloff when the edge gets more opaque. For opaque groups, you can 
adjust when the edge of the object becomes more transparent. There are two sliders which 
114       ElectricImage 2.8 Supplement    



Materials and Texture Maps — The Transparency Tab
affect the look of the edge:

• Amount
• Falloff

The Edge Characteristic sliders work similarly to the Edge Reflection sliders (covered in 

the Reflection Tab section.) The type of effect achieved is determined by the three edge 
control buttons described following the Amount/Falloff discussion.

Amount
This slider determines the amount of edge transparency or opacity applied to the group. 
The falloff value (described below) must be set to a value other than 0.0 to see the effects 
of this slider.

Falloff
This slider determines how the edge will intrude into the body of the group. The Edge 
Amount slider must have a value other than 0.0 to see the effect.

Edge Graph
To the right of the sliders and edit boxes is the edge graph, which shows the relationship 
of the Amount and Falloff parameters in graphic form. It updates in real-time as these val-
ues are edited.

Edge Control Buttons
There are three radio buttons which control the treatment of the edge of the group:

• Normal
• Opaque
• Transparent

Normal
No edge characteristic is applied. The transparency effect is carried evenly through the 
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group. This often yields a group with less definition, and is considered less realistic for 
transparencies.

Opaque
The edges of the group will be opaque, using the parameters set by the Amount and Fal-
loff sliders. For transparent objects, this option yields the most realistic results, with the 
Amount and Falloff values set to your preference.

Transparent
The edges of the group will be transparent, using the parameters set by the Amount and 
Falloff sliders. Opaque objects can be made to have clear, fluffy edges, and can be used for 
such things as clouds, cotton balls, or planet atmospheres.

Transparency Edge Map List
Transparency edge maps work the same as the transparency maps and can affect the value 
or color of the transparency at the edge of the group.

To add a transparency edge map to the list
• Click on the Add button next to the transparency edge map list
• Choose a map from the file list
• Double click on the map, or press the Open button

The map is added to the list. To configure the map, double click on the map name in the 
list. To reorder the map in the list, just drag the map to its new location. (See the section on 

Texture Mapping for more information.)

The Luminance/Glow Tab
The luminance/glow tab contains all of the material channels and attributes which affect 
the luminosity and glow effects that a group can have applied to it. 
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Figure 84 — The Luminance/Glow Tab

The luminance/glow tab is divided into four sections:

• Luminance Color
• Glow Color
• Luminance Map List
• Glow Map list

Luminance Color Section
The luminance value controls the group’s apparent luminescence. This value does not 
actually cause the group to emit light, but rather glow like an LED would glow. The slider 
controls the luminance of the group, using either the color in the color swatch, or the dif-
fuse shading channel of the group. Texture maps can also be used to control the lumines-
cence of the group. 

Use Color Button
The use color button will cause the group to luminesce with the color in the color swatch. 
The change the color in the swatch, click on it and pick the color from the color picker.
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Use Shading Button
The use shading button will cause the group to luminesce with the values found in the 
diffuse channel.

Luminance Map List
Luminance maps can be either value maps or color maps. In the case of grayscale the 
white areas of the map will illuminate to white and black areas will not illuminate. In the 
case of a color map the illumination will possess the colors of the map.

To add a map to the luminance map list
• Click the Add button next to the map
• Select a map from the file list
• Double click the map, or press the Open button.

The map will now be added to the list. To configure the map, double click on the map 
name in the list. To reorder the map in the list, just drag the map to the new location. (See 

the section on Texture Mapping for more information.) 

Glow Color Section
The glow effect causes groups to apparently emit a glowing area around the group. The 
glow is a compositing effect added at the end of each rendered frame. Glowing groups 
will not effect the appearance of other groups in the scene. Setting up glows properly 
requires the following procedure:

• Setting the glow attribute in the group’s material
• Assigning the group to a selection set
• Adding a the selection set to the glow layer tab in the Render Information Window
• Set up the glow layer

Setting the Glow Attribute in the Group’s Material
In the Glow Color section, you can control the amount that an object will glow, the color or 
shading of the glow, and whether the group will actually glow, or have a glare on the 
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brighter areas of the group (which you can control.)

Glow
The Glow radio button will use the color swatch as the glow color. The value of the glow 
is set by the Glow Amount slider. To change the color in the color swatch, click on the 
swatch and pick a color with the color picker. The actual area of glow is determined by the 
attributes of the Glow Layer, found in the Glow Layer tab of the Render Information Win-
dow. If the group is not part of a selection set contained within a Glow Layer, then the 
group will not appear to glow in the rendering.

Glare (Radiate)
The glare button will use the diffuse channel to create a glare around the group. The 
amount slider determines the brightness cutoff for the glare. Typically, a fairly subtle cut-
off is desired, as glares tend to be less overpowering than glow effects. 50% is a good 
value for the brightness cutoff to begin with. You can have the entire group “radiate” by 
setting the slider to 1.0. This makes the group appear to be heavily over-exposed, depend-
ing upon the settings in the glow layer to which the group’s selection set is assigned.

In determining which pixels will glare, the group is first rendered, and then a luminance 
calculation is performed. Any pixels which fall within the specified tolerance will be 
blurred by the amount specified in the Glow Radius attribute of the Glow Layer, and then 
added back onto the scene by the amount specified in the Intensity attribute of the Glow 
Layer to which it is assigned. Glow Radius values of 50 pixels or greater, plus a Glow 
Intensity of 1.5 will give you a good starting point for a nice glare effect (reminiscent of the 
effects seen in the CD-ROM game “Riven,” by Cyan Interactive.)

The actual area of the glare is determined by the attributes of the Glow Layer, found in the 
Glow Layer tab of the Render Information Window. If the group is not part of a selection 
set contained within a Glow Layer, then the group will not appear to have a glare in the 
rendering.
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Assign the Group to a Selection Set
• Select the group
• Choose Select>By Set>Edit Sets
• Click the Add button in the Selection Sets section of the window that appears
• Type in the name of the set and hit return
• Select the name of the set that now appears in the list
• Click the Add button in the members section of the window
• Close the window

All of the selected groups will now be part of that named selection set.

Figure 85 — Edit Selection Sets Window

(For more information on Selection Sets, see the Selection Sets chapter.)

Add the Selection Set to a Glow Layer
• Open the Render Information Window (File>Render…)
• Select the Glow Layer tab
• Click the Add button in the Glow Layer Section
• Type in Glow Layer name in the edit field and hit return
• Select the Glow Layer in the list
• Click the Add button in the Glow Layer Member section
• Select the desired selection set from the list that appears, and click the Add button
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Figure 86 — Render Information Window

The selection set is now added to the glow layer. (See the Chapter on the Render Informa-

tion Window for more details about working with Glow Layers.)

Set Up the Glow Layer
• Select a Glow Layer from the Glow Layer List
• Type in a value for the Glow Radius in pixels
• Type in a value for Glow Intensity

The smaller the pixel number in the Glow Radius edit box, the more defined and brighter 
the glow will appear. Larger values in the Glow Radius edit box might require an adjust to 
the Glow Intensity value to achieve the desired effect. Glow effects will typically be 2 or 
greater in intensity, while Glare effects will probably not be brighter than 1.5, but feel free 
to experiment.

The previous steps cover typical glow and glare usage. (For more information, see the 

chapter on the Render Information Window, Glow Layer section.)

Glow Color Maps List
Glow maps can be applied to control the amount of glow, and to control the color of the 
glow. Glow maps can be a bitmap image or movie file, or a procedural shader. You can 
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have as many glow maps as you like.

To add a map to the glow color maps list
Click the Add button next to the glow color maps list
Select a map from the file list
Double click the map, or press the Open button

The map will now be added to the list. To configure the map, double click on the name of 
the map in the list. To reorder the map, just drag the name to the desired location in the 
list. (See the section on Texture mapping for more information.)

The Transmission Tab

 The transmission tab contains all of the material channels and attributes which affect the 
transmission characteristics of the group. Some objects in the real world can allow light to 
go through them to a degree. This effect can be seen of you were to hold up a leaf to the 
sun. You would notice the spidery vein network as darker shapes, and the thinner parts of 
the leaf would appear brighter. The transmission channel lets you correctly reproduce this 
effect.
122       ElectricImage 2.8 Supplement    



Materials and Texture Maps — The Transmission Tab
Figure 87 — The Transmission Tab

The transmission tab is divided into three sections:

• Transmission Color Section
• Transmission Edge Control Section
• Transmission Maps List
• Edge Transmission Maps List

Transmission Color
This attribute determines the transmission amount and color. The best transmission color 
is white, as it will conform to the color of the group and any maps, plus the lightsource. 

Edge Control Subsection
Transmission edge control works the same as with edge transparency, allowing you to 
build less translucent edges to curved groups the way they would appear in the real 
world.

Edge Amount
Controls the transmissiveness of the edge. The Edge Falloff slider must have a value other 
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than 0.0 to see the effect.

Edge Falloff
This slider determines how the edge will intrude into the body of the group. The Edge 
Amount slider must have a value other than 0.0 to see the effect.

Edge Graph
To the right of the sliders and edit boxes is the edge graph, which shows the relationship 
of the Amount and Falloff parameters in graphic form. It updates in real-time as these val-
ues are edited.

Transmission Maps List
Transmission maps are used to control the value and color of the transmission. Transmis-
sion maps can be a bitmap image or movie file, or a procedural shader. After a map is 
assigned the slider no longer has any effect all the transmission information is derived 
from the value of the map.

The best way to achieve a natural look is to assign a standard color map under the Diffuse 
tab and then a grayscale transmission map under the Transmission Tab.

To add a map to the transmission map list
Click the Add button next to the transmission maps list
Select a map from the file list
Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the name of the 
map in the list. To reorder the map, select the name and drag it to the desired location. (See 

the section on Texture Mapping for more information.)

Edge Transmission Map List
Edge transmission maps are used to control the value and color of the edge of the group. 
Edge transmission maps can be a bitmap image or movie file, or a procedural shader. 
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After a map is assigned the slider no longer has any effect all the transmission information 
is derived from the value of the map.

To add a map to the edge transmission map list
Click the Add button next to the edge transmission maps list
Select a map from the file list
Double click the map, or press the Open button

The map is now added to the list. To configure the map, double click on the name of the 
map in the list. To reorder the map, select the name and drag it to the desired location. (See 

the section on Texture Mapping for more information.)

Using Texture Maps

ElectricImage 2.8 introduces unlimited texture maps per group. Texture maps are an inte-
gral component of a material — not separate, as in previous ElectricImage versions. Tex-
ture maps do different things, depending upon the tab and map list in which they reside. 
The same map can be used in many different channels, and each channel can have an 
unlimited amount of maps as well.

All of this power can come at a price if you are not frugal with your map management. Be 
careful not to waste maps and map memory. If you just need a grayscale value for a bump 
map, then you would be wasting over 1 MB of RAM (for a typical map) if that same map 
also had RGB channels associated with it.

New map placement controls have been added that allow face to face precision of map 
placement. These tools augment the original projection mapping approach found in previ-
ous versions of ElectricImage. Multiframe maps can be easily controlled with start and 
stop times and stop ranges. Most of the map functions described in this section can also 
pertain to procedural shaders, another new addition to ElectricImage 2.8.
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Map Lists
Maps are managed within map lists. Each channel contains a map list where appropriate. 
Map lists are a jumping off point to map configuration and management.

Map Order
Map order is very important, as some effects may not be obvious of maps are out of order. 
Fortunately, reordering maps within a channel is easy — just drag the maps to whatever 
order you wish.

Map Alpha Channels
Alpha channels now take on a more specific meaning in ElectricImage 2.8, both to make 
the process of using texture maps easier, and to conform to industry standards. There are 
essentially three ways to use an alpha channel within a texture map:

• Ignored
• As Value
• As Mask

These items will be explained in detail further in this section.

They Way it All Works

Maps add into the list from the top. Think of the list being stacked on top of the group. 
The map at the top of the list is the uppermost one, while the map at the bottom is inner-
most, nearest the actual surface of the group. The maps can be reordered by dragging 
them up or down in the list. 

The circle next to each map is a checkbox that can be used to enable or disable the map. 
This feature is very useful while developing new materials. 

Texture maps can be copied and pasted from one map list to another. To copy the map, 
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highlight the map, select Copy Texture from the Edit menu. To paste the map, select the 
list you want paste it into by clicking somewhere in the list box. The list box will show that 
it has been selected with a thick black outline (as shown in Figure x.x Diffuse Map List 

Box). Use the Paste Texture command from the Edit menu to complete the operation.

Figure 88 — Diffuse map list box

To configure the texture map, double-click on the name of the map in the list box. The Tex-
ture Info Window will open. This window displays the group to be textured and the map 
projection (on the right) and has a series of tabs and buttons for controlling texture scaling, 
tiling, etc. (on the left).

Figure 89 — Texture Info Window
Map Alignment Buttons
There are four map alignment buttons at the upper left of the window assist in map place-
ment, in addition to the projection map methods from earlier versions of ElectricImage. 
These buttons are:
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• Move
• Select Polygons
• Fit to Selected
• Align Map Plane (to Polygon) 

Move
The default option which allows you to move the map projection around in the window 
for proper placement on your model. Dragging left/right at the edges of the projection 
will scale the map. Holding down the control key while dragging will rotate the map.

Select Polygons
The next button allows you to select polygons by clicking on individual polygons (shift 
click to add or remove polygons to the selected list) or dragging a marquee around them. 
The selected list of polygons is used by the third button.

Fit to Selected
This button sets texture projection to the extent of the polygons selected with the Polygon 
Selection Button. 

Align Map Plane (to Polygon)
The last button sets map plane to any polygon clicked on. The size of the map is main-
tained with this tool. Align Map Plane is a very powerful feature for aligning the projector 
to tricky curved surfaces. This feature is also available while in Move mode by Command-
clicking on a polygon

 

Map Alignment Tab

The alignment tab contains the position and rotation information for the texture map. The 
map alignment tab is divided into three sections:
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• Alignment Radio Buttons
• Position Information
• Rotation Information

Figure 90 — Map Alignment Tab

The Alignment Radio Buttons 
These buttons provide a straightforward way of aligning the texture map. The basic map 
projections are:
• User
• Middle
• Front
• Back
• Top
• Bottom
• Left
• Right
• Polygons 
These projections will align and scale the map along the axis noted by the radio button.

Position Information
The position information section contains X,Y, and Z readouts for map position, as well as 
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a popup menu to control the motion path interpolation method for the map position chan-
nel. You can change the map position by dragging, or by typing values into the edit boxes. 
(For information about the use of Implicit and Explicit keyframe control, see Chapter 

TBD, Keypath Editor.)

Rotation Information
The rotation information section contains X,Y, and Z readouts for map rotation, as well as 
a popup menu to control the motion path interpolation method for the map rotation chan-
nel. You can change the map rotation by rotation tools and keyboard shortcuts, or by typ-
ing values into the edit boxes. (For information about the use of Implicit and Explicit 

keyframe control, see Chapter TBD, Keypath Editor.)

World Coordinates Checkbox
When this checkbox enabled, the map will reside in world space instead of local space. 
Effectively, the map becomes fixed in space at the coordinates specified (you can always 
animate its position, of course), and the group would then be perceived as moving through 
it’s map if the group were moved. (See the ElectricImage Series 2 Reference Manual and 

Addendums for more information on World Space and Local Space.) 

Map Projection Tab
The projection tab is used to determine the type of mapping primitive that the map will 
project, as well as the tiling method and map scale. There are four types of map tiling:

• None
• Hold
• Repeat
• Mirror

None
Disables the map on the specified map axis. Choosing None for both axes will hide the 
map.
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Hold
Displays the map without repeating on the specified map axis. Choosing Hold for both 
axes will cause the map to be displayed only once.

Repeat
Repeats the map along the specified axis. Choosing Repeat for both axes will cause the 
map to repeat continuously within the cone of the light, depending upon the scale of the 
map.

Mirror
Mirrors the map along the specified axis. Choosing Mirror for both axes will cause the 
map to flip flop about both axes.

Figure 91 — Map Projection Tab

Map Type Popup Menu
Map projections use simple primitives to process and align the texture map for rendering. 
There are four types of map projections:
• Flat
• Cylindrical
• Spherical
• Cubic
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Pick the projection which most closely matches the shape of the group. (For more informa-

tion on Map Projections, see the ElectricImage Series 2 Reference Manual and Adden-

dums.)

Map Scale Edit Boxes
The map scale edit boxes can be used to fine tune the scale and fit of the map on the group. 
There are separate values for X, Y, and Z axes.

Image Map Tab

The image map tab contains thumbnails of the RGB and Alpha channels of an image map, 
some statistics about the map, the map cropping rectangle, a Replace Map button, and 
movie playback information for multi-frame map files.

Figure 92 — Image Map Tab

RGB and Alpha Thumbnails
The RGB and Alpha thumbnails give you a quick visual reminder of the contents of the 
map channels. If you click on the thumbnail, a larger image will appear in the view win-
dow the right of the tab. If you double click on the image in the view window, the actual 
image will be displayed in a separate image display window. (See the ElectricImage 2.75 
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Addendum for information on Image Display.)

Replace Image Button
Allows you to replace the current texture file without losing the placement, scaling, and 
other settings.

Cropping Edit Boxes
These coordinate boxes allow you to crop the texture map to any size or portion of the 
map you wish to use. You can crop interactively by first clicking on the RGB or Alpha win-
dows, to bring up the image in the texture window, and then drag the crawling ants bor-
der.

Map Playback Controls
These controls will appear whenever you have selected a mutli-frame map as a texture. 
You can render using all frames of the map or just a sequence of frames, and control when 
the playback will start and end.

Figure 93 — Map Playback Controls

End Condition Popup Menu
This controls how the movie will behave when he end of the file is reached. There are 
three choices:

• Repeat
• Oscillate
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• Hold

Repeat
Repeats the movie when the end of the file is reached.

Oscillate
Cycles back and forth through the movie when the end of the file is reached.

Hold
Holds the movie at the last frame when the end of the file is reached.

Start Frame
The first frame of the animated texture to be used. The first frame of the animated texture 
is considered frame 1 not frame 0.

Frame Range
The number of frames in the sequence. If set to 0, the last frame used will be the last frame 
of the animated texture.

Frame Rate
Controls the number of animated texture frames to increment for every frame of the out-
put animation. This number must be greater than 0.0

Map Filter Tab

The map filter tab contains the image filtering and map strength controls for the texture 
map. This tab also is used to select how the different RGB and Alpha channels will be pro-
cessed. The filter tab is divided into several sections:
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• Map Filter Check Boxes
• Map Quality Edit Boxes
• Map Strength Slider
• Use Channel Popup
• RGB Channel Configuration
• Alpha Channel Configuration

Figure 94 — Map Filter Tab

Map Filter Check Boxes
These check boxes enable map filtering, and the Negative Z function. There are a total of 
three check boxes:

• Interpolate
• Anti-Alias
• Negative Z

Interpolate
Interpolation filters the map as it is applied to the model. It cuts down on aliasing, but can 
also soften the image (especially as the map grows larger than 1.0 in scale.) Disabling this 
feature will sharpen the map, but doing so is not recommended.
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Anti Alias
Texture anti-aliasing is another form of map filtering. With this option enabled, the map is 
effectively anti-aliased twice, first, during the stage in which the map is applied, then, as 
the entire image is anti-aliased. This can cause a loss of high frequency detail in the map, 
which some consider objectionable. Disabling this feature will cause some aliasing, but 
the overall image anti-aliasing might hide the artifacts. Use at your discretion.

Negative Z
Causes the texture map to be projected along both the positive and negative Z axis. The 
map will be projected along only the positive Z axis if this checkbox is off. As an example, 
imagine a flat map placed on a nearly flat disk. If the Negative Z checkbox is on the map 
will appear on both sides of the disk. If the checkbox is off it will appear only on the front 
side.

Map Quality Edit Boxes
These edit boxes offer even more control over the quality of the texture. There are two val-
ues to do so:

• Blur
• Samples

Blur
Allows you to degrade the map sharpness. This tool is useful for blurring a bump map 
that is too sharp and not giving you a clean bump, or taking the edge off of a reflection 
that might appear too busy otherwise.

Samples
Controls the quality of the map. For the most part, 5 samples will yield acceptable results. 
If you wish to improve the quality of your maps even more, just increase this value. 
Higher values will increase rendering time, however.

Map Strength Slider
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This slider controls the amount of affect the current texture has on the group. Use this 
slider when you have multiple texture maps on one group to mix together several maps. 
This value can be animated to cause maps to fade in/out over time.

Use Channel Popup Menu
This popup is used to specify what channels you wish to use and for what purpose. You 
can choose RGB, Alpha or both and then specify if you want it used as color or as value 
and if you want to invert it. There are three choices:

• RGB Only
• Alpha Only
• RGB + Alpha

RGB Only
Uses the RGB channel only for the map. The options field changes when this item is 
selected, offering you the ability to use the map as a color map, or as a value map (which 
case the map will be converted to gray scale.) There is also a button to the invert the map.

Alpha Only
Uses the alpha channel only. The options field changes to the invert map button, allowing 
you to reverse the alpha channel.

RGB + Alpha
Uses both the RGB and Alpha channels. The options for the RGB channel are the same as 
when RGB only is selected. The options for the Alpha channel are: ignore; as Mask, which 
uses the alpha channel as a mask for the RGB channel; and invert, which inverts the alpha 
channel. 

Special Tab

Depending upon the type of map, this tab may be empty or may contain controls for 
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bump/displacement maps, as well as controls and buttons to show or save procedural 
shaders.
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Procedural Shaders — Introduction
Procedural Shaders

Introduction

ElectricImage 2.8 includes a large number of procedural shaders. These shaders are writ-
ten in C and render very quickly. The shaders are stored in the EI Shaders folder and are 
added to your projects just like texture maps. 

Shaders can be added to any material channel you choose (diffuse, specular, etc.) they will 
affect this ‘base’ channel and may optionally affect several others as well. Most often, you 
will add the shader to the diffuse channel.

The shaders have animatable parameters. The numeric entry boxes and the colors can be 
animated to create some very striking effects. (As an example, add the Cammo shader to a 
teapot and animate the Density: value over time).

A shader is added to a material channel using the add button in the Material Info Win-
dow. Once added, you can double-click on the shader to bring up its Texture Info Win-
dow. Under the Special Tab you will find two new buttons: Procedural... and Save 
Procedural as...  The Procedural button brings up the interfaces shown in the rest of this 
chapter. The Save Procedural As button saves a copy of the procedural with the current 
settings as default. This means you can find a unique set of parameters that you like and 
save out a separate copy of the shader with those parameters imbeded in it. 

Note: Changes you make in these interfaces are made at the current time. Make sure you 
don’t create animation information if you don’t intend to.
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Procedural Shaders — Bricks
Bricks

This shader creates a brick pattern on any group it is added to.

Figure 95 — Bricks Shader Interface

Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Specular Channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Brick width
The width of each brick. A value of 1.0 will yield bricks as wide as preview window.

Brick Height 
The height of each brick. A value of 1.0 will yield bricks as high as preview window.

Mortar Thickness 
The width and height of the mortar that separates the brick.
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Procedural Shaders — Bricks
Mortar Depth
The mortar is an inset procedural bump. This controls how deep it is.

Row Vary
Controls brick alignment. If set to 0.0, The alignment between alternate rows of bricks will 
be perfect.

Jagged
Larger numbers will cause extreme variation of the height and length of the bricks.

Brick Pit Frequency
The bricks themselves have a rough surface due to a procedural bump. This value controls 
the number of pits on each brick surface. Useful values are between .001 and .009.

Brick Pit Depth
Controls the depth of the pits on the surface of the bricks. Useful values are between .01 
and .0001.

Mortar Pit Frequency
The mortar also has a rough surface due to a procedural bump. Useful values are between 
.0001 and .0009.

Mortar Pit Depth
Controls the depth of the pits in the mortar. Useful values are between .0001 and .0009.

Brick Vary 
This controls the color variation of the bricks. Useful values are between 0 and 1.

Brick Color
The RGB color of the bricks.
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Procedural Shaders — BumpArray
Mortar Color
The RGB color of the mortar.

Ks 
The Specular value for the Bricks and Mortar. 0 is no specular, 1 is maximum specular

BumpArray
This shader creates an array of dimples. Could be used for the surface of a golf ball or for 
metal floor plating. It is also wonderful for creating a pattern of round holes in an object, 
like the lid of the original Star Trek communicator. Apply the shader to the Transparency 
Channel with a Density of 10.0 and the Bump Color set to black.

Figure 96 — Bump Array Shader

Will affect the Base and Bump Channels.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Hex Grid
Realigns the bumps in a hexagonal pattern.
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Procedural Shaders — BumpyNoise
Radius
Controls the radius of the bumps. 

Spacing 
Controls the distance between each bump. This number can be set small to cause the 
bumps to overlap.

Bump Blend
Distance over which the bumps blend together. Smoothes over transitions when the 
bumps overlap.

Bump Strength 
Controls the magnitude of the bump, how deep or high it is. Can be positive or negative.

Bump Color
The RGB color of the bumped area.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

BumpyNoise

This shader creates a bumpy, noisy pattern. Could be used for alien flesh.
Will affect the Base and Bump Channels.
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Procedural Shaders — BumpyNoise
Figure 97 — Bump Noise Shader

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Bump Strength
Controls the magnitude of the bumps on the surface. Useful range is
 -5.0 to 5.0

Color Threshold
Changes where the color blend begins between Bump Color and Surface Color. 0.5 is right 
in the middle of the bump, 1.0 is right at the top of bump.

Color Range
Controls the variation in color between the lowest and highest points on the surface. Use-
ful range is between 0 and 10.

Bump Color
 The RGB color of the bumped area.

Surface Color
 Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
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Procedural Shaders — Cammo
color, or the next texture map in the diffuse list, come through instead.

Cammo
This is a camouflage shader and is loosely patterned after the standard US “Woodland” 
pattern.

Figure 98 — Cammo Shader

Will affect only the Base Channel.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Surface Color
Sets the RGB value of the underlying surface. The three Cammo regions are applied on to 
of this surface. You can set the alpha to 0.0 to let the object’s diffuse color, or the next tex-
ture map in the diffuse list, come through instead.
There are three different regions added on top of the surface color. They each have the fol-
lowing controls.
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Procedural Shaders — CellLook
Scale
Controls the size of the pieces that make up the region.

Level
Controls how much of the Surface color shows through the region. 0.0 allows all of the 
surface color to show through. 1.0 allows none at all.

Color
RGB color of the region.

CellLook

This shader gives a cartoon-like appearance to the groups it is applied to. The defaults 
have been picked to work well. You may wish to try it, as is,  before changing any of the 
values in the interface. The shader will automatically pick up the diffuse color of the 
object. Therefore, you don’t have to change the color values in the shader for each object 
you use it with.
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Procedural Shaders — CellLook
Figure 99 — Cartoon Cel Shader

Apply to the Diffuse Channel, will affect Diffuse and Specular.

Highlight
If it is on, the highlight (specular) is operated on by the shader.

Specular Range Min/Max
Specular is always in the range of 0 to 1. 0 is no specular, 1 is 100% specular. As the object 
is shaded, pixels with a specular value below the Min: get no specular highlight at all. Pix-
els greater than the Max: get the color in the specular channel of the group after being pro-
cessed by the Brightness and Saturation values.  Between the Min: and Max:, the color is 
ramped.

Brightness
Varies the brightness of the computed highlight

Saturation
Varies the saturation of the computed highlight

Color
When on, the color chosen using the swatch is used instead of the group’s specular color.

Zones
Sets the number of different colors that will be used to shade the group. 

Diffuse Range Min/Max
If the brightness of the pixel being shaded falls into this range, the objects diffuse color is 
multiplied by the Brightness value and applied. If the brightness falls in between ranges 
(as in the case of 0.42), the color is ramped.

Brightness 
The factor by which the diffuse color is multiplied to yield the final pixel color.
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Procedural Shaders — CheckerBoard
Color
If the brightness of the pixel being shaded falls into Min/Max range for this Zone, the 
object’s diffuse color is replaced by this color.

Account for Light Colors 
If on, uses the light’s color to tint the highlight and the diffuse colors. Won’t affect the col-
ors chosen discreetly using the individual color swatches in the shader.

CheckerBoard

Places a checkerboard pattern on the surface.
Will affect only the Base channel.

Figure 100 — Checker Board Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Color1&2
RGB color of the alternating squares.
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Procedural Shaders — Clouds
3D Checker
Makes the procedural act as a solid shader. The checkerboard pattern will repeat through-
out the group.

Clouds

Creates a cloud-like fractal pattern.  Will affect only the Base channel.

Figure 101 — Clouds Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Cloud Threshold
Controls how many cloud puffs are present. Useful range is 2.0 to 0.0.
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Procedural Shaders — ColorNoise
Cloud Range 
Controls the density of the clouds. Useful range is 10.0 to 0.0

Cloud Color
RGB color of the clouds.

Sky Color
RGB color of the area not covered by clouds.

ColorNoise

Creates a psychedelic color pattern, similar to tye-dye.

Figure 102 — Color Noise Shader

Will affect only the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Crumple
Crumple

Creates a bumpy pattern on an object very similar to crumpled aluminum foil.

Figure 103 — Crumple Shader

Will affect the Base and Bump channels.

 Noise Level
Controls how many iterations of noise are computed for the shader. Each successive itera-
tion is half the size of the previous one. More Levels require more rendering time.

Noise Scale
Sets the height at which the High Color is drawn. 

Noise Factor
Each successive level of noise gets smaller by this amount.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Crumple
Bump Scale 
Sets the magnitude of the bump. Can be negated to invert the crumple effect.

Bump Factor
At each successive level of noise is computed the bumps get smaller by this amount.

Animation
Animates the noise pattern over time. A value of 1.0 moves the noise 1 unit of the preview 
square per second. This can be used to create animated water effects. Try doing this by 
animating the Z value for the shader applied to a flat plane.

High Color
Sets the RGB value of the surface at the top of the bumps. You can set the alpha to 0.0 to let 
the object’s diffuse color, or the next texture map in the diffuse list, come through instead.

Low Color
Sets the RGB value of the surface at the bottom of the bumps. You can set the alpha to 0.0 
to let the object’s diffuse color, or the next texture map in the diffuse list, come through 
instead.
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Procedural Shaders — Crust
Crust

Creates a series of high, flat ledges.

Figure 104 — Crust Shader

Will affect the Base and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Coverage 
Controls the region that the Crust Color covers. 0.0 yields no Crust Color. 1.0 will cause 
the Crust Color to cover the entire procedural.

Ledge Level
Controls how far the ledges spread out across the surface.

Ledge Width
Sets the widths of the ledges

Bump Strength
Sets the magnitude of the bump for the ledges. Values can be either positive or negative.
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Procedural Shaders — Cyclone
Crust Color
Sets the RGB value of the ledges.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Cyclone

Creates a vortex pattern. The effect is quite startling when applied to the Transparency 
Channel.

Figure 105 — Cyclone Shader

Will only affect the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Cyclone
Cyclone Radius
The radius of the main body of the swirling vortex. 0.5 corresponds to the width of the 
preview window.

Eye Radius 
The radius of the eye at the center of the vortex. 0.5 corresponds to the width of the pre-
view window.

Twist 
Sets the number of revolutions the vortex makes within the width of the preview window

Scale
Sets the magnitude of the amount of clouds created in the vortex.

Offset
Can be used to make the overall effect more misty.

Omega
Increases the choppyness of the clouds. Useful range is between 0 to 1.

Octaves
Controls the complexity of the noise function. Useful range is 1 to 8

Contrast
Lower numbers decrease the contrast between Color1 and Color2.

S Noise 
A noise seed. Can be used to vary the look of the cyclone. 

D Noise
A noise seed. Can be used to vary the look of the cyclone.
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Procedural Shaders — Dots
Color1
Sets the RGB value of the region not part of the swirling vortex.

Color2
Sets the RGB value of the vortex’ clouds.

Dots

Makes a grid of dots on the surface of the object.

Figure 106 — Dots Shader

Will only affect the Base channel.

Density 
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Dot Diameter
Diameter of the dots. The value corresponds to the half the width of the preview window. 

Fuzzy Edge Width
Sets a region around the dot to blur slightly. Makes a nicer transition from the surface to 
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Procedural Shaders — Eroded
the dots.

Dot Color
The RGB color of the dots.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Eroded

This shader puts dents and holes in the surface of an object.

Figure 107 — Eroded Shader

Will affect the Base and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Bump Strength
The magnitude of the bump applied to the dented portions of the surface. Can be a nega-
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Procedural Shaders — Eroded
tive number.

Erode Holes
When on, holes are actually cut through the surface. When off, areas that represent holes 
are shaded with the Hole Color.

Hole Min
The surface of the object is represented by a value of 0 to 1. Where 0 is the bottom of the 
deepest hole. Hole min sets the range over which holes occur on the object. In the default 
case, holes appear between 0.0 and 0.3

Hole Max
The surface of the object is represented by a value of 0 to 1. Where 1 is the top of the sur-
face. Hole max sets the range over which holes occur on the object. In the default case, 
holes won’t appear between 0.4 and 1.0. Between 0.3 and 0.4 there is a ramp wherein the 
surface transitions nicely into the hole.

Hole Color
RGB value of the color applied to the holes when the Erode Holes flag is off.

Surface Color
Sets the RGB value of the surface. You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Procedural Shaders — Flame
Flame

Creates a fire-like color pattern.

Figure 108 — Flame Shader

Will only affect the Base channel.

 

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Distortion
Scales the combination of all noise functions. Larger numbers will yield many smaller 
regions of flame. Useful values are in the range of 0 to 1.

Chaos Scale
Scales the color temperature of the shader. Larger numbers are hotter.
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Procedural Shaders — FractalNoise
Chaos Offset
Adds to the color temperature of the shader.

Flame Height
If set to 0.0, this shader behaves as a 2D shader. If a height is provided, the colors will vary 
as the height of the object changes. Apply to the top of a cube and enter in a height value. 
When you render the side of the cube you will see the colors creeping up.

Flame Amplitude
Scales the flame temperature based on the height.

Lacunarity
Sets the gaps between the regions of flame in the preview window.

S Noise Scale
Acts as a noise seed to vary the look of the flame

D Noise Scale
Acts as a noise seed to vary the look of the flame

Octaves
Sets the fractal complexity of the shader. Useful values range between 1 and 7.

Colors
Sets the number of colors, from the list of colors on the left, to use when creating the pro-
cedural effect.

FractalNoise

Creates a fractal-based noise pattern.
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Procedural Shaders — FractalNoise
Figure 109 — Fractal Noise Shader

Will affect the Base and the Bump channels. 

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Noise Level
Controls the complexity of the noise. Useful range is 0 to 8

Noise Factor
Higher numbers produce a rougher surface, smaller number a smoother surface.

Bump Strength
 Sets the magnitude of the bump. Can be negated.

Bump Factor
With each successive noise level calculation, bumps get smaller by this factor.

Sharpen Bumps
Takes the highest point and makes it rougher, takes the lowest point and makes it softer. 
Good for making the bumps nice and craggy.
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Procedural Shaders — FractalNoise
Color Factor
Sets the point where the shader switches from the High Color to the Low Color. Higher 
numbers will completely eliminate the High Color.

Sharpness
Larger numbers increase the contrast between the High and Low Colors

High Color
Sets the RGB value of the surface at the top of the bumps. You can set the alpha to 0.0 to let 
the object’s diffuse color, or the next texture map in the diffuse list, come through instead.

Low Color
Sets the RGB value of the surface at the bottom of the bumps. You can set the alpha to 0.0 
to let the object’s diffuse color, or the next texture map in the diffuse list, come through 
instead.
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Procedural Shaders — Granite
Granite

Creates a granite rock appearance.

Apply only to the Diffuse Channel. Will affect the Diffuse and Specular Channels.

Figure 110 — Granite Shader

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

ks1
The Specular value for the region colored by Color1. 1.0 is max, 0.0 is no specular

ks2
The Specular value for the region colored by Color2. 1.0 is max, 0.0 is no specular

Color1
The RGB value for the underlying color of the granite rock.
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Procedural Shaders — Granite
Color2
 The RGB value for the colored pieces that mix in with the granite rock.

Grid

Creates a grid of lines.

Figure 111 — Grid Shader

Will only affect the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

3D Grid
Makes the shader work in 3D space. Apply to the top of a cube, then render the side of the 
cube. You will see the grid coming up the sides of the cube.

X,Y,Z
Offsets the grid pattern in the direction specified. Very useful when the 3D Grid checkbox 
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Procedural Shaders — Hextile
is on as you might find the Z position of the grid leaves you right in the middle of a line.

Line Thickness
Sets the thickness of the lines. 

Grid Color
Sets the RGB color of the lines.

Surface Color
Sets the RGB value of the underlying surface. You can set the alpha to 0.0 to let the object’s 
diffuse color, or the next texture map in the diffuse list, come through instead.

Hextile

Creates a hexagonal pattern of terra cotta tiles. Perfect for your patio or mud room.

Figure 112 — Hex Tile Shader

Will only affect the Base channel.
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Procedural Shaders — Hextile
Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Tile Radius
Sets the size of the tiles. 1.0 represents one full tile in the preview window.

Mortar Width
Sets the width of the mortar between the tiles. Useful range is 0.0 to 0.3

Tile Vary
Allows subtle variations in the color of the tiles. Useful range is 0.0 to 1.0

Scuffing
Sets the darkness of the scuff marks on the surface of the tiles. Useful range is 0.0 to 5.0

Stains
Creates separate stained areas using the Scuff color. Useful range is 0.0 to 5.0

Stain Frequency
Controls the size of the stained areas. Larger numbers create smaller stains.

Scuff Frequency
Controls the size of the scuff marks. Larger numbers create smaller marks.

Tile Color
Sets the RGB value of the tiles

Mortar Color
Sets the RGB value of the mortar between the tiles.

Scuff Color
Sets the RGB value of the scuff marks on top of the tile.
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Procedural Shaders — Marble
Marble

Creates a marble-link surface for rocks, pillars, temples, etc.

Figure 113 — Marble Shader

Will only affect the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Frequencies
Controls the number of separate veins that appear in the marble. The default is 8 and you 
can see 8 distinct veins running through the marble in the preview window.

Turbulence
Sets the waviness of the veins. Larger numbers yield more waviness.
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Procedural Shaders — Plank
Noise Factor
Affects the variation of the veins along their length. Useful values are in the range of 0.0 to 
1.0
Vein Spacing
Controls the distance from one vein to the next.

Vein Sharpness
Controls the width of the veins.

Colors
Controls how many of the colors on the left side of the interface are used to shade the mar-
ble.

Plank

This shader creates a nice parquet-style wood pattern. Can be used to great effect on the 
floors of entry halls or on dance floors. Biases the specular highlight with the parquet pat-
tern as well. Can also be used to simulate hardwood flooring.

Figure 114 — Plank Shader
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Procedural Shaders — Plank
Apply only to the Diffuse Channel. Will affect the Diffuse, Bump, and Specular channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Parquet Tile
Creates the parquet pattern of tiled wood. If off, long planks are created instead; perfect 
for hardwood floors.

Planks Per Tile
Number of individual wood slats that make up each tile.

Plank Length
Sets the length of the planks when the Parquet Tile flag is turned off.

Plank Width
Sets the width of the tiles when the Parquet Tile flag is on. If the flag is off, it sets the width 
of the individual planks.

Groove Width
Sets the width of the grooves that separate the tiles from one another and the grooves that 
separate the planks within the tiles from one another.

Ring Scale
Larger number create more, tighter grain patterns in the planks.

Grain Scale
Larger number cause the grain patters to be thicker.

Plank Vary
Cause color variation in the individual planks. Useful range of values is 0.0 to 2.0.
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Procedural Shaders — Plank
Grainy
Sets the amount of grain in each plank.

Wavy
Larger numbers make the grain more wavy.

Light Wood
Sets The RGB color of the lightly colored planks.

Dark Wood
Sets The RGB color of the darkly colored planks.

Groove Color
Sets The RGB color of the grooves between the planks and tiles.

ks
Sets the specular for each of the areas. 0.0 is no specular. 1.0 is maximum specular.
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Procedural Shaders — RandomDots
RandomDots

Creates a pattern of randomly colored dots. Perfect for that summer dress.

Figure 115 — Random Dots

Will only affect the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Dot Types
 Controls the number of different types of dots to apply to the surface. Up to 10 different 
dots are supported.

Dot Color
Sets the color of each dot
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Procedural Shaders — Rust
Dot Size
Sets the maximum size of each dot. There is random variation in the size from the maxi-
mum down. 

Rust

Creates a rusted surface pattern. The surface appears thick with areas eroded down to 
holes.

Figure 116 — Rust Shader

Apply only to the Diffuse Channel. Will affect the Diffuse and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Paint Level
Controls how deep into the surface the paint reaches.
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Procedural Shaders — Rust
Paint Bump
Sets the magnitude of the bumps on the painted surface.

Paint Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Rust Level
Sets the amount of the surface affected by the rust. 1.0 is all rusty, 0.0 is no rust at all.

Rust Bumps
Sets the magnitude of the bumps on the rusty surface.

Rust Color
Sets the RGB value of the rusted area.

Hole Level
Sets the amount of the surface that becomes holes. 1.0 is all hole, 0.0 is no holes.
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Procedural Shaders — Stucco
Stucco

Creates a stucco pattern using bumps. Great for adding a slight variation to interior and 
exterior walls.

Figure 117 — Stucco Shader

Will affect the Base and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Sharpness
Controls the smoothness of the bumps. Smaller numbers are smoother, larger numbers 
sharper. Useful range is 0 to 10.0

Bump Strength
Sets the magnitude of the Bump. Can be positive or negative.

Color Factor
Controls the blend, and therefore the spread, of the Bump Color into the Surface Color. 
Larger numbers correspond to a larger spread.
174       ElectricImage 2.8 Supplement    



Procedural Shaders — Veins
Bump Color
Sets the RGB value of the bumps.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Veins

Creates a series of polygonal shapes separated by grooves. Could be used for alien skin or 
even the surface of a cobblestone walkway.

Figure 118 — Veins

Will affect the Base and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.
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Procedural Shaders — Veins
Coverage
Controls the region that the Vein colors covers. 0.0 yields no Vein Color. 1.0 will cause the 
Vein Color to cover the entire procedural.

Ledge Level
Controls the height that the shapes rise above the veins

Ledge Width
Controls the width of the shapes

Bump Strength
The magnitude of the bump. Can be negative to cause the veins to rise above the shapes.

Vein Color
Sets the RGB value of the veins.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Procedural Shaders — Waves
Waves

Creates a sinusoidal pattern. Can be used to simulate ripple effects as droplets fall into 
water. This shader causes the waves to animate, flowing outward at a rate controlled by 
the Wave Frequency.

Figure 119 — Waves Shader

Will affect the Base and Bump channels.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Wave Source
Sets the number of sources that generate the waves. More sources give rise to complex 
interference patterns

Wave Range
Sets the distance between Wave Sources.

Wave Length
 Distance between the wave crests.
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Wave Frequency
Number of units the rings move outward per second.

Bump Strength
The magnitude of the bump. Can be negative invert the wave.

Wave color 
Sets the RGB value of the wave crests.

Surface Color
Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.

Wisp

Creates a series of lightly drawn lines, as if a calligraphy pen had been used to draw on 
the surface.

Figure 120 — Wisp Shader

Will only affect the Base channel.
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Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Coverage
Sets the region that the Wisp Color covers. 0.0 yields no Wisp Color. 1.0 will cause the 
Wisp Color to cover the entire procedural.

Ledge Level
Larger numbers increase the number of lines that are drawn

Ledge Width
Smaller numbers increase the thickness of each line.

Wave Color
Sets the RGB value of the lines.

Surface Color
 Sets the RGB value of the surface You can set the alpha to 0.0 to let the object’s diffuse 
color, or the next texture map in the diffuse list, come through instead.
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Wood

A basic procedural to create a wood-like appearance.

Figure 121 — Wood Shader

Will only affect the Base channel.

Density
Sets the Scale of the shader on the group. Larger numbers are equivalent to zooming out, 
smaller to zooming in.

Frequencies
Controls the number of separate grains that appear in the wood.

Turbulence
Sets the waviness of the grain. Larger numbers yield more waviness.

Noise Factor
Affects the variation of the grain along their length. Useful values are in the range of 0.0 to 
1.0
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Vein Spacing
Controls the distance from one vein to the next.

Vein Min
Controls the maximum width of the veins.

Vein Max
Controls the minimum width of the veins.

Colors
Controls how many of the colors on the left side of the interface are used to shade the 
wood.
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The Project Window

Introduction

The Project Window has always been the heart of animation in ElectricImage. It is this sin-
gle window into your scene that offers the most control, to virtually every parameter. 
ElectricImage 2.8 includes a few “under the hood” improvements in the Project Window, 
as noted below:

• The Animation Box
• The Velocity Enable Check Box
• New object selection methods
• The Function Curve editor

 

Figure 122 — Project Window
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The Animation Box

As an animator, you will find that while you may have hundreds of objects in a given 
scene, you may only be animating ten or twenty of them. Like a director on a movie set, 
you expect your props to stay put, while requiring your actors to move and express them-
selves. When animating with a computer, all of these objects have to be tracked, main-
tained, and otherwise dealt with in some fashion. Not all of them need to be animated, 
however.

Figure 123 — Typical Animation Box

That’s where the animation box comes in. A third column has been added to the left side 
of the project window, next to the Visibility checkbox and the Lock boxes.   The Animation 
box is a little green arrow that enables animation for each group and each animation chan-
nel within that group. The animation box next to the group name acts as a master switch. 
If the master isn't on, the channels below won’t animate regardless of the settings of their 
animation boxes. A new preference under the Edit >Keyframe... menu controls whether or 
not groups default with their master animation boxes on or off.
 

Figure 124 — Animation Preference

By activating animation channels only when necessary, you will conserve memory and 
improve interface performance within ElectricImage. You can specify on a channel by 
channel basis which attributes will animate, and which will not.
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The Velocity Enable Box
 

Figure 125 — Velocity Enable Check boxes

A velocity enable box has also been added next to each animation channel capable of a 
velocity calculation. You can disable the velocity calculation for any channel you choose 
by turning off this box.

Object Selection Methods

The 2.8 Project Window also adds greater ease of changing common characteristics of 
multiple objects by adding some new object selection methods. The following steps will 
explain the procedure for changing the Visibility, Lock, or Animation settings for multiple 
objects, and objects with children.

Selecting and changing attributes for Multiple objects:

• Select the objects in the Project Window.

Figure 126 — Multiple Objects Selected
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• Click the desired box on one of the selected objects.

Figure 127 — Selected Objects with Animation Turned Off

The selection changes for only the selected objects.

Selecting and Changing Objects with Children

• Use Option and Command (ð ) keys and click on the parent object 
• Change the animation value
 

Figure 128 — Caption Me

The animation records for the parent group and its children have now been changed.

This technique also works if you have an object with hidden children. Just follow the pro-
cedures above. These features, in combination with selection sets, will make the manage-
ment of large projects substantially easier.
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Function Curve Editor

Introduction

One of the most exciting new features of ElectricImage 2.8 is the Function Curve Editor. 
The Function Curve Editor is a powerful feature which lets you graphically create, edit 
and apply animation information to virtually any parameter in a scene. Function curve 
editors have formed the basis of some of the most powerful character animation software 
anywhere.

What is a Function Curve Editor?

The Function Curve Editor is a new window which allows animators to graphically con-
trol animation data in the form of a curve which represents changes in time and data val-
ues. The editing methods in the Function Curve Editor provide far more control over how 
the values change, not just when the values change as with the older velocity graphs in 
previous version of ElectricImage. All animation channels can be edited with a function 
curve, with the exception of color.

The Benefits of Using the Curve Editor

The art of animation involves many subtleties. Good animators know that to add those 
subtleties can be an exercise in tedium. The function curve editor is intended to make that 
task easier. By being able to edit the curve as it enters and exits a keyframe, the animator 
has more control over each keyframe, leading to more control to the overall animation and 
the realism of the shot. At the very least, using the Function Curve Editor will assist the 
animator in creating complex motion using less keyframes, saving time in the process.
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Implicit and Explicit Translation

As you may have already noticed, all vectorized quantities in ElectricImage (position, ref-
erence, center, etc.) now have an extra pulldown menu in their info windows. This pull-
down controls whether the quantity is Implicitly or Explicitly translated. Implicit 
translation is what you have been using in past versions of ElectricImage. Explicit transla-
tion allows separate control for each of the three translation components (X,Y,Z).

Implicit Translation Example
Figure 129 — 

Figure 130 — Top View and Velocity Curve Example

Figure X-X shows us the top view of a basic motion path, as you were used to seeing in 
prior versions of ElectricImage. Figure X-X shows us the graph of the camera motion 
velocity.

The Camera's motion path, as seen in Figure X-X is really a composite of the Z and X chan-
nels of the Camera motion path transform. When you drag the Camera in the top view the 
Z and X values change but Y does not. Velocity is computed on the composite vector (The 
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vectors of X and Y.) There is no curve available to individually adjust any of the three com-
ponents by itself.

Explicit Translation Example

By making the Camera's transformation Explicit, velocity calculations are removed and 
you are free to independently manipulate the three component vectors of the motion 
(X,Y,Z).

To make an group’s Translation explicit:

• Open the Group Info window for a given object. Make sure that the X-Form window 
is in the foreground.

Figure 131 — Group Info Window

• Change the translation of the particular Transformation characteristic from Implicit to 
Explicit. Figure X-X shows the Position translation being changed.
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Figure 132 — Key Menu

The translation value for the object’s position is now explicit. 

One of the first things you will notice is the change in the way the motion path for the object is now 

drawn in the world view windows. The path is no longer the familiar bezier spline, but rather a 

curve with no real controls. You can create new keyframes as before, by changing the time and drag-

ging the group to a new position, but you cannot edit the shape of the curve in the world view win-

dows. 

Accessing the Curve Editor

There are two ways to open the Function Curve Editor:

• Choose Windows>Function Curve Editor
• Type ð  -` (Command - `).

The Function Curve Editor Opens

The Function Curve Editor Window

The Function Curve Editor is divided up into three sections:

• A toolbar at the top of the window
• A list of channels on the left
• The graph of the channels on the right (the curves.)
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Figure 133 — Function Curve Editor (with channel data)

Initially, there won't be any channels loaded into the Editor. Channels are loaded by two 
methods:

• From the project window, by double-clicking on the animation channel names in the 
particular object that you want to work with.

• Using the Key Channel Loader described in the Toolbar section of this document 
(below.)

You can load in as many channels as you like from as many different groups as you like. 
Virtually any channel, except RGB color, can be loaded into the editor.
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The Toolbar

To effectively edit motion and time data, some special tools are required. The Function 
Curve Editor comes with its own set of tools which are used to edit data splines, load 
motion data, and various other tools to manipulate the motion data. The following sec-
tions will detail the function of each Tool icon and it’s menu items.
 

Figure 134 — Function Curve Toolbar

Envelope Load  

Envelope Load allows you to load values into and save data out from curves described in 
the Graph Editor (See the Graph Editor section below.)   These curve files are called “enve-
lopes.” Envelopes may be loaded or saved across the entire time range or across a selected 
range of time.

Figure 135 — Envelope Load Menu

One of the benefits of using a computer is that it can do the repetitive work for you. In 
ElectricImage 2.8, you can easily load motion data from motion capture device data files, 
other groups or function curves from another EI project. By saving and loading envelopes 
from other channels, you can reuse existing motion data and customize it for your current 
animation project. This works very well when doing repetitive motion, such as animating 
a set of humming bird wings, a trail of ants taking over a picnic, or matching blinking 
light patterns.
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Clicking on the Load icon brings up a drop down menu with four choices:

• Load to Replace All...
• Load to Insert Into Time Selection
• Save All...
• Save Within Time Selection.

These tools allow you to load and save motion envelopes.

Load To Replace All
This menu choice will replace all of the keys with a previously saved channel envelope. 
Selecting this menu choice will present the standard Macintosh file open dialog from 
which you can select an envelope file. Envelope files can be saved from other channels or 
motion capture data files. 

Load to Insert Into Time Selection
Using this option will replace the selected time frame with the saved data envelope. If the 
inserted envelope is larger than the selection area, keys outside the selection area are 
scaled to allow for the inserted envelope. Inserting an envelope works as if a slice of time 
is being inserted at the selection area. If the selection area is the same size in time as the 
envelope, keys outside the selection are unaffected. If the envelope is smaller than the 
selection area, keys following the selection area are shifted sooner in time.

Save All
Use the Save All function to save all keys in the selected function curve. This effectively 
saves an entire channel as an envelope which can be loaded at a later time

Save Within Time Selection
Using this option, you can save all keys located within a selected range to an envelope file.
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Key Channel Loader 

As its name suggests, the Key Channel Loader is used to add key channels into the Curve 
Editor. Select the object(s) in the Project Window, then use this tool load in all of or a 
selected group of animation channels. Once loaded, the channels are displayed in the 
channel list. The circles to the left of the channel names may be used to turn off the display 
of the channel in the graph window. Channel may be removed from the editor by select-
ing them in the channel list and hitting the delete key or by using the clear under the edit 
menu.
 

Figure 136 — Key Loader Dialog

All
Using the All option, all channels for the selected object(s) are added to the key path edi-
tor. Depending on whether the selected object is a camera, light, or geometry there may be 
as few as 7 or as many as 30 or more channels added to the editor via this option.

Custom
Loads the channel selected using the Custom... view option in the project window.

Specific
Using the Specific option, you can import channels of selected types only. This option 
works well when you only need to edit a single attribute on many objects, such as the vis-
ibility property. Since some attributes have interrelated channels, those too will be loaded. 
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For example, loading the Material type will load as many as 22 channels, while the Trans-
form type will load 9 and the visibility type only one.

Color Preferences 

Use to set the default color for curves displayed in the graph window of the Curve Editor. 
Clicking on this option invokes a dialog box with editor attributes accompanied by a color 
bar for customizing the color used for each attribute. You may use any color combination 
which is comfortable for you, although selecting non-contrasting colors may make it diffi-
cult to distinguish between editor attributes.

Figure 137 — Color Preferences Dialog
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Graph Display Element Control 

This pulldown changes the on/off settings of the last nine controls represented in the tool-
bar. Since, these nine controls can be turned off or on by clicking on them, this particular 
tool is redundant and will likely be removed.
 

Figure 138 — Figure X-X

Grid
Displays a horizontal and vertical grid

Ruler
Turns all paths on and off

All Paths
Toggles whether the selected channel or all channels are displayed

Velocity
Displays the velocity graph

Acceleration
Displays the acceleration path
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Snap Undo
Displays the Snap Undo path

Current Time 
Displays the current time marker

Time Range
Displays the time ruler

Data Range
Displays the data ruler.

Grid Options 

This menu controls the grid. Both the spacing of the visual grid and the snapping grid are 
controlled here. To activate snapping, make sure that the caps lock key is set.

Key Channel Window 

The Key Channel window is used to set the curve type for each channel, and the begin-
ning. You can also manage individual keyframes through the key list. Get to know this 
window well, as it will offer you the ability to fine tune your function curves, and get the 
most out of your animation efforts.
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Figure 139 — Key Channel Window

The Motion Type Menu
The motion type menu determines the type of spline curve used to calculate the interpola-
tion of the data in the channel. There are four different curve types:

• Linear
• Natural Cubic
• Hermite
• F-Curve 

Linear
Straight line between the keys, no interpolation

Natural Cubic
B-Spline interpolation, no controls. Use where you want automatic smoothing.

Hermite
More versatile than Natural Cubic. The whole curve won't change when one key is 
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adjusted.

F-Curve
Contains control handles for fine adjustment. This will give the best control and is similar 
to Bezier curves

The Left & Right Extension Menus

The beginning and ends of function curves can have a variety of behaviors. This allows 
you to create repetitive motions quickly and easily, and has the added value of transmit-
ting any changes to the carried over curve sections, if desired.

Hold
The hold option maintains the value of the starting or ending point of the curve.

Repeat
This option will cause the entire curve to repeat itself in a cycle.

Oscillate
The Oscillate option will make the curve repeat itself in a mirror-image fashion.

The Key List Subsection

Individual channel keys are displayed in the keylist to the lower left of the Key Channel 
window. Keyframe attributes are displayed when a particular keyframe is selected in the 
list. There are several attributes that are controllable on a keyframe by keyframe basis:

• Time
• Value
• Spline-specific controls
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Figure 140 — Keyframe List

Time and Value Edit Boxes
You can change the time or value of the selected keyframe. Enabling the Hold Value check 
box will force the value of the slope between the selected keyframe and the next keyframe 
be maintained until the next keyframe: no interpolation will occur. This will appear as a 
flat line until just before the next keyframe in the Function Curve Editor.

Spline Specific Fields
This section displays different controls depending upon the spline selected in the Motion 
Type popup menu:

• Linear
• Natural Cubic
• Hermite
• F-Curve

Linear 
There are no additional controls for the Linear Motion Type.

Natural Cubic 
There are no additional controls for the Natural Cubic Motion Type.
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Hermite 
There are controls for the Tension, Bias, Continuity attributes of the acceleration and 
velocity of the curve. You can type the values in directly, or hold down the T, B, or C keys 
(lower case is fine) and dragging. You will see the acceleration and velocity curves change 
as you adjust the value. You will also clearly see changes in the actual motion path drawn 
in the world view windows. You can linearize the values by checking the Linear button.

F Curve 
Controls for the keyframe vectors will appear if the Motion Type is set to F-Curve. The 
keyframe vectors are the little “teeter bars” that appear at each keyframe. There are sepa-
rate vectors for the left and right side of the keyframe. You can set the vector angles by 
clicking and dragging on the vectors, or by typing values directly into the edit boxes. In 
addition, you cal linearize the spline segment by enabling the Linear button. When the 
beginning or ending keyframes are selected, on the left or right vector will be displayed.

There are also two check boxes for slope control, which affect the shape of the curve, and 
how the curve is interpolated through its control points:

Continuous Slope
Causes the curve to be smoothed along both sides of the control point equally.

Automatic Slope
Causes the curve's adjoining slopes to be adjusted for smoothness.

Editor Display Scale
The Editor Display Scale box allows you to scale individual curves so that they can be dis-
played together in the Editor. For example, lets say you have a X motion curve that runs 
from 0.0 to 4444 over 4 seconds and you also have a roll channel that goes from 0.0 to 5 
degrees over the same 4 seconds. Using the Editor Display Scale you can set the scale of 
the X motion to 1.0 and the roll to 889. In this way, both curves will be visible in the Curve 
Editor and the same time. The Editor Display value for each channel is listed as a percent-
age after the channel name in the channel list.
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Snap 

When a data or time range is edited within the Function Curve Editor, the original path 
becomes the Snap value. The Snap command stores the present position of a curve in 
memory. This allows you to display the original path while you make changes to it. You 
can make adjustments to a function curve and revert back by clicking the Unsnap option 
or saving the new curve as the snap value (or new original) by clicking the Snap option.

Range 

Ranges are highlighted sections of the Graph Window. The tools in this menu allow you to 
select a time or data range and to operate on sections of a curve within the range.
The range itself is created by dragging in the white band just below (time range) or just
to the right (data range) of the curve editor. The Time Range and Enable Range buttons 
must be on for the range to be displayed (see below).
 

Figure 141 — Range Menu

Set Ranges…
Brings up a dialog box that allows you to type in values to create the range instead of 
dragging the range at the right or bottom of the Graph Window.

Fit to Range
Scales the curve to fit within the selected time range.
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Fit to Data Range
Scales the curve to fit within the selected data range.

Move to Beginning
Move an entire channel’s keyframes to start at time 0

Reverse Time
Reverses the order of keyframes reversing the animation.

Reverse Data
Reverse keyframes to reverse data values

Key Time Range
Deletes keyframes outside of the selected time range.

Fit Curve To Data in Time Range
This option fits a curve to custom keyframe data with a tolerance setting. The original cus-
tom data is deleted. You can use this setting to turn motion capture data into motion 
curves.

Grid Enable 

This button toggles the display of the grid in the graph window.

Time Scale Enable 

This button toggles the display of the time scale, the value scale, and the time thumb con-
trol. The time thumb display mode (seconds, timecode, frames) can be changed by option-
clicking on the control.
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All Paths 

When this button is off, only the channel highlighted in the channel list is displayed in the 
graph window.

Velocity Display 

Toggles the display of the velocity curve. The velocity curve is updated as you make 
changes to the channel curve.

Acceleration Enable 

Toggles the display of the acceleration curve. The acceleration curve is updated as you 
change the channel curve.

Current Time 

Toggles the vertical time line that crosses through the editing field.

Time Range 

Toggles the display of the selected time range. The Time Range is chosen by dragging in 
the white region just below the Graph Window. Copying and pasting takes place inside 
the chosen Time Range.
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Data Range 

Toggles the display of the selected data range. The Data Range is chosen by dragging in 
the white region just to the right of the Graph Window.

The Graph Window

The graph window is used as an interactive display to modify the effects between two or 
more keyframes. Through the use of the graph window, offset keys may be added and 
deleted, as well as modified.

Figure 142 — Graph Window

There are a variety of commands and shortcuts available in the Graph Window.

The Tab Key
Can be used to restrict the axial movement of the keyframes. Tab once to restrict in X, tab 
again to restrict to Y, tab again to restrict diagonally, tab again to restore free movement. 
(Cursor still does not change to reflect the drag mode.)
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Option Clicking
Option-clicking (or option-clicking and dragging) will add a new key to the point on the 
curve on which you clicked.

Figure 143 — Option Click adds new keyframe

Command Clicking
Command clicking on a key will break or mend the control handles.

Figure 144 — Command Click adjusts slope of handles

Shift Clicking
Shift clicking or marquee selecting a group of keys will allow the keys to be dragged 
together.

Figure 145 — Shift Click selects multiple keys
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Control-Drag
Holding down the control key as you drag a key will interactively scale the curve 
(requires that a time range be selected first).

Keypath Drag
Drag the curve between to keys to drag both keys. This allows you to drag a section of the 
curve.

Dragging the Window
Hold the space bar down to drag the entire Graph Window.

Toggle Linear
Command-Control clicking on a key will toggle the linear buttons in the Key Channel 
Dialog box for that key.

Cut and Paste
Cutting and pasting sections of the curve requires that a time range be selected first.
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Character Animation Section

Introduction

ElectricImage 2.8 introduces state-of-the-art character animation features, including 
advanced inverse kinematics, facial expression morphing and the ability to use Bones to 
deform an object. As character animation is such a complex and varied topic, we have 
decided cover the topic in several sections, spread over multiple chapters.

The first section will address inverse kinematics.  The first three chapters in this section 
will cover Effectors, Hierarchies and Constraints, and the Group Linkage Window (each 
written by ElectricImage power user Chris Weyers).  The last two chapters will cover 
Deformations and Facial Morphing.

Bones are partially covered in the Effectors chapter and the Deformations chapter, as a 
bone can serve double duty as both an effector and a deformation.
ElectricImage 2.8 Supplement        209



Character Animation Section — Introduction
210       ElectricImage 2.8 Supplement    



Effectors and IK — Introduction
Effectors and IK

Introduction

Effectors are invisible null objects that models, cameras, and lights in a scene can be linked 
to.  Any transformation, rotation, scale, or deformation applied to the effector will be 
passed on to the groups that are linked to it.  Using effectors allows you to control com-
plex animation's by layering motion characteristics into separate control objects.  The fol-
lowing chapter will explain the use of effectors of all kinds, and describe the layout of the 
new effector window.

Adding Effectors to a Scene

1.  Choose File > Add > Type > Effector.  Or choose the effector icon from the Object Pal-
ette.

Figure 146 — The Add Effector button from the Object Palette

2.  The cursor will change to an arrow with a cube next to it.

Figure 147 —  The Add Effector cursor

3.  Click in any view window to set the effector in the scene.
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The Effector Info Window

Figure 148 — The Effector Info window with the X-form palette displayed
 
An effector’s characteristics are controlled by the settings in the Effector Info Window.  
This window is very similar to the Group Info window for model geometry.  It is divided 
into two specific sections, each marked by a folder tab.

• X-Form
• Special

The Effector X-Form (Transformation) Palette

The X-form palette in the effector info window is similar to the x-form palette for other 
objects in a scene.  There are four rows of data cells that allow the input of values:

• Position
• Center
• Rotation
• Scale
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Position
This row of data cells allows the input of X, Y, and Z position values for the effector.  The 
"Key" pull-down menu offers a choice of "Implicit" or "Explicit" keyframe recording.

Figure 149 — The Implicit/Explicit menu

Implicit
will create a velocity curve for the keyframes. 
Explicit
will create f-curves for the keyframes.

(For an explanation of Implicit and Explicit translation, please refer to Chapter 3, The 

Group Info Window.)

Center
This row of data cells allows the input of X, Y, and Z position values for an effectors center 
of rotation.  Changing these values will move the physical center of the effector.

Rotation
This row of data cells allows the input of X, Y, and Z rotation values for the effector.

Scale
This row of data cells allows the input of X, Y, and Z scale values for the effector.
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The Effector Special Palette

Figure 150 — The Effector Info window with the Special palette displayed

The Special Palette contains editable fields that affect how different types of effectors dis-
play in a scene.  This palette is used for Box Effectors, Joints, and Bones only.

The Style pull down menu in the effector info window offers a choice of how you want to 
display an effector. The standard effector display styles are Cross and Box. There are also 
a special class of effectors called Joints and Bones that create pre-built hierarchies.  (See 
the Skeleton Effectors and Bones section later in this chapter.)  Whichever display method 
is chosen, keep in mind that an effector represents a single point in space, and is trans-
formed in relation to that point.
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The Effector Style Menu

Figure 151 — Style pull down menu

Box

Choosing Box from the style drop down menu will display a cube in the scene.  An extra 
checkbox called Show Extent will become available right below the Style drop down 
menu.

 

Figure 152 — The ShowExtent checkbox

Extents are dessentially the lines that join to create the cube.  They display the outer limits 
of the space occupied by the effector.  Unchecking this box will disable the display of the 
cube, leaving only it's center of rotation visible in the scene.

 

Figure 153 — A box effector showing extents

The defining characteristic of a box effector is that it can be resized.  This makes the box 
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effector display perfect for scaling and deformations, as well as surrounding groups of 
linked objects.

Special Palette Options:  Selecting Box from the style pull down in the Effector Info win-
dow will cause the Special Palette to display two new options:

• Origin 
• Size

 

Figure 154 — The Origin and Size value boxes

These options only affect the way the effector displays.

• Origin:  The Origin defines the point in space that the boxes extents are drawn from.  
The origin displays as a small cross.  In the picture below, the Origin is represented by 
the black circle and the black crossed lines at the center of the effector.

 

Figure 155 — A Box effector with the Origin point in the center

• Size:  The Size defines the size of the box effectors extents in world units.  Don't con-
fuse size with scale (found in the X-Form palette).  If you scale a box effector you will 
scale all objects attached to it.  Changing extent size affects only the box display.  You 
can, for instance, change these values to make a box effector larger in order to sur-
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round the groups that are linked to it.

The size and origin boxes work together to control the overall size and positioning of the 
effector in space.  When a change is made to  the size values, the boxes extents will change 
in relation to the origin point.  To keep the origin exactly in the center of the box the values 
in the origin fields need to be a negative half of the value in the size fields.

For instance.  If you change a boxes size from 1.0 on x, y, and z to 100 you would need to 
change the origin to -50 on x, y, and z to keep the point from which the box is drawn even 
with the boxes center point.

Cross

Choosing Cross from the style menu will display a small target shaped circle.

 

Figure 156 — A cross effector

The defining characteristic of the cross effector display type is that it can't be resized.  This 
makes the cross effector ideal for large scenes that require constant zooming in and out.   
Regardless of how far in or out you zoom, the cross effector will remain the same size, and 
thus be easy to select and manipulate.

Special Palette Options:  There are no editable attributes displayed in the special menu 
for a cross effector.
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Joint

Figure 157 — Style pull down menu

Choosing Joint from the style drop down menu will display a Skeleton Effector Joint Vec-
tor in the scene.
 

Figure 158 — Joint (Skeleton) effector

A joint displays as a long, toothpick shaped object, that is pointy on one end and round on 
the other.  The center of a joint effector is displayed where the horizontal and vertical vec-
tor lines cross.  Joint effectors are used to create skeletal hierarchies.  To create a linked 
chain of joint effectors use the File > Add > Type > Skeleton command.

Special Palette Options:  Selecting the joint display method enables a row of size data 
cells in the special palette.

 
Figure 159 — The Size boxes

These values can be modified to change the length of the Joints vector.  Because skeleton 
joints always orient with the Z-axis running the length of the vector, the only value that 
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needs to be changed is the Z data field.  (See Drawing Skeletons and Bones for more infor-
mation.)

Bone

Figure 160 — Style pull down menu

Choosing Bone from the style drop down menu will display a Bone Effector Joint Vector in 
the scene. 

 

Figure 161 — A Bone Effector

A bone displays as a long, toothpick shaped object, that is pointy on one end and pyramid 
shaped on the other.  The center of a bone effector is displayed where the horizontal and 
vertical vector lines cross.  Bone effectors are used to deform object meshes.  To create a 
bone effector chain use the file > add > type > bones command.

When a bone display style is chosen several new items become available in the effector 
info window.
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Figure 162 — New options in the window when Bone is selected

Bone Color
The bone color displays the color the bone will appear in when it is deselected.  This color 
can be changed by clicking on the color tab and choosing a new color from the color 
picker.

Bone Highlight
The bone highlight color displays the color the bone will appear in when it is selected.  
This color can be changed by clicking on the color tab and choosing a new color from the 
color picker.

Set Rest
Rotating a bone into the desired position and pressing the "Set Rest" button will tell the 
bone what position to stay in when it is at rest.  Please refer to Chapter X, Deformations, 
for more information.

Set Bias
Resets the current rotation values of the bone to 0,0,0.  Bones have a default Z orientation, 
which can interefere with imported data, such as motion capture data.  This featrue lets 
you position the bone, and then “zero it out.”  This is similar to indexing a servo motor or 
motion control axis on a robotic camera system.

Special Palette Options:   Selecting the joint display method enables several new options 
in the special palette.  These options, with the exception of bone length, are specific to how 
a bone deforms a mesh.  (See the Deformations chapter for more information.)
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Figure 163 — The Special Menu options for Bone

Why use an Effector?
Often times an animation requires "layering" of motion.  You may need to translate or 
rotate an object in several different ways to achieve the desired animated results.  The only 
problem is that an object has only one set of data channels.  Once the rotation channels are 
filled, for instance, they can't be changed without erasing the previous values.  You can, 
however, link to a second object to create a second set of rotations that will happen on top 
of the rotations that have already occurred in the local data channels.  Effectors allow you 
to gain control of your animation by separating transformations into easily addressable 
layers.

One classic example of this is a moon orbiting a planet.  You want the moon to rotate 
about it's local center point, but you also want it to orbit around the planets center point.  
You create a rotation of the moon on the Y-axis so it spins.  But now you have to give the 
moon a second Y-axis rotation characteristic that orbits it around the planet. The only way 
to do this is to link the moon to an effector that is positioned over the center of the planet.  
By rotating the effector on Y you can create two y-rotations for the moon!
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Another example would be creating a swarm of bees.  You would want to individually 
animate each bee so it flies in a slightly different manner, but you would also want all the 
bee's in the swarm moving forward at a similar rate.  You could animate each bee's for-
ward motion individually.  Each time you change one bee in the swarms forward acceler-
ations, however, you would have to re-animate the rest of the swarm to follow.  A better 
way to control the swarm would be to link each bee in the swarm to an effector that pulls 
them forward as a group.  This would allow you individual control over each bee (as long 
as the link type is set to free), but move them all forward at the same rate.

If you're working on a complex animation task and having difficulty achieving the desired 
results, as yourself "Could an effector help me here?"

Skeleton Effectors and Bones

Skeleton Effectors and Bones are a special class of effector that can be used to create pre-
linked hierarchies.  Skeleton Effectors and Bones both display similarly as sharp "tooth-
pick" like vectors.

   
Figure 164 — Joint (Skeleton) effector and Bone Effector

Skeleton Effector chains can be used to create complex hierarchies that geometry can be 
linked to.  By allowing an underlying hierarchy of skeleton effectors to control a complex 
model, you gain the freedom to manipulate, or replace geometry without the necessity of 
re-defining all of your joint parameters.

Bone Effectors are used to create chains that can deform an objects mesh.  They can be 
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used to create smooth skeletal deformations in situations where you can’t work with a 
jointed model.

Adding Bones and Skeleton Effectors

Choose File > Add > Type and pick Skeleton or Bone.  Skeleton Joints and Bones can also 
be added by choosing the skeleton or bone effector icon from the Object palette.

 

Figure 165 — The Skeleton and Bone effector icons

Click in any window to set the root of the chain (double click to set the root for a bone), 
click a second time to set the length of the vector.  Continue clicking in this fashion to cre-
ate a linked chain of any length.

To end the creation of a chain type ð -. (Command-Period)

Skeleton Effector and Bone Orientation

The Z-Axis of a skeleton Effector or a bone is always oriented parallel to the length bone 
vector.  This has the potential to cause confusion if you don’t look for it.

For instance if you draw a skeleton effector in the front view window, starting at the top 
and moving to the bottom, you would expect the z-rotation tool to rotate the effector like 
the hand on a clock.  However, you will find this isn’t the case because the z-axis is aligned 
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with the world's Y-axis.
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Hierarchies and Constraints

Introduction

A hierarchy is defined as a collection of groups attached in a realtionship with each other 
in some fashion, like the links in a chain (hierarchies are often referred to as chains.) Any 
time you link two objects together you are creating a hierarchy. A hierarchical relationship 
allows the transformations of a parent object to be passed along to child objects. A hierar-
chy can be as simple as two linked objects, or as complex as a thousand linked objects. 

Constraints limit the scope or motion of a joint within the hierarchy.  By establishing con-
straints for each joint, a variety of specialized motion can be easily achieved.  Also, inverse 
kinematics chains are far more predictable if constraints are applied to each joint.  The 
solution process of inverse kinematics can be made more efficient by imposing constraints 
as well.

Constraints and hierarchies work hand in hand together. Hence, they receive their own 
chapter. Please learn this chapter well, as your understanding of this chapter will have 
direct impact upon your success in working with inverse kinematics.

Hierarchies

There are two different types of hierarchies:
• Static
• Articulate

Static Hierarchy
A static hierarchy consists of a group of linked objects that don't change relationships to 
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each other. A chair is an example of a static hierarchy. The legs, back and seat are all linked 
together in a “locked” relationship that never changes.

 
Figure 166 — A Static Hierarchy

Articulate Hierarchy
An articulate hierarchy consists of a group of linked objects that move in a pre-defined 
relationship to each other, and their parent object. A robotic manufacturing arm would be 
an example of an articulate hierarchy. The claw, upper arm, and lower arm are all linked 
to the base, but each item is free to move around it's own pivot point. Articulate hierar-
chies require an extra degree of thought and set-up prior to animating.

 
Figure 167 — An Articulate Hierarchy

That’s where constraints come in.  A constraint is a way to limit, or control an objects 
motion. In Electricimage a constraint can be accomplished in several ways: By parenting 
one model to another; By setting joint position and rotation limits; or by creating an auto-
Ik constraint.

Joints and Chains

When you link one object to another you create a joint. The joint is simply the point where 
the two objects connect.
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 The position of the joint is determined by the objects center point, which in turn controls 
how linked objects move in relationship to each other.

A chain, or joint chain, is a series of one or more joints that have been linked together. To 
use the human body as an example, the shoulder is a ball and socket joint, the elbow is a 
hinge joint, and the wrist is similar to a universal joint. The upper arm (shoulder), the 
lower arm(elbow), and the hand (wrist) form a joint chain.

 

Figure 168 — Typical Hierarchy Chain
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Every chain has a root that defines the parent object holding the chain in place.

Understanding How Joints Rotate

Objects in ElectricImage rotate around their center of rotation. You can recognize the cen-
terpoint when you're in wire frame mode as a small black dot on selected objects.

 

Figure 169 — Arm With Rotation in Center

When you're creating joint chains you need to make sure that the center of rotation is 
aligned with the area you want the object to rotate around.

If you were to create an arm chain you would probably want the lower arm to rotate 
around the end that's attached to the upper arm. When you import the model, you will 
need to check and see where the center of rotation is. If it's in the middle of the lower arm, 
the rotation tools would cause it to spin like a propeller.
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Figure 170 — Result of Center Rotation on Arm

If, on the other hand, you move it down to coincide with the point it joins the upper arm, 
you will get a believable rotation.
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Figure 171 — Result of Proper Rotation Point for Arm

To move the center of rotation you have to move the local origin, which appears as a small 
cross on selected objects.

Figure 172 —  Center of Rotation

It's important to note that the local origin and the center of rotation are controlled in dif-
ferent dialogues. The center of rotation is controlled in the group info window for an 

Center of Rotation
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object with the “center” data channels. The Local origin is controlled in the group linkage 
window.

In a normal hierarchy you would want to keep the local origin and the centerpoint equal 
to each other. This is to make sure that wherever you drag the local origin to, will also be 
the point around which and object rotates. When the “center” values in the group info 
windows are at 0,0,0 the center of rotation will align exactly with the local origin. The cen-
ter of rotation is the point that actually defines the geometric center of an object. The local 
origin, on the other hand, simply defines where an object joins to it's parent. This is why 
control for the two resides in different dialogues. The center of rotation is defined as an 
offset of the local origin. So when you move the local origin, the center of rotation will 
move a proportional amount. The only time you can get into difficulty here is if you man-
ually enter an offset in the “center” channels. This may cause your object to rotate out of 
synch with the position of the local origin.

Animating Joint Chains

When you have you're joints properly configured to rotate in relationship to each other 
the next logical thing to do is animate them. There are two ways to animate joint chains in 
ElectricImage: Forward Kinematics, and Inverse Kinematics. With either method your 
goal is to move part of a chain toward a target object. 

Animating with forward kinematics requires that you control your hierarchy from the top 
down. You move the parent, then the child. Any movement you give to the parent is 
passed on to the child, but the movement you give to the child is NOT passed on to the 
parent.  This is the default positional animation method in ElectricImage.
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Figure 173 — Forward Kinematics Flow Chart

Let's say we want to create an animation of an arm chain as it reaches out for a glass of 
water.

Using forward kinematics we would first rotate the upper arm toward the glass, then the 
lower arm, and finally the hand. This method of animating gives you the greatest control 
over your joints by forcing you to set keyframes for each one of them. It isn't the most 
intuitive way to reach the target though. You have to guess how far to move the upper 
arm, then the lower arm, in order to get the hand closer to the glass. 

Illustrations “Chain at Rest”, “Shoulder is Moved First”, and “Rotated Elbow brings 
Hand to Glass” demonstrate this process.
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Forward Kinematics Example

Figure 174 — Chain at Rest
 

Figure 175 — Shoulder is Moved First

Figure 176 — Rotated Elbow brings Hand to Glass
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 Wouldn't it be much easier if we could just pull the hand toward the glass and have the 
rest of the joints follow?

Animating with Inverse Kinematics will allow us to do just that. As it's name implies 
Inverse Kinematics lets you animate from the bottom up. You pass information FROM the 
child TO the parent. Any movement you give to a child object is passed up the hierarchy 
to it's parents. Unlike forward kinematics then, parents are aware of what their children 
are doing. (picture HC_5.ai)

Figure 177 — Inverse Kinematics Flow Chart

 To animate our arm with Inverse Kinematics we select the Lower Arm, the Upper Arm, 
and the hand (in any order), and pull on the hand with the IK tool. In one simple step you 
have animated all the joints in the arm chain and reached the glass of water! 
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Figure 178 —  Inverse Kinematics Version of Glass Example

With an inverse kinematics method you've gained control over reaching the target, but 
you've lost control over your joints. Instead of having fixed keyframe values for each joint 
in the chain, you have only one keyframe (the one for the child) controlling them all.

One thing you must keep in mind about Inverse Kinematics is that the parent/child rela-
tionship in your hierarchy hasn't been turned off. It's just temporarily reversed when you 
use the IK tool. It is possible to create a conflict by using an inverse kinematics method 
and a forward kinematics method on the same chain. 

In our example of a hand reaching for a glass of water we set a keyframe, using IK, for the 
hand which controls the lower arm and the upper arm. If, we decide to use the move tool 
to translate the upper arm forward, a forward kinematics solution, we will move the hand 
past the glass.
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Figure 179 — Conflicts between Forward and Inverse Kinematics

Because the forward kinematics solution forces the child to follow the parent again, the IK 
keyframes are actually dragged out of position!

It's a case of the “Push Me Pull You.” When you're using the IK tool the parents are aware 
of where the children have been keyframed and react accordingly. Using the Forward 
Kinematics tools (move tool, x,y,z rotate tools) makes the parents ignore the child key-
frames.

Using the IK tool

Because IK works on a hierarchy, you must select all the objects you wish to translate first. 

Select all the objects in the chain(s) you wish to translate with the IK tool. Holding the 
shift key down while selecting will let you make multiple objects active.

                          
236       ElectricImage 2.8 Supplement    



Hierarchies and Constraints — Using Inverse Kinematics
Figure 180 — Multiple selected joints in the Front View and Project Windows

With the IK tool select the child on the chain(s) you wish to manipulate

  
Figure 181 — The bottom child on the chain is selected

Pull in any view window. The chains will all move at once within any limits and con-
straints that have been set for them.

  
Figure 182 — The IK Chain in motion

It's important to keep in mind that the IK tool actually translates AND rotates all the 
selected joints in a chain at the same time. So if all the joints in your chain are set to free 
(giving them the freedom to rotate and translate) using the IK tool to move the chain will 
actually cause it to break apart.

 
Figure 183 — The IK Chain breaking apart

IK Preferences

The kinematics preferences box can be opened by choosing Edit > Kinematics... The 
options in this box control the way in which Electricimage solves Inverse Kinematics solu-
tions.
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Figure 184 — The Kinematics Preferences window

While dragging the chain...

• Use Phantom Joint: When this box is checked phantom, or ghost, joints for a chain will 
be displayed as it is manipulated with the IK tools.

• Use Global Gravity: 

• Keep World Orientation: 

 
Figure 185 — IK Chain Options

Deselected joints in chain...

• Lock Rotation: This checkbox, when enabled, will prevent deslected joints in a chain 
from rotating.

• Lock Position: This checkbox, when enabled, will prevent deslected joints in a chain 
from moving.

 
Figure 186 — Deselected Joint Options

Interactive Solution Options

• Find Exact Solution: This checkbox, when enabled, will force Electricimage to find the 
exact IK solution for a joint chain when it is manipulated. Enabling this option can 
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add significantly to the time it takes to redraw the position of a chain.

• Solution Time: This data field allows the entry of a time, in seconds, for the IK chain to 
update once it's been manipulated. This time only applies if the Find Exact Solution 
box has been checked.

 
Figure 187 — Exact Solution Options

Automatic Solution Options

• Solution time: This data field allows the entry of a time, in seconds, that can be used 
before the chain is automatically redrawn.

 
Figure 188 — Automatic Solution Options

• Constraint Multipliers: These values can be set between 1 and 0. The higher the num-
ber in each field the higher the priority that channel will take in when the IK solution 
is calculated.

 
Figure 189 — Constraint Movies

• Global Gravity: These data fields allow the entry of a global gravity constraint that 
will be applied to all joints in a chain when using the IK tool. The default setting is X= 
0, Y= -1.0, and Z= 0.
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Figure 190 — Global Gravity

Creating a Workable Hierarchy

When you create a joint chain you are creating a series of dependencies. Each joint in a 
chain will move and rotate in relationship to its parents movements. If you give each joint 
in that chain the freedom to rotate on all axes, you could end up with a joint chain that is 
spinning out of control. 

The price you must pay for the ease of animating with IK is properly setting up joint rota-
tion and position limits for each joint in your chain. By doing this you're telling the IK tool 
where and how to bend your joints.

Broken Hierarchies

When you join multiple joint chains into a single hierarchy you have to pay close attention 
to how these chains will interact with each other when you animate them. In any hierar-
chy there can only be one parent. Every time you make a change to the parent you will be 
sending a cascade of changes down all of the joint chains that are connected to that parent. 
This could lead to a hierarchy that bends and twists in unexpected ways.

To prevent the animation of one joint chain in a hierarchy from contaminating others in 
the same hierarchy it's sometimes necessary to break the hierarchy into separate pieces 
that all lie on the same level. 

The best case for breaking a hierarchy is the human body. 

As a joint chain structure the human body has two arm chains, two leg chains, a back 
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chain, a head chain, and hips. In the natural world the hips tend to be the point where 
everything finally connects. When the hips move forward so do the arm chains, the head 
chain, and the legs.

 

It's easy to animate the arm and leg chains in this configuration. Any IK animation you 
give these chains will stop being passed at their roots. But when you try and move the 
entire hierarchy forward (to take a step) the hips will send their movement data back 
down into the leg and arm chains. This will cause the IK solution you've applied to these 
chains to be overridden. The end result will be a hierarchy that isn't working properly.

Each time you rotate a chain in this hierarchy you run the risk of sending the translation 
and rotation information into another, seemingly unrelated, chain.

This can be prevented by breaking the hierarchy up into smaller, related sections. By con-
necting the arm and leg chains to an effector, you create a sort of animation “washer” that 
helps prevent the keyframes used to move the entire hierarchy forward from interfering 
with the local IK keyframes you give to your chain. (picture HC_9.ai)

 NEED PICTURE HERE - HC_9.AI
Figure 191 — Precision Hierarchies

Animating a broken hierarchy also requires a “broken” animation technique. You must 
devise an animation strategy that allows you to animate the movement of the individual 
chains with rotation keyframes, but also allows you to pull the same chains around with 
effectors that act as roots of the individual hierarchies.

Auto-IK

While it's not advisable to use the IK tool and the forward kinematics tools on the same 
ElectricImage 2.8 Supplement        241



Hierarchies and Constraints — Auto-IK
chain, it is possible to achieve the same effect on the chain using an auto-ik constraint. 
This type of constraint allows you to manipulate objects with the move and rotate tools, 
but applies an Inverse Kinematics solution to the chain.

Auto-IK allows you to force your chain to follow an object that lies outside of it's hierar-
chy.   When you move the object that your chain has been auto-ik constrained to, an IK 
solution will be passed up the chain, controlling all of the joints, until it reaches the termi-
nation point.

At the same time you will be able to translate the root of the chain in a different direction. 
When you do this the joint chain as a whole will try and orient itself so that it stays 
aligned with the position of the root, and the auto-ik constraint object. This is why it's 
called a constraint. When the chain is in motion it will be constrained to a position 
between the root, and the auto-IK constraint object.

Because an auto-IK constraint object is not part of the joint hierarchy itself, the IK solution 
doesn't know where to stop applying itself within the chain. In order to keep the auto-IK 
constraint from affecting all of the joints, you will need to set a termination point. The ter-
mination point simply tells the auto-IK solution where to stop applying itself.

Setting up an Auto-IK constraint

Using an auto-ik constraint requires a jointed chain and a constraint object that is not part 
of the chains hierarchy.

Select the part of the chain that you want to follow the constraint object.

ADD PICTURE HERE

Choose the Constrain to object tool from the Project Window or the Tool Palette.
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Figure 192 — The Constrain to Object tool

Click on the constraint object. Two keyframes will immediately be set. One at the current 
position of the time thumb, and one at the end of the animation. These are custom key-
frames that will be recalculated every time you move the constraint object.

Select the part of the chain you are constraining and switch your project to keyframe 
mode. Spin down the data channel arrow for the object.(picture 9)

 
Figure 193 — Some window with some stuff in it

Spin down the AutoFrames arrow for the object and pick a termination point from the 
Auto IK dropdown menu.

Once the termination point is set you can animate the constraint object, and the chain will 
follow along. Each time you preview your animation the auto-keyframes will be recalcu-
lated. 

To disable an auto-IK constrain select the object in the chain that's being constrained and 
click on the Remove Constraint Tool. (picture 10)

 
Figure 194 — The Remove Constraint tool

Because Auto-IK constraints create custom keyframe data for the objects they're constrain-
ing it's a good idea to use the Keyframe > Clear All Keyframes command on the object 
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the constraint has been removed from.
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The Group Linkage Window 

Introduction

The Group Linkage window contains all the controls needed to set up the position, and 
rotation controls for individual object pivot points in a hierarchy.  To open the Group 
Linkage window select an object and choose the Linkage Icon from the tools palette, the 
tools menu, or the project window. (picture 1).

 
Figure 195 — The Linkage Icon

You can also hold down the Command & Option keys and double click on a group to 
open its group linkage window.

The group linkage window is a non-modal dialogue box.  It can be left open while work is 
being done in the world view windows.

The main dialogue for the group info window is divided into three sections:

 
Figure 196 — The Group Linkage Window

• A group preview window
• Three global pull-down menus
• A palette area.
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The Group Preview Window

The group preview window allows the pivot point for an object to be interactively posi-
tioned by clicking and dragging on the red gnome.  The gnome displays the X, Y, and Z 
coordinate position and orientation for the joint.  Where these vectors meet represents the 
center of the pivot point.  

The detail to which an object renders in the group preview window is controlled by the 
settings in the Drawing Preferences Box, under the Edit menu.

Making changes to the Group Windows area of the drawing preferences box will change 
the way objects are displayed in the group preview window.

The group preview window view can be manipulated in the same way world view win-
dows are.  Clicking on the zoom in, zoom out buttons will bring an object closer or farther 
from the view window.  Clicking on the view pop-up will change the angle from which 
the object is viewed.

The gnome can be positioned by clicking and dragging on it in any orthographic view.   
The gnome cannot be interactively dragged when the view is set to skew.

The Global Pulldown Menus

The global pull down menus at the top of the group linkage window contain settings that 
will affect joints the same way regardless of what information is entered in the palette 
menus.  (That's why we call them global parameters.)

• Transform:  The settings in the transform menu contain two switches, Classic and 
Standard.  These switches tell ElectricImage how to calculate the settings entered in 
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the group linkage palettes. 

• Standard:  ElectricImage 2.8 joint calculations will be made.

• Classic:  Uses the calculation method from versions of ElectricImage prior to 2.8.

Rotation Order

Object rotation in Electricimage is calculated one axis at a time, which means that there 
must be an order to which rotation calculation comes first, second, and third.  This doesn't 
mean that rotations can only happen one axis at a time, it only means the calculations for 
those rotations happen one at a time.

The Rotation Order pull down offers complete control over these calculations.

 
Figure 197 — The Rotation Order Pulldown

The default is ZXY.  This means that Z rotations will be calculated first, followed by X, and 
finally by Y axis rotation calculations.  For many animation situations the default settings 
will work just fine.

If you have problems with objects wobbling as you spin them you may need to assign a 
new rotation order to the object.  A good rule of thumb for assigning rotation order is to 
calculate the axes in a descending order of stability.  Think about how you're object is 
moving, and decide which axis is most important to creating the desired motion.  Which 
axis is second most important, and which is the least important.  

The last six choices in the Rotation Order pull-down have a fourth coordinate inside 
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parentheses.  This coordinate controls the last rotation in the order.  For instance, XYX(z) 
indicates an X rotation, then a Y rotation, and a second X rotation that is controlled by the 
Z coordinate channel.

Link Type

 
Figure 198 — The Link Type Menu

The Link Type pull-down menu contains pre-configured link types that can be applied to 
an objects pivot point.  Use this pull-down menu to set a basic set of position and rotation 
limits for a joint.  The link type chosen will create global rotation and position limits that 
will override specific values entered in the limits sub-palette, by locking specific X, Y, and 
Z channels.

• Custom:  The custom option opens a dialogue box that allows specific rotation and 
position parameters to be locked or unlocked for a group.  Parameters with check 
marks next to them are completely disabled.  For instance, a check mark next to Lock 
Y Position will disable an objects ability to move on the Y-axis.

 
Figure 199 — The Custom Link Window

The Custom link type can be used to see what kind of position and rotation limits are cre-
ated by the other pre-defined link types.  Just pick one of the link types, like socket, and 
then choose Custom.  The Custom Joint dialogue will pop-up with the limits that a socket 
link uses already checked off.

• Free: This link type allows an object total freedom to move and rotate on all axes.  Free 
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is the default link type for root objects in any chain.  Because this joint type is free to 
move and rotate on all axis, the values in the limits sub-palette will override it.

• Ball Planar:  This link type locks the Y position channel only.

• Cylinder Planer:  This link type locks the Y position channel and the X rotation chan-
nel.

• Planar:  This link type locks the Y position channel and the X and Z rotation channels.

• Socket:  This link type locks the X, Y, and Z position channels.

• Cylinder:  This link type locks the X and Y position channels and the X and Y Rotation 
Channels.

• Universal:  This link type locks the X, Y, and Z position channels and the X rotation 
channel.

• Slide:  This link type locks the X and Y position channels and the X, Y, and Z rotation 
channels.

• Pin:  This link type locks the X, Y, and Z position channels, and the X and Y rotation 
channels.

• Lock:  This link type locks all position and rotation channels.

Folder Tabs

All of the specific local controls for an objects pivot point can be set in the tabbed palettes 
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in the Group Linkage window.

The X-Form Tab

The X-form palette controls the position and orientation of the gnome, and thus the pivot 
point for an object.  Values entered in these fields will cause the gnome to be re-positioned 
in the group preview window.

 
Figure 200 — The Transformation window

Link Alignment Position:

 
Figure 201 — The Link Alignment menu

This pull-down controls the position of the groups pivot point in relation to it's geometric 
bounds.  Changes in this dialogue will align the gnome with specific sides of the object, 
and change the position around which it rotates.

  
Please redo the Front View image so that its  border is active

• Middle:  The default for all objects, positions the pivot point exactly in the center of 
the object.

• Front:  This option positions the pivot point with the groups front.

• Back:  This option positions the pivot point with the groups back.
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• Top:  This option positions the pivot point with the groups top.

• Bottom: This option positions the pivot point with the groups bottom.

• Left:  This option positions the pivot point with the groups left side.

• Right: This option positions the pivot point with the groups right side.

Link Alignment Orientation

 
Figure 202 — The Link Alignment Menu

This pull-down controls the orientation of the groups pivot point.  Changing the link 
alignment orientation changes the orientation of the X, Y, and Z axes of the pivot point.  
Changing the Link Alignment Orientation will change the direction that the object 
rotates.

The results of changing the Link Alignment Orientation can be seen in the group preview 
window by watching the changes in the gnome orientation as different options are cho-
sen.

• Z proper:  The default option maintains the objects initial link coordinates.

• Z is X:  This option will swap the group's Z and Z coordinates so that the Z coordinate 
becomes the X coordinate.

• Z is Y:  This option swaps the group's Z and Y coordinates so that the Z coordinate 
becomes the Y coordinate.
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Position

This area contains data cells for the X, Y, and Z position of the pivot point.  Entering values 
in this field will update the position of the gnome in the group preview window.

Rotation

This area contains the data cells for the X, Y, and Z orientation of the pivot point.  Entering 
values in this field will update the orientation of the gnome in the group preview window.

Parental Offset

This area contains data cells for the X, Y, and Z parental offset values of the pivot point.  
The parental offset is the distance between the pivot point of the parent object, and the 
pivot point of the child object.  Changing the values in the Parental Offset data cells 
changes the distance between the pivot point of the child and the pivot point of the par-
ent, it does not change the position of the pivot point in relation to the object.  Changing 
the parental offset value will cause an object to move closer too, or farther away from it's 
parent.

The Inherit Palette

 
Figure 203 — The Inherit Palette
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The inherit palette controls which transformations performed on the parent will be passed 
on to the child in a hierarchy.  To enable an attribute check it's box, to disable an attribute 
uncheck it's box.  By default rotation and position information are passed from the parent 
to the child.  When a parent object is transformed or rotated, it's child will be transformed 
or rotated accordingly.  If the position and rotation checkboxes were unchecked, the child 
would not react at all to the parents movements.

The default preferences for the inherit options can be changed by opening the Import... 
options under the Edit menu.  The Import Preferences dialog contains an identical set of 
attributes to the inherit palette.  Checking attributes in the Import Preferences dialogue 
will make those settings the default for all newly created hierarchies.

 
Figure 204 — The Import Options dialog

•Inherit Position:  This checkbox option, when enabled, links the position of the child 
group to the position of it's parent group.  When the parent is moved in X, Y, or Z space, 
the child will be moved with it.

•Inherit Rotation:  This checkbox option, when enabled, links the rotation of the child 
group to the rotation of it's parent group.  When the parent is rotated in X, Y, or Z space, 
the child will be rotated with it.

•Inherit Scale:  This checkbox option, when enabled, links the scale of the child group to 
the scale of it's parent group.  When the parent is scaled in X, Y, or Z space, the child will 
be scaled with it.

•Inherit Visibility: This checkbox option, when enabled, links the visibility of the child to 
the visibility of the it's parent.  When the parent's visibility is off, the child's visibility will 
be off.
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•Inherit Deformation:  This checkbox option, when enabled, will include the child with a 
deformation applied to the parent.  The deformation region for the parent must be 
adjusted to include the child object within the deformation region for this option to be 
effective.  This is a very powerful feature that will allow you to deform an entire hierarchy 
as if it were one object.

The Limits Palette

 
Figure 205 — The Limits Palette

The limits palette consists of five sub-palettes: 

• Rotation
• Stiffness
• Viscosity
• Position
• Gravity

These settings work together to set position and rotation limits, and physical characteris-
tics for your joints.

Load Joint

 
Figure 206 — The Load Joint menu with the New submenu exposed

This pull-down menu allows you to use, or remove, joints from a pre-defined joint library.  
Unlike the pre-defined choices in the Link Type menu, these joints can have pre-defined 
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rotation and position limits in degrees of freedom.

•Use:  Loads a choice of pre-defined joint types in the currently open joint library.  To cre-
ate a new library choose Use > New.

•Remove:  Removes a pre-defined joint from a group.

•Modify:  Allows a pre-defined joint type to be replaced.

The Rotation Sub-Palette

 
Figure 207 — The Rotation sub-palette

The rotation sub-palette allows joint rotation limits to be set for X, Y, and Z rotation.  The 
enable limits checkbox, when checked, applies the values in the rotation limits sub-palette 
to an object.  When unchecked, the values will be ignored.  If you know you've set up joint 
limits for an object, but it's not honoring them, make sure and check the enable box.

•Minimum:  This row of data cells contains values, in degrees, for the minimum angle a 
joint can rotate.

•Maximum:  This row of data cells contains values, in degrees, for the maximum amount 
a joint can rotate.

•Center:  This row of data cells contains the values, in degrees, for the angles at which the 
joint wants to be naturally positioned at rest.  This value is used to help smooth the transi-
tion between the minimum and maximum rotation limits.  Instead of rotating between the 
maximum and minimum, the joint motion curve will arc through the center limit first.
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Use Current Value Arrows

 
Figure 208 — The Use Current Value popup

Each data cell in the rotation limits sub-palette has a small arrow that, when clicked on, 
will bring up a Use current value box.  Selecting this option will update the current rota-
tion value of the joint into the data cell.  This allows rotation limits to be set interactively 
by rotating a joint with the rotate tools, and transferring the value of the rotation into a 
limits data cell.  The group linkage window is non-modal, so you can easily jump back 
and forth between world view windows and the limits palette to make use of this feature.

ElectricImage is very smart when it comes to updating the maximum and minimum cells 
with current limits.  It knows to put the highest value in the maximum box, and the small-
est value in the minimum box.  This means you can click on the Maximum or Minimum 
use current value arrow and the proper values will be inserted where they belong.  For 
instance, if you try to put a negative X value in the Maximum box, and a positive X value 
in the minimum box, ElectricImage will automatically "flip-flop" the two values so the 
positive value is in the Maximum box and the negative value is in the Minimum box.

 
Figure 209 — The Use Center of Limits popup

There is an additional current value choice in the drop-down menu for the center data 
cells called Use center of limits.  Selecting this option will divide between the minimum 
and maximum limits and enter the result in the data cell.  Note that in some cases the cen-
ter of limits may not be where you want the joint to be when it is at rest.  In those cases 
manually rotate the joint into the resting position and select the "use current values" 
option.
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The Stiffness Sub-Palette

 
Figure 210 — The Stiffness Sub-Palette

The stiffness sub-palette can be used to control the amount of pull required to move a joint 
through it's X, Y, and Z rotation.  The higher the values in these fields the harder the pull 
required to move the joint.  The end result is that joints with a smaller stiffness setting will 
move farther, faster, than joints with a high stiffness setting. 

An example would be a human leg.  The thigh bone should move slower than the shin 
bone.  Setting a higher stiffness for the thigh would mimic this motion.

The Enable checkbox, when checked, makes the stiffness settings active.

The Viscosity Sub-Palette

 
Figure 211 — The Viscosity Sub-Palette

The viscosity sub-palette can be used to control the viscosity, or apparent friction, of a 
joints X, Y, and Z rotation.  The higher the values in these fields, the more friction the joint 
will appear to experience as it rotates.  Very high values will make the joint appear to 
catch and release as it rotates.

An example would be a rusty door hinge.  The rust would cause more friction, and thus 
cause the joint to move in an un-smooth fashion.  To recreate this you would apply a high 
amount of viscosity to the hinge joint.

The Enable checkbox, when checked, makes the viscosity settings active.
ElectricImage 2.8 Supplement        257



The Group Linkage Window — Position Sub-Palette
The Position Sub-Palette

 
Figure 212 — The Position Sub-Palette

The position sub-palette allows joint position limits to be set for the X, Y, and Z axes.  
These limits control how close, or far, a group can move from it's parent. The enable limits 
checkbox, when checked, makes the position limits active.

•Minimum:  This row of data cells contains the minimum X, Y, and Z position values for 
the groups joint.

•Maximum:  This row of data cells contains the maximum X, Y, and Z position values for 
the groups joint.

Each data cell has a drop-down menu arrow that, when selected, will input the current 
position of the joint into the field.

The Gravity Sub-Palette

 
Figure 213 — The Gravity  Sub-Palette

The gravity sub-palette contains values for X, Y, and Z gravity settings for the joint.  The 
settings in these fields apply only to the joint they're set for, not the entire hierarchy.  Local 
and Global gravity settings only affect how a group moves while the model is being trans-
lated in IK mode, it is not a physics simulation.

Normal gravity settings would be X=0, Z=0, and a - Y setting.
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The Local box, when checked, makes the joints gravity settings active and overrides the 
global gravity values for the joint.

Working in the Group Linkage Window

Because the group linkage window offers a wide variety of palettes and input fields, it's 
helpful to develop a standard procedure when creating joints.  Like any complex task, it's 
best to start with the basics and work your way to the specifics.  A basic procedure might 
go something like this:

1. Choose a pre-defined link type from the Link Type global pull-down menu.

2. Select the X-Form Palette and choose a link alignment position for the pivot point.  (If 
one applies)

3. Interactively drag the gnome into position in the group preview window.  Tweak the 
values in the X-form palette if needed.

4.Set Joint rotation and position limits in the Rotation and Position sub-palettes.

5.Test your joint to make sure it's working properly.

6.Set Stiffness, Viscosity, and Gravity settings only if they're needed.
ElectricImage 2.8 Supplement        259



The Group Linkage Window — Gravity Sub-Palette
260       ElectricImage 2.8 Supplement    



Deformations — Introduction
Deformations

Introduction

Deformations allow you to bend, twist and otherwise distort groups in a variety of differ-
ent ways. A basic tool for 3D character animation, deformations will enable you to impart 
“life” into a character, “bend steel with your bare hands” (apologies to the Superguy!), 
and so on. ElectricImage 2.8 introduces two new types of deformations: a multi-point bez-
ier deformation, and hierarchical (skeletal) bones deformations, which you can use with 
inverse kinematics. When used in conjunction with morphing, all of these deformation 
tools provide everything you need to create fantastic character animation. 

In this chapter we'll discover just what a deformation is, how to use it, the differences 
between each deformation type offered in ElectricImage and some tips on their use.

What is a Deformation?

A deformation region allows you to squash, stretch, twist, bend, shear or wibble wobble 
any group (including it's children) in any manner you see fit. You can have one deforma-
tion action on a group, or you can have many. Any deformation is animatable, which 
means you can make that can of tomato soup do the macarena if your heart desires. When 
you combine different animated deformations into one object, often times the flexibility 
offered is amazing.

Deformations in ElectricImage

In ElectricImage, deformations are applied to groups through the use of regions. A defor-
mation region is similar to a group’s cubic extent at first, but you can adjust the area of a 
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region to suit your needs. You can assign as many deformation regions as you like to a 
group. The reasons for doing so are up to you, and are typically done for either more pre-
cise control or data management (too many deformations in a single region can sometimes 
get a little complex to follow.)

Actual deformations are assign to a specific region. You can have as many deformations as 
you like in a region, and they can be of any supported type. The effect that a deformation 
will have on a group is dependent upon both the order of the deformations in the region’s 
deformation list, and the order of the actual regions in the region list. In both cases, the 
lists are processed top to bottom. You can think of this as a simple hierarchy.

For a complete technical discussion on deformations in ElectricImage, please refer to the 

ElectricImage Series 2 Reference Manual, chapter 16, “The Group Deformation Window.”

Using Deformations

In order to supplement the previous documentation on deformations, we have provided a 
sample ElectricImage project file, which you can find on the 2.8 CD ROM.

Find and open the file, called HotDogD4M.Project. You'll immediately notice a hot dog 
wearing a set of Groucho glasses. We're going to explore the use of deformations by mak-
ing this hot dog do things that no ordinary hot dog would stand for.

Figure 214 — the Hot Dog object
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To Apply a Deformation

1. Select the group, by either clicking on it in the world views or selecting it's name in the 
Project window.

2. Open the Group Deformation Window. There are three ways you can do this:

• Select it from the Tools menu
• Click the small Deformations icon in the top row of the Project window.
• Click the Deformations icon in the Tool bar.

The Group Deformation window opens:

Figure 215 — Deformation window for the Hot Dog group

Now we will take a look at this dialog and break down it's individual parts:

• Deformation Section
• Region/Deformation Section
• Region Section
• Show Region Buttons
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Deformation Section
The deformation section consists of the type menu, the options button, the Angle/
Amount/Strength edit box, Along Axis and Deform Axis check boxes. This section is 
where you choose and control the deformation.
 

Figure 216 — Deformation section of the Deformation Window

Type
This pop-up menu contains all the different types of deformations available to you. This is 
where you select what kind of deformation you'd like to use. We'll discuss the different 
kinds of deformations later in the chapter.

Options
Clicking this button brings up options specific to the type of deformation selected. Each 
deformation type has different options available to it, so depending on what type of defor-
mation you've chosen with the Type pop-up, you will get a different dialog each time you 
select the Options button. We'll discuss the options for each type of deformation individu-
ally when we discuss each later in the chapter.

Strength% (or Scale or Angle)
This is where you enter the amount of deformation to be applied to the group. To animate 
a deformation, you simply change the value in this box over time, by either directly enter-
ing a number or by adjusting it via the rocker buttons to the right of the window. Another 
way to change this value is by directly manipulating the deformation region in the World 
views by clicking and dragging on the selected group. You will see the group update in 
the world view windows as you drag. Just about any deformation available may be inter-
actively set this way.
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One thing to note about this box is that it's label will change, depending upon which type 
of deformation you chose. For Twist, Shear and Bend, it will change to Angle; for Scale, 
Taper or Bulge deformations, it will read Percentage; and for Stretch and Bezier deforma-
tions it will read Strength.

Along Axis
These three radial buttons determine what axis or axes the deformation is calculated 
along. Let’s use a bend deformation as an example.

Deform Axis
These check boxes determine what direction the deformation will occur towards. These 
check boxes are dependent upon what axis you chose to deform along in the Along Axis 
setting. If an axis is not available to a particular deformation type, the check box associ-
ated with that axis will be grayed out.

Using a bend deformation on the Hot Dog as an example, let’s look at how these two set-
tings work together.

Deformation Axis Examples

Deform X along Y 
If you choose to bend the hot dog along it's Y axis (Along Axis setting is Y), note that the Y 
Deform Axis box is grayed out. That's because you're calculating along the Y axis and 
can't deform in the Y direction. 
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Figure 217 — Y axis deformation along the X axis

Keeping the axis along which the deformation takes place set to Y, a deform along the X 
axis will make the object bend to the left or to the right, depending on the value assigned 
to Angle. Looking at the front view window, positive X is to the right, and negative X is to 
the left. Because we have a bend angle of 45 degrees (positive) the object bends to the 
right.

             

Figure 218 — 45˚ X Axis Bend Along Y
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Deform Z along Y 
If you choose to deform only the Z axis, you'll see that when you bend your hot dog it will 
bow forward or arc it's back.

 

Figure 219 — Y axis deformation along the Z axis

This is because the deformation is moving the polygons toward either the positive or neg-
ative Z along the Z axis. Because we have a negative value for our Angle, the Hot Dog will 
bend towards negative Z, which is to the left when looking at the side view window.
             

Figure 220 — -45˚ Z Axis Bend Along Y
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Deform X and Z along Y 
If you choose to deform in both X and Z axes (both check boxes selected) then the hot dog 
will appear to bend in all directions, like forward to the right, backward to the left, etc. 

Figure 221 — Y axis deformation along the X and Z axes

The illustration entitled “-45˚ X and Z Axis Bend Along Y” show the Hot Dog bending to 
the forward left. This is because our X deformation is causing it to bend to the left along 
the positive X axis, and our Z deformation is causing it to bend forward along the nega-
tive Z axis.

Figure 222 — -45˚ X and Z Axis Bend Along Y
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Show Regions
As mentioned previously, regions are the extents within which actual deformations are 
applied to the group. There are two types of region display options, Ghost Region and All 
Regions.

Figure 223 — The Show Regions check boxes

These two check boxes determine how the deformation region is displayed in the world 
view windows. 

Ghost Region creates a faded purple box delineating the original extents of the deforma-
tion region. No matter how much you deform an object, the Ghost Region will always 
retain the original shape of the deformation region to show you the original position of 
the region.

By checking the All Regions box you can show every region not currently selected in the 
Region list (located in the upper right of the Group Deformation Window) as a cyan col-
ored line. The difference with this cyan line vs. the faded purple line of the Ghost Region 
is that the cyan line of All Regions actually deforms the extent box of the region to show 
just how much that region has deformed.

Comparing the Ghost region to All Regions gives you an idea of how complex things are, 
and is a good way of finding problems and solving them. If you have 3 or 4 deformations 
and want to know how deformed any of the other regions are, simply check the All 
Regions box and every deformation region will show up as a cyan line, with any deforma-
tion effects applied to the cyan extents box. This is also extremely helpful when you have 
different regions in different parts of a group and don't want your regions to overlap. By 
checking All Regions you can be sure that your new regions don't overlap and acciden-
tally interfere with any previously placed regions.
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Region/Deformation Section
This section contains tools and lists for creating and managing regions and deformations. 
As mentioned previously, deformations are contained within a region that is assigned to a 
group. You can have as many regions as you like, and as many deformations within a 
region as you like.

Figure 224 — The Region/Deformation lists of the Deformation Window

This section covers the following items:

• Region List
• Deformation List
• The Trash Can
• The New buttons

The Region List

This is the area in which all your deformation regions are listed. They are order depen-
dent, processing from top to bottom. You may drag any region up or down in this list to 
change the sequence in which a deformation is applied. It is sometimes necessary to 
adjust the order of regions (and/or their deformations) for very complex multi-deforma-
tion effects.
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The Deformation List

This section lists all the different deformation types associated with a particular Region. 
You may change this setting via the Type pop-up menu. The currently selected deforma-
tion type for TheBend is Bend.

To Change the Deformation Type

1.Click on the Type pop-up window and change the deformation type for TheBend to a 
Scale deformation.

Figure 225 — The Deformation Type popup menu

Notice that the Deformation list has updated to show that you have changed the deforma-
tion type to Scale. You'll also note that the Angle box has changed it's name to Scale%, 
which is the animatable value for a scale deformation.

Figure 226 — The Deformation window with TheBend region set to Scale
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2.Change the deformation type back to Bend.

 The Trash Can

You can delete a region or deformation by dragging it’s name to the Trash Can icon. Once 
something is deleted in this fashion, the information applied to the disposed region is lost. 
Immediately invoking the Undo command (or typing ð -Z) will restore the region and it's 
information.

 

Figure 227 — The scale deformation dragged to the trash

The New Buttons

Under both the Region list and the Deformation list you will see a button labelled New. 
Clicking this button will creates a new region or deform, depending on which button is 
clicked. All new regions are created with Bend deformations by default.
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To Rename a Region or Deformation

Regions or Deformations can be easily renamed. Both are renamed in exactly the same 
manner. To illustrate this we will now rename TheBend to something else.

1. Double-click on TheBend region.
A dialog box appears.

Figure 228 — The change region name dialog box

2. Type in “Hot Dog Bend” as a new name for TheBend.
The Deform Region is now renamed.

Figure 229 — TheBend is renamed Hot Dog Bend

4. Change Hot Dog Bend back to TheBend.

To Add a Region or Deformation

1. Click the New button under the Region list and name the new region Twister.
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Figure 230 — The Twister group is created

Note that the default deformation type for the new Region is Bend. Since we already have 
a Bend, let's make this a Twist deformation. 

2. Make sure that the Twister region is highlighted in the Region list. Change the deforma-
tion region to Twist
 

Figure 231 — The Twister region deform is changed to Twist
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The Region Section

This section gives you precise numerical control over regions, and the space that they 
occupy. You can use the edit boxes to adjust the area of the region, or to limit the effective-
ness of a region.

Figure 232 — The Region section of the Deformation window

The Region Section contains four separate items, each containing a space for X, Y, and Z 
values:

• Position
• Rotation
• Minimum
• Maximum

Position

These edit boxes allow you to set the position of the deformation region relative to the 
group it is applied to. This setting may be adjusted by any of three methods:

• Direct entering of numeric values
• Direct manipulation in the world view windows
• By the up and down buttons located to the right of each value. 
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Figure 233 — The Position boxes

This setting is animatable over time. Each of the three coordinates is available, so the 
deformation region may be anywhere in world space. The default 0,0,0 positions the 
deformation region at the center point of the group it is applied to. All measurements are 
in ElectricImage world units, and are measured from the center point of the group being 
deformed.

Animating the Position of a Deformation Region

The ability to animate the position of the region is useful if you need a deformation to shift 
from one part of the group to another. Lets make our hot dog pass through a “distortion 
field.”

1. In the Region list, select the Twister region. In the Y Position box, type in a value of -10.

The Twist deformation has now shifted directly below the Hot Dog group.
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Figure 234 — The Twister region directly below the Hot Dog

2. Now we will create our “Distortion Field. Give the Twist deformation an angle of 90˚ 
along the Y axis. This will give the Twister region a 90˚ twist along the Y axis. 

Keep an eye on the Hot Dog as you make your change. While there is no change in the 
shape of the Hot Dog itself, notice that it has turned to its left. 

Figure 235 — The Twister region at 90˚, with the Hot Dog turned to the left
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3. In the areas titled Minimum and Maximum, click and activate the check boxes next to 
the Y value. The Hot Dog group is now oriented correctly. (Why this worked will be 
explained in detail later in the chapter.) 

 

Figure 236 — The Region section with the Y values checked

Your Side View window should look like the following:

 

Figure 237 — The correct Side view window

4. Open your Project window, and move the time thumb to 1 second.

5. In the Deformation window, enter a value of 10 into the Y Position field for the Twister 
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region. A keyframe is created in the Project window for the Hot Dog group.
The region is now directly above the Hot Dog group.

 

Figure 238 — The deform region above the Hot Dog Group

6. Again, it looks like nothing has happened to the Hot Dog. To see the effect of the steps 
we just performed, click the little camera icon in the bottom left of the Camera View win-
dow to preview the animation.
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Figure 239 — The group is deformed as the region passes through it

As the deformation region changes it's position up the Y axis it applies it's deformation to 
the Hot Dog group.

Rotation

 

Figure 240 — The Rotation boxes

The Rotation section enables you to set the rotation value of a deformation region relative 
to the group to which it is applied to. This setting may be adjusted by any of three meth-
ods:

• Direct entering of numeric values
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• Direct manipulation in the world view windows
• By the up and down buttons located next to each value. 

Like Position, this setting is animatable over time. Each of the three rotation axes is avail-
able, so the deformation region may be rotated at any angle. All rotations are measured in 
degrees. Rotating the group to which a deformation region is applied does not affect these 
rotation values; they are only affected by direct rotation of the region itself.

Rotating a Region with the Trackball

You can rotate a region for alignment or effect.

Let’s clear the previous work:
• Move the time thumb back to 0. 
• Make sure that the Deformation window is open
• Drag the Twister Region to the trash to delete it

Your project should look like the illustration below:

Figure 241 — The Front View window
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To rotate the region:
• Select TheBend from the Deformation list
• Press the Control key.
• A Green wireframe sphere will appear. Click and drag within the sphere to rotate

The circle, referred to as a trackball, will rotate, rotating the deformation region in turn.

Note that the Trackball only rotates upon whatever two axes are visible in the particular 
world view window. In the illustration “Region Trackball” below, the Front View window 
allows rotation to take place only upon the X and Y axes, as the Z axis is not directly visi-
ble. Also, as you rotate the Trackball, notice the X and Y values in the Rotation section 
update in real time.

 

Figure 242 — Region Trackball
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Animating a Region’s Rotation

The following exercise will show you how to animate the rotation values of a deformation 
region:
• Clear Rotation Values to 0.0
• Deform the X axis of TheBend along the Y axis using a value of 45˚
• Move the time thumb in the Project Window to 1 second
• In the Deformation Window, and enter the value 360 in the Y Rotation field. 
• Preview your animation

Watch the Bend deformation rotate over time to produce a twirling effect, making our Hot 
Dog look like he’s doing stretching exercises. 
 

Figure 243 — The Hot Dog is animated

Rotation of regions also comes in handy when you want to bend an object in one direc-
tion, but when you apply the deformation it’s bending from the other direction.
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Let’s say you wanted to bend our hot dog so that his bottom end moved instead of his top 
end, making him look like he’s kicking instead of bowing. The following steps will dem-
onstrate this technique to you:

• Clear Rotation Values to 0.0
• Rotate TheBend deformation region 180 degrees on the Z or X axis at time 0 (essen-

tially flipping it upside-down)
• Deform the X axis of TheBend along the Y axis using a value of 45˚ (as before)
• Preview your animation

Figure 244 — The deformation region rotated 180˚ on the X axis

The deformation is now applied to the opposite end of the group. The bottom of the Hot 
Dog now flips around in a circle, like it’s dancing.

Minimum & Maximum

Each region can have a limited range of effectiveness. The edit boxes in this section (along 
with their associated check boxes) will enable this control.
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Figure 245 — The Minimum and Maximum boxes

The Minimum and Maximum boxes are for setting the size of the deformation region rela-
tive to the group they are applied to. The numbers that initially appear in these fields rep-
resent the extents size of the group the region is applied to. These setting may be adjusted 
by any of following methods:

• Direct entering of numeric values
• By the up and down buttons located next to each value.
• Direct manipulation of the Boundary Knobs of the deformation region in the world 

view windows.

Boundary Knobs

The Boundary Knobs are the little black dots (circles) in the middle of each side of the 
deform region. In order to see them in the World View windows, Show Ghost Region 
must be checked and a Deformation Region must be selected in the Deformation window.
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Figure 246 — The Boundary Knobs displayed

Notice the little black dots on the left, right, top, and bottom of the Deformation Region. 
These are the boundary knobs. 

Using the Boundary Knobs

To adjust the size of the deformation region using the Boundary Knobs, click and drag 
their dots interactively in one of the World View windows. This will adjust the size of the 
deformation region and will determine exactly where the region will deform the group. 
By checking the check boxes next to these fields, you can limit the effect a deformation 
region has to only the polygons contained within the region.

If you like, refer back to the exercise on Animating the Position of a Deformation Region. 
Remember when we put the 90˚ rotation on the deform region and the Hot Dog group 
rotated 90˚ to the left, even though it wasn’t actually within the deform region? When we 
enabled the checkboxes next to the Y Minimum and Y Maximum fields, we limited the 
effect that the Deformation Region had on the geometry to the values contained in the 
checkboxes. In this instance, these values represented the Y extents of the Hot Dog group. 
As such, the deformation did not take place until the deform region actually entered the 
space occupied by the extents of the group.
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Adjusting the Minimum and Maximum

The following exercise will demonstrate further the use of the Minimum and Maximum 
values.

• Activate the ghost region
• Set all region position and rotation values to 0.0
• Deform TheBend with an X axis Angle value of 0˚, along Y.
• Enter the value -1.4 in all the Minimum boxes and 1.9 in all the Maximum boxes

The region box changes size to reflect the new values entered.

Figure 247 — Before and After the Minimum and Maximum values are applied

Bend the group to see the effects of limiting the effective range of the region:
• Select Bend in The Bend Region
• Enter an Angle value of 90˚
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Figure 248 — The 90˚bend with the full region and the newly defined region

See how the Hot Dog now has a tighter bend with a smaller arc? Before we were calculat-
ing the bend along the whole length of the hot dog; now the bend only occurs within the 
area defined by the region.

Let’s change the height of the Region along the Y axis:
• Select the top knob of the region
• Drag it upwards

The arc of the bend will change as you drag it The deformation itself is still 90, but the 
range of the bend is expanding along the Y axis as the region itself expands along the Y 
axis.
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Figure 249 — The 90˚bend expands as the Y deform area increases

Let’s see what happens when we reset the limits on the region:
• Set your Y Maximum back to 1.9
• Enable the check boxes next to Y Minimum and Y Maximum.

Figure 250 — The 90˚bend with Y Minimum and Maximum off and on

The hot dog is standing straight up except that the area directly within the bend region is 
all bent out of shape. What the check boxes did was tell the program not to include any 
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polygons outside of the box to receive the effects of the bend.   While this doesn’t look so 
great in this example, you can easily see the difference that the Minimum and Maximum 
checkboxes make.

This feature is very useful if you need to have something deform in only in one part of a 
group while not affecting anything else in the group. This is extremely helpful for keeping 
different deformation regions from interfering with each other.

Types of Deformations

There are 12 different types of deformations in ElectricImage. They are:

• Scale
• Shear
• Twist
• Taper
• Bend
• Bulge
• Linear Wave
• Circular Wave
• Stretch
• Bezier
• Bezier II
• Bones

Below you will find a description of each type of deformation and an example illustrating 
its use. To duplicate these examples make your Deform Window settings the same as 
those provided in the example, creating and deleting Deformation Regions as necessary.
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Scale

This type of deformation affects the scale of the group. The amount of scaling applied is 
measure in percentage. You do not need to determine what axis the deform is along in the 
Along Axis area since Scale affects all axes selected in the Deform Axis check boxes. To 
designate the axis or axes along which the Scale will occur, click the appropriate check box 
in the Deform Axis area.

There are no options available for the Scale deformation type.

Below is an example of a scale deformation applied to the X and Z axes of the hot dog and 
limited with the Minimum and Maximum settings.

Figure 251 — The Scale deformation 

Shear

This deformation will Shear (or offset) a group along an the axis defined in the Deform 
Axis check boxes. You may choose to shear a group along any axis by selecting that axis in 
the Along Axis area. 
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Shearing can best be described as slanting an object in a particular direction. This slanting 
is more defined and uniform than the Bend deformation, resulting in a harsher effect than 
bending gives.

There are no options for the Shear deformation that can be accessed via the Options but-
ton.

Here is an example of a Shear deformation applied to the Hot Dog.

Figure 252 — The Shear deformation set to 30˚

Twist

The Twist deformation allows, as its name would suggest, for the twisting of a group. 
Twisting can best be defined as rotation along a defined axis where one end of the defor-
mation region rotates clockwise and the opposite end rotates counterclockwise. The 
amount of deformation is determined by the degree value in the Angle box.

There are no option available for twist deformations.
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Twists are generally set up to affect both axes that are not used to calculate the deforma-
tion. For example, if you calculate a twist along the Y axis, it can be used to deform either 
the X, the Z or both the X & Z axes. Experiment with setting Deform Axis to either one or 
the other remaining axes of a deformation to see the varying possible results. 

Note: Since our Hot Dog group is essentially a long, skinny, Y-oriented object, we will use 
another object to better illustrate the Twist deformation. Simply turn off visibility for the 
Hot Dog group and enable visibility for the Box group.

Figure 253 — The Twist deformation

Taper

The Taper deformation allows a group to be tapered. Tapering can be described as reduc-
ing or increasing the dimensions of an object on one end of the deformation region. This 
dimension change can occur along one or two axes. The amount of tapering is determined 
by the value in the Percentage field.
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If the value in the Percentage field is -100%, the group will Taper to a flat edge along 
whichever Deform Axis is not selected. The group will taper to a point if the Deform Axis 
check boxes indicate that two axes are selected.

Figure 254 — -100% X axis Taper deformation

         

Figure 255 — -100% X and Y axis Taper deformation
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If the value in the Percentage field is 100%, the group will double in size on the end of the 
deformation region effected.

Figure 256 — 100% X and Y axis Taper deformation

Taper Options

The Taper deformation has a Fillet Taper option, which is accessible through the Options 
button in the Group Deformation window. The Fillet Taper option may be applied to 
either the beginning, the end or both ends of the region.

Figure 257 — The Taper options window

Filleting a taper causes a smooth transition between the taper deformation and the unaf-
fected polygons. This can be seen if the deformation region is reduced to be smaller than 
the size of the group as a whole. Without Fillet Taper enabled, the edges of the deforma-
tion region (where the deformation begins to effect the group,) will appear to have hard, 
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clean edge. With Fillet Taper enabled this edge is rounded and has a softer transition from 
the area not deformed into the area being deformed.

Figure 258 — Front view of a Taper with no Fillet options selected

Note the hard edges at the boundaries of the taper region. If this is objectionable, activat-
ing the “At Beginning” option can remedy this.

Figure 259 — Front view of a Taper with beginning Fillet options selected 

At Beginning causes the deformation to be blended into the surrounding polygons, 
changing the shape dramatically.
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Figure 260 — Front view of a Taper with beginning and ending Fillet options selected

With both the At Beginning and At End options selected, we see a smooth transition into 
the deformation at both ends.

Bend

The bend deformation is used to bend a group. The bend occurs along the axis set in the 
Along Axis check boxes and deforms in the direction as determined in the Deform Axis 
check boxes. The deformation amount corresponds with the value in the Angle field.

The bend deformation has a Bend from Center option available via the Options button.
 

Figure 261 — The Bend Options dialog
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Selecting this option changes the center radii of the bend arc from the edge of the defor-
mation group and places it at the midpoint of the deformation region.

If you apply the Bend from Center option to a Y axis bend deformation, both ends of the 
hot dog will bend away from center, rather than having one end “locked down” while the 
other bends away.

Front View of a 90 degree Bend deformation with Bend from Center disabled.
Note how only one end bends away from the group’s center line...
 

Figure 262 — Bend from Center Disabled (default setting)

Front View of a 90 degree Bend deformation with Bend from Center enabled. Note how 
both ends bend away from the group’s center line...
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Figure 263 — Bend from Center Enabled

If a Bend deformation is used in tandem with other types of deformations, and these dif-
ferent deformation regions overlap, it is best to place the bend deformation region last in 
the Region list, so as to apply the Bend deformation to the other deformations in the list. 
this will help to avoid some unwanted or unpredictable results that may occur if vertices 
that are to be deformed by another region if they are bent first.

Bulge

The bulge deformation allows a group to have it’s dimensions increased or decreased on 
two axes from the center of the Bulge deformation region. The amount of dimension 
deformation is correspondent to the Bulge% value. A positive Bulge% value will expand 
the groups dimensions away from the center of the bulge region, whereas a negative 
Bulge% value will draw the dimensions of the group inward toward the center of the 
bulge region.

If you set the Bulge% value to 75, our hot dog will look like a fat knockwurst. If you set the 
Bulge% value to -75, the hot dog will look more like a smoothly rounded hourglass. Bulge 
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deformation with a Bulge% value of 75. Notice how the vertices are “pushed out” from 
the center of the region.
 

Figure 264 — Bulge Out 75%

Bulge deformation with a Bulge% value of -75. See how the vertices are “pulled in” 
toward the center of the region.
 

Figure 265 — Bulge in, -75%
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The bulge deformation has a Filleted Bulge option available via the Options button. Simi-
lar to the Fillet Taper, the Filleted Bulge allows the edges of the deformation region to be 
made rounded, rather than the default hard edge when this option is disabled. Unlike the 
Fillet Taper, however, the Filleted Bulge has no setting for filleting the beginning or end of 
the region. this is because the Bulge deformation has no beginning nor end, but effects the 
group from the center of the region.
 

Figure 266 — Bulge Option Dialog

A Bulge region with Filleted Bulge option enabled. Note how the deformation eases in 
and is rounded.

Figure 267 — Filleted Bulge Option Enabled
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Linear Wave

The Linear Wave deformation deforms the vertices of the group along a sine wave that 
passes along the axis delineated in the Along Axis radial button settings. The crest and 
trough of the Linear Wave are deformed in the direction delineated in the Deform Axis 
check boxes. The degree of deformation corresponds to the setting in the Amplitude field. 
The higher the Amplitude, the more “wavy” the deformation. The lower the Amplitude, 
the less “wavy” the deformation. The Amplitude is a measurement of Electric Image 
units. If the Amplitude value is set to 1, then the linear wave crest deformation will offset 
the centerline of the Along Axis by 1 Electric Image unit in the direction of the Deform 
Axis setting. The example below is of a Linear Wave deformation calculated along the Y 
axis and deforming the X axis, to an amplitude value of 1. Note how the center point of 
the along axis (in this case, the Y axis) is offset by 1 Electric Image unit, as shown in the 
ruler ticks.

Figure 268 — Linear Wave Deformation

If you’re having difficulty understanding the Linear Wave, think of an ocean. The waves 
of an ocean are traveling along an axis. If the ocean is like any other body of water, the 
waves travel in a horizontal direction. This would mean they are Along the X axis (the 
horizontal axis). Now, the high part of an ocean wave is called it’s crest. The low part of a 
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wave is called it’s trough. The waves of an ocean go up and down as they travel horizon-
tally. This would mean that the ocean waves are deforming the water’s Y axis (hence the 
up and down of the wave). If the waves of an ocean traveled horizontally (along the X 
axis) but deformed side to side (deforming the Z axis instead of the Y axis) then the waves 
of the ocean would wiggle like a snake instead of going up and down. If you want higher 
wave crests and lower wave troughs, you need to increase the Amplitude. 

The Linear Wave deformation has a Phase and a sin curve selector option available via the 
Options button. To choose a simple sine wave, select the radial button next to Sin. This is 
the default. To select a Cosine wave, select the radial button next to the 1- Cos. A cosine 
wave will have two crests to the sine wave’s one. 

The Phase option allows you to choose where along the sine wave you wish the deforma-
tion to start. Every sine wave has a phase value. The default value for the beginning of a 
wave is 0. As you travel along the length of the wave, the phase value increases or 
decreases, depending on the direction you travel. If you travel along a sine wave to the 
right, the phase value increases. If you travel along a sine wave to the left, the phase value 
decreases. Phase is the measurement of where you are along the length of the wave. If you 
need your Linear Wave deformation to begin it’s deformation at some point other than the 
0 point of the wave, you can change the value in the Phase field of the Options dialog. The 
line drawing of the curve will update to reflect the value you have entered. Look at the 
examples below to see the differences that can be achieved via a change in the Phase 
value. Note the curve feedback in the Options dialog, and how that variance affects the 
group deformation. This area is one where exploration and experimentation is best tried.

Figure 269 — Linear Wave Option Dialog
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Figure 270 — Phase set to 75

By animating the Phase value over time you can achieve interesting results, and with 
some work can animate convincing seaweed flowing in ocean currents, by adjusting noth-
ing more than the Phase value over time.

If you want more than the 2 waves given by the sin or cosine wave, you can adjust the 
Waves field value in the Options dialog to suit your tastes.

Circular Wave
 
This deformation type allows you to create waves or ripples similar to those found when a 
stone is thrown into a pond. The waves move outward from the center of the region in a 
circular pattern. The amplitude (e.g.: crest and trough) of the wave move along the 
Deform Axis, as set in the Deform Axis check boxes. The height of the wave, or intensity of 
amplitude, are determined by the actual height of the circular wave deformation region in 
the axis determined as the Along Axis. Below is an example of how the region height 
affects the wave height...
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Figure 271 — Wave Height is Dependent upon Height of Deformation Region
 

Figure 272 — Camera View with same settings as previous figure

In other words, if your Deform Axis is X, the waves will move outward horizontally. If the 
Deform Axis is set to Z, the same will occur, since these waves are circular and move in all 
directions on these two axes. If your Along Axis is Y, the waves will act like ocean waves/
pond ripples and will have the appearance of having height. To adjust this height, adjust 
the actual height of the deformation region. To do this, show Ghost Region, grab the 
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boundary Knob on the top of the region and drag it either up or down to suit your desire 
for wave height. Here is a close up of the deformation region and the Knobs you’ll need to 
adjust. Note the relation between wave height and the height of the deformation region.... 
 

Figure 273 — Close-up of Circular Wave Region

To determine how much of the group is influenced by the circular wave’s deformation 
region, you may change the value in the Outer Radius field. The Outer Radius is a mea-
surement of percentage of coverage. A setting of 100 will allow 100% of the region to influ-
ence the group. A setting of 50 will only allow half of the region to influence the groups 
deformation. This setting may be animatable over time to produce a rippling effect. An 
object may start with an Outer Radius of 0, which will not allow any of the region to 
deform the group. By setting the Outer Radius to 100 at a later time, the impression of a 
stone being thrown into a still pond may be achieved, with expanding concentric waves 
resulting. 

The circular wave deformation has a number of Rings option available via the Options 
button. To increase the number of waves, simply change the value in this dialog. This 
value may be animated over time to produce expanding rings effects. 
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Figure 274 — Circular Wave Options Dialog

You may also combine several Circular Wave deformation regions to achieve even more 
interesting wave effects. For the random wave pattern found in a pool on a breezy day, 
you may add a number of regions of varying size, outer diameter and wave height set-
tings. Also, rain drops falling onto a puddle may be achieved by adding many smaller 
regions to the puddle group, and animating the regions outer diameter, as well as it’s 
wave height to give the impression of small, short rippling effects common to rain drops. 
Combined with proper water material properties, this effect can be stunning. Here is an 
example of how combining several Circular Wave deformation groups can be applied...
 

Figure 275 — Multiple Circular Wave Deforms
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Stretch

The stretch deformation allows you to grab a region of vertices and pull, move, rotate or 
scale them in any direction while remaining attached to the remaining unselected vertices 
of the group outside of the stretch region. The Stretch deformation is best used when the 
deformation region is smaller than the entire group. If the entire group lies within the 
region of the Stretch deformation, nothing will appear to happen when the Stretch region 
is moved, rotated, etc. except that the whole group moves. To grab this section of vertices, 
you must “capture” them. To capture the vertices for deformation, you must access the 
Capture Vertexes button via the Options button. When your region of desired deforma-
tion is set, you must click the Capture Vertexes button to enable deforming the object. 

Think of your group as a piece of taffy. Now, holding this taffy in your hand, grab one end 
of it with your fingers. Now, pull that section away from the rest of the taffy glob. It 
remains attached, but deformed. It is stretched. This is basically how the stretch deforma-
tion works. You define how much “taffy” (e.g.: vertices) your grab by the size of the defor-
mation region. You close your fingers around the taffy you wish to pull by capturing the 
vertices (e.g.: Capture Vertexes) and you pull by moving the deformation region with 
your mouse, or by entering values in the position or rotation fields.

The best way to understand the Stretch deformation is to see it in action. Follow this 
example:

• Add a new region to the list
• Choose the Stretch Deformation type
• Activate the Ghost Region
• Use the boundary knobs to the bottom of the group only
• Choose the Options button
• Select the Capture Vertexes button (this tells the computer that you ware ready to start 

pulling this group into or out of shape.)
• Grab the region with your mouse and pull it as you see fit. 
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You may also rotate the region via the Rotation values for the region as found in the 
Group Deformation window

Figure 276 — Stretch Deformation

If the stretching seems too harsh or edgy, you may adjust the Blend Factor in the Options 
dialog. Increasing the Blend Factor reduces the harshness of the stretching. A higher Blend 
Factor will allow the stretch region to affect a wider area of vertices outside of the actual 
stretch deformation region. 
 

Stretch with Blend Factor at 5
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You may limit the stretching to affect only vertices along the X, Y or Z axes. This means 
that if you only enable the X axis, that no matter how hard you try to move the region on 
the Y axis, the region will not be allowed to move in that direction until you enable the Y 
axis in the Deform Axis check boxes. You’ll also note that the Along Axis radial buttons 
are disabled. This is because the Stretch deformation doesn’t calculate along an axis, but is 
determined by the size of the region of captured vertices, as well as the Blend Factor, 
regardless of axis. You may also pre-define your stretch region’s position and animate it’s 
Strength% over time to slowly deform your group without having to set keyframes for the 
position or rotation of the stretch region. Only adjust the Strength% over time. The result 
is similar to that of a magnet pulling the vertices out of shape over time.

Bezier 

One of the most powerful tools for character animation within Electric Image is the Bezier 
deformation. A Bezier deformation allows for a very fluid deformation of the group by it’s 
Along Axis and in the direction as determined by the Deform Axis check boxes. The main 
controls for the bezier deformation are its control arms and anchor points. The control 
arms behave in a manner very similar to bones, but have some pronounced differences 
from bones. Think of the control arms as puppeteering rods built inside of the group. By 
moving the pupeteering rods, you change the shape of the group. The control arms 
appear as indigo colored lines that run along the length of the Bezier region as defined in 
the Along Axis radial buttons. The control arms may be animated to produce the effect of 
bending, twisting, stretching, squashing and arcing the group as influenced by the control 
arm. The deformation occurs along the axis that the control arms are parallel to. To define 
which axis the control arms are parallel to, set this axis in the Along Axis radial buttons. 
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Figure 277 — Along Axis set to Y
 

Figure 278 — Along Axis set to the X
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Figure 279 — Along Axis set to the Z

You will note that the boundary knobs of the Bezier region are concealed where the Con-
trol points of the control arms rest on the regions boundaries. To get at these boundary 
knobs, switch the Along Axis setting to a different axis to reveal the Knobs. Adjust them to 
your liking and then reset the Along Axis to the axis you desire to deform along.

Each control arm has three controlling points on it. The Anchor point, the Control point 
and the Spin point. All three points may be animated separately by grabbing them and 
moving them with the mouse, or they may be moved as a group by grabbing the control 
arm itself and moving it. Grabbing the control arm itself and moving the Anchor, Control 
and Spin points all at once produces a result similar to that of the Stretch deformation.

The Anchor point is the black dot at the base of a control arm that is closest to the center of 
the deformation region. This is the center of rotation for the entire control arm. When the 
control arm is moved, it seems to pivot and rotate around this point.

The Control point is the black dot at the very end of the control arm and is located at the 
boundary of the Bezier region. To move the control arm but not affect the Anchor point, 
grab and move the Control point. This will deform the vertices as influenced within the 
region. 
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The Spin point is the point attached to a small spur control arm that emerges from the 
Control point and is perpendicular to the Control arm. The Spin point allows you to spin 
the top of the Bezier region for twisting the group. The center of rotation for the Spin point 
is the Control point, where the center of rotation for the Control point is the Anchor point. 
The Anchor point has no center of rotation and cannot be rotated. The Anchor point may 
be moved. Moving the Anchor point effects the rest of the control arm’s effects of defor-
mation. 
 

Figure 280 — Moving the Control Point

Moving the Control point only causes the group to deform along the curve produced 
between the two points. (Note that the curve is not actually drawn.) You can drag the con-
trol point to any position, as with any bezier spline.
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Figure 281 — Moving the Anchor Point

Moving the Anchor point is equivalent to changing the endpoints of the bezier spline. 
This is useful for making a character lead or “telegraph” the intended direction of travel 
(or perhaps for making a great Axl Rose impersonation!)

Figure 282 — Moving the Spin Point

Moving the spin point will twist the group along the spline direction, with the majority of 
the twist occurring at the location of the spin point.
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Figure 283 — Spin Rotation from the Side

The figure above shows the spin from another direction. Again, notice how the twist effect 
is more pronounced around the spin control point.
 

Figure 284 — Dragging the Control Arm

You can also just drag the entire control arm, which will offset the endpoint, keeping the 
trajectory of the control arm intact. In the example above, the shape is starting to deform 
back to it’s original orientation.
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Figure 285 — Bending and Twisting a Bezier

Bezier deformations, used in tandem with each other, can produce powerfully flexible 
deformations. One can animate the fingers of a hand with a combination of Bezier defor-
mation regions. One important tip to keep in mind when combining more than one Bezier 
region on a group is to limit the influence of the region’s deformation. This is done via the 
check boxes next to the Maximum and Minimum fields in the lower right of the Group 
Deformation window.

Figure 286 — Limited Bezier Region and it’s effects
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Like any deformation, you can have multiple bezier deformations on a group. When 
doing so, it is best to assign a new region, so you can change the focus area of the bezier 
effect, as shown in the illustration, “Limited Bezier Region and it’s effects” on page 316.

The hot dog has two bezier regions on it. You’ll note that when the lowermost Control 
point of the upper region is moved, it moves the whole bottom of the group. This may or 
may not be desirable.

You can limit the influence of that region by checking it’s Y Minimum limit box, and thus 
limit the influence of this region to only those vertices with a Y position value greater than 
the Minimum Y as set in the field.

Figure 287 — Limited Region Bezier Deformations

Now the lower bezier region’s upper Control point is moved. Note the very unpleasant 
deformation results (illustration on page 318). This looks pretty ugly. That’s because the 
upper deformation region has already had it’s deforming effects applied. By deforming 
the lower region, we magnify, or multiply in combination that effect, so that what we see 
is the result of the two regions affecting the same vertices twice.
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Figure 288 — Problem associated with limiting Y Minimum

This can be corrected by limiting this region’s Y Maximum influence. Do this by checking 
the check box next to the Y Maximum field in the Group Deformation window.
 
Observe how the deformations Maximum Y influence is constrained to those vertices 
within the actual Bezier region itself in the following illustration. The undesirable kink 
can be removed by insuring the regions are close but not overlapping. 

Figure 289 — Not Perfect, but Getting There (Min and Max limited)
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If you need to have greater control over the location of your Anchor, Control or Spin 
points, you may obtain their location, relative to the group’s object space, by clicking the 
Options button. In the dialog you will see fields for entering numeric values to adjust the 
positions of these points. This dialog is especially helpful for duplicating point positions. 
If you need to return an Anchor, Control or Spin point to a previously keyframed position, 
you can obtain that location information in this Options window for later reference. Also 
in the Options dialog you will note a Reset Points button. Clicking this button will reset all 
the Anchor, Control and Spin points to their default position relative to the deformation 
region. This is helpful if your deformation gets out of hand or you need to return to the 
default position after animating a deformation.

Figure 290 — Bezier Options Dialog

Also within the Options dialog you will see a check box marked Curve Continuity. This is 
useful for overriding the default results of the Bezier deformation. By default, when a 
group is deformed using a Bezier deformation, pinching is minimized. However, you may 
have undesired results because the continuity, or the continuing, of the curve of the 
group’s vertices as they cross the bezier region boundaries may not be smooth. 
The illustration “Bezier example without continuity applied”is an indication that the 
Curve Continuity option for a Bezier region is necessary. 
ElectricImage 2.8 Supplement        319



Deformations — Bezier II
The hot dog is not maintaining it’s volume as it deforms, violating one of the primary 
laws of squash and stretch, a common cartoon technique. To remedy this, activate the 
Curve Continuity option in the dialog.

Figure 291 — Bezier example without continuity applied

Similar to the Stretch deformation, you may preset the amount of bezier deformation and 
simply animate it’s Strength% over time to give a very complex magnet effect.

Bezier II
 
Bezier II is a new deformation type added to Electric Image for version 2.8. This deforma-
tion type behaves in every way similar to the Bezier deformation, but allows greater flexi-
bility in the ability to add extra control arms on the interior of the deformation region. Up 
to four control arms may be had with a Bezier II deformation type. The Bezier II deforma-
tion deforms exactly the way a Bezier deformation does relative to the Deform Axis and 
Along Axis settings. 

In the following illustration, note how the control arms are arranged within the bound-
aries of the Bezier II region.
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Figure 292 — Bezier II default condition

To determine the number of control arms a Bezier II deformation may have, you must 
access the control arm dialog via the Options button. You may also turn off the visibility of 
the Anchor, Control and Spin points of each of the control arms. In the Options dialog you 
may also select what type of curve you wish to use. By clicking the left curve type, it is 
similar to selecting a non-continuous curve. By selecting the right curve type it is similar 
to selecting a Continuous curve in bezier deformations. The text below the curve types 
will update to give information about the choice of curve you have made. Also, the Bezier 
II Options dialog has a Reset Curve button. This behaves in a similar way to the Reset 
Points button in the Bezier deformation options dialog. This will set all the Anchor, Con-
trol & Spin points for all control arms to their default position.

Figure 293 — Bezier II Options Dialog
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Like the Bezier deformation you may move any or all of the Anchor, Control or Spin 
points of each control arm. Again, either by individually selecting and moving each point 
or by grabbing the control arm as a whole. Since we covered how the end control arms 
work within the section discussing the Bezier deformation, let us take a closer look at the 
interior control arms of the Bezier II deformation.

The interior control arms acts more as “rockers”, while the end most control arms behave 
like puppeteering rods similar to the way they behave in the Bezier deformation type. The 
interior control arms each have two Control points to their one Anchor point. This allows 
them to “rock” back and forth, with their center of rotation being the center Anchor point 
of the control arm.

Note in this illustration how this combination of “rocking” the interior control arms can 
produce a complex “wavy effect.”

Figure 294 — Tilted Control Arms

In the following illustration, observe how you can move the Anchor and Control points 
for each interior control arm by dragging the Anchor points. The relation of the Control 
and Anchor points to one another remains the same, however the relation of the interior 
control arms to the group changes. This technique is very powerful for complex muscle 
movements and internal shape distortions commonly found in character animation.
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Figure 295 — Offset Control Arms

By combining moving the Anchor points and adjusting the Control points for each inte-
rior control arm, you can achieve very complex deformation effects.

Figure 296 — Hoo, Baby, I Like it Like That!

Again, as with regular Bezier deformations, you may use a series of Bezier II deformations 
in tandem on a single group to achieve even more complex deformations. Remember to 
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use the limit influence check boxes next to the Minimum and Maximum fields to keep 
these multiple regions under control. However, there comes a point of diminishing control 
with multiple Bezier II deformation regions.

Example of a multiple Bezier II deformation region combo. The more you add, the more 
difficult it becomes to get predictable results using Bezier II deformations.

Figure 297 — Now things are getting a little out of hand

Bones

Bones are used to perform “free-form” deformations, with fewer limitations than the 
other deformation types. Bones can be linked together to form a deformation chain, 
imparting an incredible amount of control over a group. With bones, you can deform “sin-
gle skin” objects such as characters or animals as if there were being moved by their own 
skeletal system (in fact, they are!) You can even use bones to create “morph targets” for 
facial expression morphing. In all, bones are quite handy.

Bones can also be a bit picky. Bones act like little magnets, pushing and pulling on groups, 
sometimes destroying them if used with wild abandon. Deforming a group with bones 
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almost always means there will be more than one bone parented to a group. That means 
that they will compete with each other, unless you limit their ranges of influence.

Prepping the Model

Like any other deformation, bones require a model that is properly meshed in order to 
provide the best results. You can use the Dicer plug-in to mesh the model if necessary.

Figure 298 — Low Resolution and high Resolution Models with Bones

The Dicer plug-in will regenerate the model quite often. Since it is unlikely that you will 

want to change the resolution of the model over time (the reason why Dicer regenerates) it 

is best to save the model as a new file once you have the proper resolution.

You can use low resolution proxies to speed up the interaction process when working 
with bones. Just make sure that the low resolution model is volumetrically similar to the 
final target model. You can parent both models to a null effector, with the same cubic 
extent as the models, and then make the working model or final model visible.

Adding Bones

There are two ways to add bones to your project:
• From the File Menu (File>Add>Type>Bones)
• From the Object Palette (Bones Icon)
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Bones are added as a chain until you stop the process by choosing command-period. The 
length of the bone is dictated by the distance between each mouse click. In effect, you can 
actually draw the skeleton on top of the desired model in the world views.

A typical skeleton is comprised of several link chains. The main chain would be the body, 

including the spine and neck. The extremities would each be a separate chain. When repro-

ducing a bones chain, it is best to create each extremity as a separate chain, and then cre-

ate the final hierarchy with the parenting tools available in the Project Window. This 

will enable you to maximize bone usage with inverse kinematics.

Associating Bones to a Group

In order for bones to affect the shape of a group, three steps must first be undertaken. Like 
other types of deformations in this chapter, bones must be attached to a deformation 
region. See the section “Creating Deformation Regions.” It is a good idea to create a 
unique deformation region for bones, to separate them from other deformations. This is 
necessary because bones can exist in only one region per group, and that region needs to 
cover the entire extent of the group in a default position. 

Remember that regions are order sensitive, and you might want to have the Region con-
taining the bones deformation be at the top of the list. Either before or after you create a 
deformation region for the bones chain

Before you parent a bones chain to a group, you must first set up the chain so that the link-
ages of each bone provide the appropriate type of constrained motion. (See the chapter 

entitled “Group Linkage Window” for more information on configuring and constraining 

joints.) 

To associate bones with a group:

• Make sure that the previous recommendations have been followed
• Select the first bone in the chain from the project window
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• Click on the Parent tool icon in the project window
• Select the group name in the project window that you want to deform with bones

Assuming that all of the steps have been followed, the bone chain is now attached to the 
desired group.

Moving the Bones Around

Now that you have created a bones chain, deformation region, set up the joint constraints, 
and parented the bones to a group, you are ready to test your work. You can use either for-
ward or inverse kinematics to move a bone chain. Each produces a different result. (For 

more information on Forward and Inverse Kinematics, see the chapter entitled, “Effectors 

and IK.”) 

As you move the bones chain and interact with it, you will likely decide to adjust the val-
ues and parameters of the bones for the effect that you want to achieve. To do this, you 
must configure each bone separately through the Bone Info Window. To access the Bone 
Info Window:
• Select the bone 
• Double click or choose File>Get Info…

The Bone Info Window will appear.

Bone Info Window

The Bone Info Window contains a series of buttons and tabs for configuring the bone, and 
animating it. As a bone is an effector in ElectricImage, in addition to a deformation type, 
we will only cover the controls which are related to bones deformations in this chapter. 
For an explanation of the other controls, see the chapter “Effectors and IK.”
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Figure 299 — Bone Info Window

This chapter will cover the controls in the two tabbed sections:
• Bones X-Form Tab
• Bones Special Tab

Bones X-Form Tab

This tab contains the transformation information for a bone. The information in this tab is 
equivalent for the other effector types, and is covered in detail in the Effectors and IK 
Chapter.

Figure 300 — Bones X-Form Tab
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Bones Special Tab

This tab contains controls for adjusting and setting bones characteristics.

Figure 301 — Bones Special Tab

The tab is divided into four sections:

• General Section
• Range Section
• Rotation Bias Section
• Strength Section

General Section
This section contains the active check box, which determines whether or not the bones 
effects will be applied to the group, and the bone length edit box. Bone length is set at the 
time that you create the bone, but you are free to edit the length of the bone at any time 
with this control. Bone length is a factor in the strength of the bone.

Range Section
The range section contains four items which control the effective range of the bone, and 
how its energy will be applied to the group through the bone:

• Limited Range Check Box
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• Minimum Range Edit Box
• Maximum Range Edit Box
• Fall Off Popup Menu

Limited Range Check Box
This check box activates the bone’s ability to limit its influence. The numbers in the Mini-
mum and Maximum range edit boxes are used when this feature is active. If this feature is 
not active, the bone’s effective influence will apply throughout the deformation region for 
the bone, on the group to which the bone is attached.

When this option is active, the actual range of the bone will be drawn in the world view 
windows around the bone itself. The minimum value will not be drawn if it’s value is 0.0, 
otherwise it will be drawn in dashed lines. The maximum value will be drawn (if it’s 
value is not 0.0) in unbroken lines.
Minimum Range Edit Box
This edit box specifies the minimum area of effectiveness for the bone. A value of 0.0 (the 
default value) will begin to dissipate the energy of the bone immediately, until the maxi-
mum range value is encountered, using the method specified in the Falloff menu. 

Minimum values can be greater than zero. In this instance, the strength of the effect is 
applied from the center of the bone until it encounters this boundary, at which point the 
energy will begin to fall off as specified in the Falloff menu.

If you encounter a severe amount of distortion on your model, try setting the minimum 
value to be larger than 0.0. Combined with the Maximum range value, you can get very 
precise control over the deformation area.

Maximum Range Edit Box
The edit box specifies the maximum are of influence for the bone. Any part of the group 
which falls outside of this area will not be directly effected by the bone. This option is 
valid only when the limited strength check box for the bone is active.
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Falloff Menu
The falloff menu determines the energy transition from the Minimum to the Maximum 
range of the bone. The following methods are available:

• Ease
• Linear
• Power (of) 2
• Power (of) 4
• Power (of) 8
• Power (of) 16

Each of these methods affect the visual quality of the transition. Ease is typically the best 
method, and the default. You may wish to experiment with the other methods as well to 
suit your taste.

Rotation Bias Section
Bones have a default direction of influence, which can cause problems for certain types of 
data, such as motion capture data. This type of data is typically not “indexed” with any 
accuracy. That is to say, there is no rational frame of reference to begin mapping the 
motion capture data, as it is typically stored as a series of offset values. This section 
enables you to “reconfigure” the bone to more closely match the first frame of data in the 
capture file.

The edit boxes are used to “zero out” the bone. Position the bone to the desired beginning 
position and click the Set Bias button to do so.

Strength Section
Bones have the strongest effect on points closest to them, or those within the bones limited 
range (assuming that option is active.) You may wish to add bones which counteract the 
effect of other bones for more precise mesh control. Typically, these bones would not be 
independently animated, as their intended function would be to suppress unwanted dis-
tortions from becoming pronounced.
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Overlapping areas of bone influence can produce points which are under the control of 
more than one bone. When that occurs, the strength of each bone will have an effect as 
well. Sometimes this will be of use to you, such as the case mentioned in the paragraph 
above. At other times, it might be a hindrance. This can be avoided to a degree by limiting 
the bones area of influence.

As bones can be set to different strengths, the bone with the higher strength value will 
exert more influence over points than bones with lower values. All of the bones affecting 
the points will exert some influence, however. Bones with equal strengths will tend to can-
cel each other out if pulling in opposing directions.

The Strength by Length check box will use the length of the bone to calculate its influence 
over the group. The strength edit box is used to set a direct amount of strength for the 
bone, taking all of the bones contained within the chain into consideration for the overall 
effect on a group. Bones with strengths that are greater than their neighbors will exert 
more influence, however the neighbors will still have some “pull,” so to speak.

Tips On Using Deformations

Performance is affect by the Amount of Colors Displayed
It is a good idea to keep the bit depth settings of your monitor at 256 colors when working 
within ElectricImage, as it is optimized for this monitors setting

Use Deformation Scale only if Deforming a Group
Do not scale the group or it’s children via the Group Info window. Scaling groups before 
applying deformations is just asking for trouble, especially if your are deforming a group 
and it’s linked children. The greater the variance from the default scale of the parent (e.g.: 
x1.0, y1.0, z1.0), the greater the distortion of deformed linked children. If you need to scale 
a parent and children group before adding a deformation, then use a Scale deformation. 
Make sure the Scale deformation is the first region listed in the Region list in the Group 
Deformation window. This will allow Electric Image to apply the Scale deformation first 
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to the group and it’s children, followed by any other deformations. One drawback to this 
is that if you need to Scale deform your group and children by a large amount, it becomes 
difficult to see the actual Scale region in the world views. The Scale region remains the size 
of the group before it was scaled, while as the group is scaled, it becomes larger or smaller. 
Note in the example below how the Ghost Region of the Scale deformation stays the same 
size, while the group itself, scaled by 100%, grows larger. In this example, this is fine, but 
try scaling a group by 1000% and you can see why you may not want this.

Turn Off inherit Deformation or Child Groups will Deform too
If you want to deform an object, but simply want it’s linked children to move along with 
the faces, not actually be distorted themselves, then make sure the linked children have 
Inherit Deformation disabled in their Group Link window. This is the best setting for hav-
ing hands follow a body, or in the case of our hot dog, having the glasses follow the 
deforming hot dog without getting all twisted up themselves.

On the Other Hand, That May Be What You Want
If you desire the children of a group to deform in a similar manner as it's parent, then 
make sure the Inherit Deformations option is enabled in the children’s Group Link win-
dow. This is most useful for eyelids that deform along the eye as they blink, or for clothes 
that you wish to squash and stretch with a character as they bend or move. This way the 
children objects will not intersect with the parent as it deforms.

Make Sure Your Models Are Meshed
Groups that don’t seem to deform very well may need to have their mesh density 
increased. Deformations will only move polygons as a whole. Deformations cannot bend 
a polygon itself. So if your deformation seems “choppy” or doesn’t seem to bend 
smoothly, try increasing the polygon density of the deforming group. You can either do 
this by adjusting this in the modeler, or by parenting the group to be deformed to a Dicer! 
object. The best way to handle parenting to a Dicer! is to add the Dicer! object 
(File>Add>Socket>Dicer!), to the project, then link the group to it. Then export the Dicer! 
object with the group linked to it as a fact. Re-import the Dicer! object into the project. Dis-
card the linked group and rename the Dicer! in the Project window to the name of the 
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group. What this does is forces Electric Image to recognize the Dicer! group as having 
more polygons. This is helpful when it comes time to render because at render time all 
Dicer! objects need to be recalculated for each frame. But a high density mesh is just read 
like any other model.

Rotations Can Get Tricky
If you need a group to rotate, but don’t want the deformation to rotate with it, then 
counter rotate the deformation. Look at the SewerSnake.Project on the Electric Image CD-
ROM. Note how the bend deformation region doesn't go twirling around at the bottom of 
the sewer snake as it rotates? This is because the rotation of the sewer snake is offset by a 
similar counter rotation of the deformation region. This gives the appearance of the defor-
mation region not moving, when in fact it is actually rotating -1 degree for every degree of 
rotation of the group it deforms.

Camera View of SewerSnake.Project illustrating counter rotation of deformation regions. 
The head of the sewer snake rotates along with the other parts of the sewer snake as it 
rotates on it’s Y axis.

 

Figure 302 — Counter Rotation of Regions will Compensate Strange Results
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Multiple Groups can give More Control
You can use a combination of groups to achieve even more complex animated deforma-
tion effects by applying the deformation of one group to another as it passes through the 
first group. Look at the SewerSnake-2.Project on the Electric Image CD-ROM. The parent 
Standard Shape, a cylinder, has a 90 degree Bend deformation applied to it. The child, the 
sewer snake, has Inherit Deformation enabled in it's Group Link window. As the sewer 
snake is animated to intersect with the parent cylinder, it inherits the 90 degree bend that 
it’s parent has. This technique is very useful for showing complex organic mechanisms in 
action.

Camera View of SewerSnake-2.Project illustrating inherited deformations to achieve com-
plex animated deformation effects.

Figure 303 — Child Group Passes through Parent Region
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